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1. Administration Panel Environment
The user interface of CS-Cart administration panel is similar to many other web applications. It includes meaningful menus to
ensure clear navigation and handy toolbars to provide quick access to the most frequently used parts of the administration
panel. So, you are likely to feel at home with CS-Cart administration panel very soon even if didn't have experience in running a
web store in the past.
Please have a look at the map below. It will help you familiarize yourself with the layout and navigation structure, which are
common throughout the administration panel.

Map of the CS-Cart administration panel
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[1] Top navigation menu

[2] Administration header

Menu bar with drop-down menus to access operational parts

Menu bar with drop down menus to access administrative

of the administration panel. Each item of the menu has a

parts of the administration panel. Use this menus to access

short description so that you can easily decide which section

store settings and perform maintenance routine.

to use to perform certain tasks.
Use this icon to access the home page from any part of the
administration panel:

[3] Operation area

[4] Search form

This is the main element of administration panel interface. It

Enables quick search for products, orders, users, and

includes all controls to manage and configure your web store. content pages from anywhere in the administration panel
The collection of controls is specific to each section that you

without specifying the type of data being searched. Please

have opened by using the top navigation menu, administration learn more about quick search later in this topic.
header or other links.

Viewing the Storefront
When working with the administration panel, you may need to view the storefront. To quickly open the storefront, click the icon
in the top left-hand corner (near the store name). The storefront will be opened in a new browser tab.
Note: You should choose a store first to make this icon active.

Using Quick Search
The Quick Search form allows conducting the search for items that belong to one of the following types of data: products,
orders, users, content pages, and news. You do not need to specify the type of object being searched. Instead, search results
will be divided into five separate groups.
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Here is a list of fields which are searched through:
1. Products – Product ID, Product code, Name, Short description, Full description, Search words, Meta keywords, Meta
description, SEO name.
2. Orders – First name, Last name, Email, Order ID.
3. Customers – First name, Last name, Username, Email.
4. Pages – Name, Description, SEO name.
5. News – Name, Description, SEO name.

Navigating Between Congeneric Items
Many pages of the administration panel are equipped with the navigation links Previous, Next and the button

. These

controls allow administrator to easily move around and go back to the search results.

Advanced Search Options
Along with the regular search facility, most sections of the administration panel provide for the advanced search option.
Advanced search is activated by using the Advanced search link and allows filtering search results by a larger number of
parameters, thereby making the output more precise.
For example, in Orders

View orders you can search customer orders by the following parameters:

Customer – Orders placed by a specific customer.
Email – Orders placed by a customer with specific email.
Issuer – Orders placed by a specific issuer.
Total – Orders with total that lays between these numbers.
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eBay orders – Orders imported from eBay (the eBay synchronization add-on must be installed in the Add-ons >
Manage Add-ons section).
Period – Orders placed within a specific time period.
Order status – Orders with the selected statuses only.
Tax exempt – Orders placed by users having exemptions from taxes or vice versa.
Order ID – Order with a specific ID number.
Has credit memo – Orders having credit memos (returned orders).
Credit memo ID – Credit memo with a specific ID number.
Has invoice – Orders having invoices (paid orders).
Invoice ID – Invoice with a specific ID number.
Search by owner – Orders containing products from specific stores.
New orders – Orders that have not been viewed yet.
Shipping – Orders shipped with the selected shipping methods.
Payment methods – Orders payed with the selected payment methods.
Ordered products – Orders containing specific products.
Gift certificate code – Orders containing gift certificates with a specific code.
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Besides, with the Advanced Search option you can create different search patterns and save them for future use. Just set the
search options, type the name of the pattern in the Save this search as input box and click Save. Once the search pattern
has been saved, it is displayed in the drop-down list box at the top.
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After completing any of the search fields, click Search to display the search results.
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2. Dashboard
Dashboard is the first screen that you see after logging in to the administration panel. It contains a summary of the recent
activity in your store - latest orders and sales - as well as the a synopsis of the store inventory and general user statistics.

[1] Total number of orders, sales and taxes sums in your store.
[2] Recent orders made in your store. Switch between the tabs to see orders with particular statuses.
[3] Monthly statistics of your store in the form of a diagram.
[4] Brief statistics of the store: the number of products, customers, pages, etc. Click on the number of items to be redirected to
the page with the detailed list of these items.
[5] The number of orders with the particular status and total income received by the orders of this type.
[6] Brief variant of information, represented in the Administration -> Logs section. Click the Show all link and you will be
redirected to this section.
You can also choose the period of time, for which the information on the dashboard is displayed. Click on the period in the right
upper corner of the page and choose the required period of time from the drop-down menu. Optionally, click Custom Range to
define your own period and press Apply.
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3. Orders
This section of the Administration panel is used to manage and control order procedures in your store. Here you can review
and edit orders that have been placed in your store, place new orders on behalf of other users, handle return requests,
manage call requests, etc.
For accounting purposes, orders have continuous ID numbers disregarding their current state and number. At that, CS-Cart
keeps track of successful and returned orders assigning them separate IDs.
That is how it works. All orders can be one of the three conditions:
Order - The order has been placed, but not paid out;
Invoice - The order has been paid and processed successfully;
Credit memo - The order has been paid and processed, but then returned.
So, invoice IDs and credit memo IDs are generated continuously for the appropriate orders only:
0005

Order ID

Order Status
Complete

0001

Invoice ID
-

Credit Memo ID

0006

Incomplete

-

-

0007

Canceled

-

0001

0008

Complete

0002

-

Tip: To list orders that has been placed in a particular store only, switch to the store administrator's mode. For details, see "
Understanding multi-store functionality".

3.1. View orders
In the View orders section, you can carry out the following tasks:
Display a sorted list of all orders in the store or display a filtered list of orders that meets your search pattern only.
View orders that were not completed (press the button

and choose the Incomplete orders link). An order

receives the status "incomplete" after a customer has placed the order until the order has been processed by a payment
system. For example, during the period when a customer is entering credit card details on the payment system website
up until the customer is redirected back to your store.
Change order statuses on the fly.
View and edit order details.
Add comments to the order which are visible to the customer who placed the order.
Export order details in the CSV, Quickbooks and MYOB formats.
Print invoices and package slips both separately for each order or in bulk.
Remove credit card info (if any).
Create orders.
Delete existing orders.

Displaying orders
When you open the View Orders section, the system automatically lists all orders from the database, i.e. the orders that have
ever been placed and not deleted. By default, the list is arranged according to the date the orders were placed with the most
recent orders at the top. If necessary, you can rearrange the list according to the order IDs or statuses, names or email
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addresses of users who placed the orders, or order totals.
To display the orders that satisfy a certain criterion or a combination of multiple criteria only, use the form to the right of the
order list. By default, the form allows you to filter orders against names and e-mail addresses of users who placed the orders
and the range of order totals. To access more filtering criteria, expand the form by clicking Advanced search.
If you filter orders against a particular search pattern regularly (e.g., to list all new orders that were paid with a gift certificate),
you will find it convenient to save the pattern and add it to the list of pre-defined patterns appearing in the top left corner of the
View Orders section (see the picture below). For more information about using advanced search, please see the "
Administration Panel Environment" section.

Changing order status
To change an order status quickly without opening the order for editing, click on the current order status to expand a list of all
applicable statuses. Then simply click on the required status.

Quick order printing, exporting, and deleting
The View orders section allows you to carry out many routine tasks for multiple orders including bulk order exporting and
invoice printing in one click.
1. In the list of orders, select the check boxes for the orders you want to take action on.
2. Click on the button

in the upper right part of the list. This displays a list of applicable actions.
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3. Click on the required action in the list.

Viewing and editing order details
To display order details, press the button

corresponding to the order that you want to review and choose View.

This opens the order details page.

Here you can add comments to the order and define shipment details.
To edit the order details, click the button

and choose Edit. This opens an editing order details page.
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Here you can edit the set of products in the order (remove products from the order with the icon

12

or add new products with

the Add product button) as well as change the product cost as it appears in the order (click on a checkbox near the product
price first). This doesn't affect the product cost in the catalog. You can also edit the product clicking on a product name.
In the left sidebar, you can edit customer's contact info together with the billing and shipping address (the

icon).

In the right smaller field of the page, you can change the payment method and the shipping method choosing the desired
method from the drop-down menu. You can also change the order status here. To change the status, click on it and choose
another status from the drop-down menu.
In this section you can also apply a discount coupon and edit the applied tax rate.

3.2. Sales reports
In this section, you can find a detailed statistics on the sales that have been made in your web store. Statistics may be
represented in a form of graphical or tabular charts. For convenience, charts are grouped into separate reports. You are
encouraged to use several pre-defined reports or create your own reports. To switch between the reports, use the toggle on
the left.

Creating a report
To create a custom report:
1. In the Orders -> Sales reports section, press the button
available reports.

© 2004 - 2015 Simbirsk Technologies Ltd.
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2. Click the button

.

This will open a form with the report details.
3. Complete the form.
Name - Name of the report as it will appear in the list of reports.
Status - Status of the report (active or disabled.)
4. Click the Create button.
The new report will be listed among the other reports.
Now proceed to edit the report and add charts.

Creating a chart
Data charts must be assigned to a particular report.
To add a chart to a report:
1. In the Orders -> Sales reports section, click the button

and choose Manage reports to display a list of all

available reports.
2. Click on the button

corresponding to the required report and choose Edit from the drop-down list.

This will open a page with the report details. The Charts section contains a list of assigned reports (if any).
3. Click the button

.

This will open a form with the chart details.
4. Complete the form.
Use the General tab to define the chart scope.
Name - Name of the chart as it will appear in the reports.
Position - Position of the chart relatively to the position of the charts in the report.
Type - How the data should be represented: graphically or in a table.
Object to analyze - Type of data to be reported on (users, orders and order statuses, products, categories, etc.)
Value to display - Aspect to be analyzed.
Time interval - Analyzed periods (day, week, month, year.) Is not applicable to the chart type Graphic [Pie 3D].
The tabs Orders, Statuses of orders, Payment methods, Locations, Users, Categories, and Products are used to
filter or limit chart contents so that it covers specific items only.
For example, in the Order statuses tab you can select to show statistics on orders with specific statuses only, and in the
Products tab you can choose the products which statistics should be represented in the chart. Statistics on the unchosen
products will not be included in the chart.
5. Click the Create button.
The new chart will be listed among the other charts.

3.3. Shipments
In CS-Cart, shipments refer to situations when you ship items from a single order in multiple batches and/or at different periods
of time. Such batches are treated as separate shipments of one order.
This functionality is very useful when you have to deal with back orders regularly.
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For example, if a customer orders several items that are out-of-stock, you can ship in-stock items immediately after the order
has been placed, and then send the rest of the order at a later day as a separate shipment.

Creating a shipment
Shipments are created separately for each order on the order details page in the section Shipping information.
To create a shipment:
1. Click the New shipment button. This will open a pop-up window.

2. For each product in the order, select the number of items that will be delivered in the current shipment.
If you're going to deliver a particular product in a different shipment, select 0 (zero) from the Quantity drop-down list.
3. Choose a shipping method.
4. Optionally, input a tracking number, choose a carrier, and add your comments.
5. If necessary, change the order status.
6. Click the Create button.
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Printing package slips
To print a package slip for a particular shipment or several package slips for multiple shipments at a time:
1. In the administration panel, go to the Shipments section (Orders

Shipments).

You will see a list of all shipments in the store. If necessary, filter the list of displayed orders using the search panel above
the list of shipments.
2. Select shipments for which you need to print package slips.
3. Click the button

and choose Packing slip bulk print.

3.4. Return requests
Here you can handle product return requests that your customers have registered as well as configuring the general product
return policy of your store. A few other parameters related to product returns are configured on the settings page for the RMA
add-on module.
Tip: To allow for return requests in your store, activate the RMA add-on module in the Add-ons section of the administration
panel (Add-ons

Manage Add-ons

RMA). There you can also configure some essential settings that relate to return

requests.
The section consists of four subsections: Return requests, RMA reasons, RMA actions, and RMA request statuses. To switch
between the subsections, use the gear button on the right.

3.4.1. Return requests
Managing return requests
The Return requests subsection contains a simple list of product return requests. You can sort or filter the list according to
different parameters. To filter the requests, use the search panel to the right of the list.
To handle a particular request, click the button

corresponding to the request and choose Edit. This will uncover the

request details (separated into four tabs):
Return products information - Contains a list of products from the request that are or will be approved for the return.
Declined products information - Contains a list of products from the request that are or will be declined for the
return.
Comments - Contains user comments about the requested return.
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Actions - Contains controls to handle the return request.

Changing a request status
To change the status of a return request:
1. Open the request for editing and go to the Actions tab.
2. Select a new status from a drop-down list.
3. If necessary, choose to recalculate the original order.
4. If necessary, select to notify the customer and the order department.
5. Click the Save button to apply the changes.

Declining/approving individual products
If a request consists of multiple products but you are going to accept only few of them, you can decline the products by
excluding them from the list of approved returns.
To decline a product or several products at a time:
1. Open the Return products information tab.
2. Select the check boxes for the products you want to decline.
3. Click the Decline products button above the list.
The products will appear in the list of declined products.
To approve a declined product:
1. Open the Declined products information tab.
4. Select the check boxes for the products you want to approve.
5. Click the Accept products button above the list.
The products will appear in the list of accepted products.

Printing a packing slip
You can print a packing slip for requested product returns.
To print a slip for an individual request, click the button

on the requests details page and choose Print slip. To print

packing slips for several requests at a time, on the return requests page select the check boxes corresponding to the request,
click the button

in the right upper corner of the page and choose Packing slip bulk print.

Note: A packing slip includes only those products that are approved for the return.

Issuing a credit/gift certificate
For each approved product from a return request, you can issue a gift certificate which worth completely agrees with the cost
of the returned product. Alternatively, you can issue one gift certificate for all approved products from the request. In this case,
the certificate worth will be the same as the original subtotal of the returned products.
To issue a gift certificate:
1. In the Return products information tab, select the required products.
2. Click the Create gift certificate button above the list of approved products.
3. If prompted, confirm the action.
The code of the new certificate will appear above the tabs.
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3.4.2. RMA reasons
When submitting a return request, customers are asked to specify a reason why they want to return a particular product. The
store administrator can adjust the default set of reasons by adding (the button

) or removing reasons. It is also possible to

activate or disable a certain reason from the list, which is useful when you need to temporarily deactivate the reason, but plan
to use it again later.
To activate or disable a reason, click on the Active/Disabled link, corresponding to the particular reason, and choose the
required status from the drop-down menu.
You can also change the formulation of the reason and it's position on fly here.

Adding a reason
To add a product return reason:
1. Click the button

.

This will open a form with the new reason details.
2. Complete the fields in the form.
Reason - Return reason as it appears on the customer storefront.
Position - Ordinal number conveying the position of the new reason relative to other reasons from the list.
Status - Initial status of the new reason (active or disabled.)
3. Click the Create button.

3.4.3. RMA actions
RMA actions refer to the actions that a customer may expect to be taken towards his or her return requests: replace an item or
make a refund. Customers are asked to choose a preferable action when they submit a return request. If a particular action is
not applicable in your store, you can disable the action.
To activate or disable an action, click on the Active/Disabled field, corresponding to the particular action, and choose the
required status from the drop-down menu.

3.4.4. RMA request statuses
By default, there are four possible statuses for return requests: Approved, Complete, Declined, Requested. The latter status is
automatically assigned to all newly submitted requests, and then the store administrator can manually change the request
status. If necessary, you can expand the default set of request statuses with custom statuses.
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To add a custom request status:
1. Click the + button in the right upper corner of a page and choose Add status. This will open a pop-up window with a form for
the new status details.
2. Fill out the form. Fields marked with an asterisk (*) are mandatory.
Name - Name of the status.
E-mail subject - Subject of an email message that is sent to customers automatically when the request status
changes to this status.
E-mail header - Header of an email message that is sent to customers automatically when the request status changes
to this status.
Inventory - Choose whether to decrease or increase the number of items in stock for products included in the return
request.
3. Click the Create button.
You can also Edit or Delete statuses with the

button choosing the required action from the drop-down menu. Default

statuses can not be deleted.

3.5. Call requests
In this section you can see a list of customer call requests.

When a customer clicks the Buy now with 1-click link on the product details page and fills in the form, a new order with the
Awaiting call status is formed in the list of orders. At the same time a call request is generated that can be looked through and
managed on this page. If a customer fills in only the Phone field, only the call request is created (without an order).
A customer can also click the Request call link on the storefront (if the Call requests block is added in the Design >
Layouts section). In this case a call request is created too where the list of products added to a customer's cart is mentioned.
Tip: To allow call requests in your store, activate the Call requests add-on in the Add-ons section of the administration panel
(Add-ons

Manage Add-ons

Call requests). There you can also configure some essential settings that relate to call

requests.

For each call request in the list you can see the following information:
ID - A request identifier as it appears in the administration panel.
Date - Date and time when a request was sent.
Name and phone - Name and phone of a customer who sent a request (as he/she wrote them in a form).
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Order/Status - Order ID as it appears on the View orders page and its status.
Responsible - Here you can choose an administrator responsible for calling a customer.
Status - Status of a call request. All newly sent requests have the New status.
In this list you can also see the requested products for each call request and the convenient time for calling a customer.
To add some notes for a call request, just type them in the Notes field.

To change a request status, click on the current status in the Status row and choose the required status from the drop-down
menu:
New - A call request was just sent by a customer.
In progress - An administrator is working on a request.
Completed - A customer was called to.
No answer - A customer was called to, but there was no answer.

To delete a call request, hover the mouse pointer over it. You will see a gear button. Click it and choose Delete. To delete
several requests at once, tick checkboxes to the left of them, click the gear button in the right top corner of the page, and
choose Delete selected.
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4. Products
This section of the Administration panel assembles control elements for managing the product catalog. The two key concepts
to describe the cataloguing in CS-Cart are the product and the category of products, or simply the category.
Finding a right product in a web store becomes much easier if the products in the catalog are categorized, i.e. are sensibly
arranged into groups of related products, or categories. Each product category can include an unlimited number of child
categories which, in return, can include own child categories. Child categories are referred to as sub-categories while the
categories that do not have parent categories, i.e. categories of the highest level, are called root categories. The system of
categories enables you to build the catalog in the way of a tree with multiple branches, making the navigation structured,
intuitive, and clear.
On the storefront, categories generally appear in a special side bar. Yet, you can show them as a horizontal menu or even
differently depending on the theme that you use for the storefront.
Tip: Individual products cannot appear outside a product category, so every product that you have in your catalog must be
assigned to at least one category.

4.1. Categories
Use this section to manage product categories. When you open the section, it displays a list of all categories and subcategories in the store.
Note: The nature of using categories in a multiple-store environment is described in "Understanding multi-store functionality".
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Actions on categories
The store administrator can carry out the following actions on the categories:
Add individual categories (the

button) or several categories at a time (the Bulk category addition link under the

button).
Change attributes per category or simultaneously for several categories (the Edit selected link under the
Delete categories (the Delete selected link under the

button).

button).

Caution: Be careful when deleting a category! Child categories and the products under the category will be deleted
automatically.

Category attributes
When you create or edit a category, your should specify a number of category attributes. For convenience, attributes are
grouped under several tabs.
General tab:
Information
Name - Name of the category as it appears on the storefront and in the Administration panel.
Location - Position of the category in the category tree: a root category or a child category of a parent category.
Description - Description of the category as it appears on the storefront.
The description that you enter here follows the category name and helps visitors understand what kind of product they
should expect to find under the category.
Besides, an informative description is just another SEO-wise opportunity.
The description can be either a plain text or a formatted HTML text. If you are not familiar with HTML, you are encouraged
to add a formatted description using the built-in WYSIWYG HTML editor.
Status - Status of the category (Active - category is available on the storefront, Disabled - category is not available on
the storefront, or Hidden - category does not appear on the storefront, but customers can access it via a direct link.)
Store - Store to which the category belongs.
Images - Pair of images to illustrate the category: a category thumbnail and a large category image.
Both images can be either uploaded from a local computer or the server file system, or linked to a remote location where the
required image is physically located.
Images must be of one of the following formats only: JPEG, GIF, PNG. Maximum size of an uploaded image depends on your
server configuration. As a rule, it should not exceed 2 MB.
An alternative text describes an image in words. Technically, the text that you enter appears inside the alt="" and title=""
attributes of the <img> HTML tag. The text is shown when the image is missing or cannot be displayed. It is good practice to
have an alternative text associated with the image as an additional SEO-wise opportunity.
Meta data
Page title - Title of the category page on the storefront, which is displayed in the web browser when somebody is
viewing the page. Required for SEO purposes.
META description - Contents of the HTML meta tag describing the category. Required for SEO purposes.
META keywords - Contents of the HTML tag containing a list of search keywords for the category. Required for SEO
purposes.
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Availability
User groups - User groups whose members can access the category.
Position - Position of the category relatively to the other categories of the same level. If no category positions are
defined, categories are sorted alphabetically.
Creation date - Date when the category was added to the catalog.
Layouts tab (the category contents):
This tab duplicates the global layout of the location to which this storefront page belongs (see Design

Layouts.)

By using this tab, you can disable blocks that are globally enabled, and, on the contrary, enable blocks that are globally
disabled. This makes it possible to configure an individual layout for different storefront pages.
Any modification that you make under this tab will not affect other storefront pages.
Tip: For more information on blocks, see Design > Layouts.
This tab is displayed only when you edit the existing category, not when create new.
Add-ons tab (applicable category attributes that depend on the active add-on modules):
Age verification - If selected, the access to the category is limited by the customer age.
Age limit - Minimum age for accessing the category and the products under the category.
Warning message - Message to be displayed if the customer does not qualify for the category contents.
Reviews - Customer reviews or ratings, or both.
Note: The attributes require the Age Verification and Comments and Reviews modules to be enabled and configured.
Views tab (appearance of the product under the category):
Product details view - Choose a template for all product details pages within the category.
Use custom view - If selected, you can choose a non-default view.
Product columns - Number of columns that the products under the category are displayed in. This option works for the
Grid view only, but you can still use it with a custom view.
Available views - Select the category views that customers should be able to select from when viewing the category.
Default category view - Select the default category view.
Reward points tab (number of points that customers receive at their accounts when buying category products):
Override global point value for all products in this category – If selected, the below values prevail over the global
points that are defined in the Reward points section.
User group - User group whose members are granted reward points for buying the category products.
Amount - Number of reward points to be granted to a user group member who bought the category product.
Amount type - Absolute number of points or percentage-based value calculated in the following manner: the product
cost is divided into 100, and the result is multiplied by the value in the field.
Reviews tab:
List of customers' reviews of the category. Requires that the Reviews field in the Add-ons tab be set to Communication,
Rating, or both:
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4.2. Products
Use this section to manage the products in your catalog. When you open the section, it displays a sorted list of all products in
the store. To filter the list, use the search to the right of the list.
Each entry in the list has the following attributes:
Image – Product thumbnail.
Name – Name of the product and the internal product code (SKU number). This number must not necessarily be
unique, or it can even be missing.
Price – Product price.
List price – Price suggested by the product manufacturer. Good practice is to show that your price is lower than the list
price.
Quantity – Number of products in the stock.
Status – (Active – product is available on the storefront, Disabled – product is not available on the storefront, or Hidden
– category does not appear on the storefront, but customers can access it via a direct link.)
These attributes can be changed on the fly without opening the product for editing.

Actions on products
The store administrator can carry out the following actions on the products (the button
Add products individually (the button

):

) or in bulk (the Bulk product addition link) and clone products (the Clone

selected link).
Change product attributes per product (the Edit link) or simultaneously for several products (the Global update link).
Export products (the Export selected link). See topic Administration/Export data for more information about export
procedures.
Delete products.
Look through the list of products with subscriptions with the help of Product subscriptions link.
Export products to eBay with the Export to eBay link (the eBay synchronization add-on must be installed and set up
in the Add-ons > Manage add-ons section).
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Product attributes
When you create or edit a product, you should specify a number of product attributes. For convenience, attributes are grouped
under several tabs.
General tab:
Information
Name – Name of the product as it appears on the storefront and in the Administration panel.
Categories – Categories that the product will be assigned to. To define the product main category, select the
corresponding radio button.
Price – Base product price in your store main currency.
Full description – Full product description appearing on the product details page of the storefront.
The description can be either a plain text or a formatted HTML text. If you are not familiar with HTML, you are encouraged
to add a formatted description using the built-in WYSIWYG HTML editor.
An informative description not only helps your customers better understand whether they need this product, but it is also
just another SEO-wise opportunity.
Status – (Active – product is available on the storefront, Disabled – product is not available on the storefront, or Hidden
– product does not appear on the storefront, but customers can access it via a direct link).
Store - Store to which the product originally belongs.
Images – Pair of images to illustrate the product: a product thumbnail and a large product image.
Both images can be either uploaded from a local computer or the server file system, or linked to a remote location where the
required image is physically located.
Images must be of one of the following formats only: JPEG, GIF, PNG. Maximum size of an uploaded image depends on your
server configuration. As a rule, it should not exceed 2 MB.
An alternative text describes an image in words. Technically, the text that you enter appears inside the alt="" and title=""
attributes of the <img> HTML tag. The text is shown when the image is missing or cannot be displayed. It is good practice to
have an alternative text associated with the image as an additional SEO-wise opportunity.
Options settings
Options type - Select a type of the product options, i.e. how this product options and variants appear on the storefront:
Simultaneous - all options and variants appear simultaneously and independently; Sequential - options and variants are
chosen successively one after another, and customers will be able to choose only the allowed option combination,
avoiding exceptions.
Exceptions type - Select a type of the product options exceptions: Forbidden - all option exceptions are forbidden, and
the customer cannot add the product with such option combination to the cart, all other option combinations become
permissible; Allowed - all option exceptions are allowed, and the customer can add the product with such option
combination to the cart, all other option combinations become impermissible. To specify product options, use the
controls under the Options tab.
Pricing / inventory
CODE – Internal product code (SKU number).
List price – Price suggested by the product manufacturer. Good practice is to show that your price is lower than the list
price.
In stock – Number of products in the stock. By default, products that are out of stock do not appear on the storefront
until you enable the Allow negative amount in inventory option in Settings
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Zero price action – Allowed action on the product if the product has zero price. Allow or disallow users to add the
products to the cart or ask users to enter a custom price.
Inventory – Way of tracking the inventory of the current product: track with product options or without product options
or do not track at all. If the product is selected to be tracked with options, the common product quantity becomes
unavailable, and you are supposed to specify the number of in-stock items individually for each product option/variant.
Minimum order quantity - Minimum number of product items that a customer must add to the cart to be able to order
the product. The minimum amount always appears on a product details page of the storefront right after the product
price.
Maximum order quantity – Maximum number of product items that a customer can order at a time. 0 means no
maximum limit.
Quantity step – Number of product items between the two ing choices in the Quantity select box.
List quantity count – Maximum of choices in the Quantity select box.
Taxes – Select applicable taxes. To configure the set of available taxes, use the section Shipping/Taxes.

Availability
User groups – User groups whose members can access the product.
Creation date – Date when the product was added to the catalog.
Avail since – Date when the product becomes available for sale.
Out-of-stock actions – Select if customers should be able to buy the product in advance before it is not yet available
for sale, or sign up to receive an email notification when the product is available. Note that the "Buy in advance" option
requires that you have the product in stock, while the "Sign up for notification" option requires that you have it out-ofstock. Also, the "Sign up for notification" option cannot apply to products which are tracked with options.
Extra
Product details view - Choose a template for the page view.
Feature comparison – If selected, the product can be chosen for comparison. Availability of the feature comparison
chart on the storefront is controlled by a separate block with the Feature Comparison content type (see section Design > Layouts for details).
Downloadable – If selected, the product is labeled as downloadable, i.e. distributed by download.
Enable shipping for downloadable products – If selected, shipping is available for this downloadable product.
The Enable selling downloadable products checkbox must be chosen in the Settings > General > Catalog section to
enable this functionality.
Time-unlimited download – If selected, the product download period never expires. As a rule, download links expire
after a certain period of time that is controlled by Download key TTL option in Settings

General

Short description – Short product description appearing on a product list page of the storefront.
The description can be either a plain text or a formatted HTML text. If you are not familiar with HTML, you are encouraged
to add a formatted description using the built-in WYSIWYG HTML editor.
If you leave this field blank, the short description will be automatically taken from the full product description (first 300
characters).
Popularity – Integer conveying the product popularity, which is calculated automatically. This rating depends on the
number of product views as well as the number of times the product was added to the cart and purchased. If necessary,
you can manually adjust this value. Product popularity influences the way the products are arranged on the storefront.
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Search words – List of words by which the product should be easily found in the built-in search facility.
Promo text – Type some important information about the product here in the form of a short message.
Images tab (additional product images):
This tab contains additional images for the product. Each additional image is represented as a pair of images: a thumbnail and
a large pop-up image. Additional thumbnails appear on the product details page of the storefront beneath the main image
thumbnail. And when a customer chooses to enlarge the active thumbnail, it expands into the large pop-up window.

Both images can be either uploaded from a local computer or the server file system, or linked to a remote location where the
required image is physically located.
Images must be of one of the following formats only: JPEG, GIF, PNG. Maximum size of an uploaded image depends on your
server configuration. As a rule, it should not exceed 2 MB.
An alternative text describes an image in words. Technically, the text that you enter appears inside the alt="" and title=""
attributes of the <img> HTML tag. The text is shown when the image is missing or cannot be displayed. It is good practice to
have an alternative text associated with the image as an additional SEO-wise opportunity.
To add two or more image pairs, use these graphic controls:
SEO tab:
Page title – Title of the product page on the storefront, which is displayed in the web browser when somebody is
viewing the page. Required for SEO purposes.
META description – Contents of the HTML meta tag describing the product. Required for SEO purposes.
META keywords – Contents of the HTML tag containing a list of search keywords for the product. Required for SEO
purposes.

Options tab (product options and variants:)
This tab allows you to manage the product options and option variants as well as controlling the option combinations and
adding forbidden/allowed combinations.
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Note: In this tab, you can also add a global option to the product. For instructions on how to use global options, please refer to
the Global options section further in this guide.
Product options appear on the product details page on the storefront as selectable or input parameters to the product. Options
can have the following attributes:
Name – Name of the product option as it appears on the storefront.
Position – Position of the product option relatively to the position of the other options in the list.
Inventory – If selected, the option has a separate number of items in stock, which is tracked separately.
Store - Store unit to which the option originally belongs.
Type – Type of the product option: Select box, Radio group, Check box, Text, Text area or File. For a specification of
some of the option types, please refer to the CS-Cart knowledge base at http://kb2.cs-cart.com/settings-text-option .
Description – Description of the product option as it appears on the storefront under the question sign (?) next to the
option name.
Comment – Comment to be displayed below the option on the storefront.
Required – If selected, this option is mandatory for selection/completion.
Missing variants handling - Select how impermissible/missing option combinations should be handled: Display
message - the option will be marked as not available, if the option is mandatory (see the previous setting) customers will
not be able to add the product to the cart; Hide option completely - the option will be hidden, if the option is mandatory
(see the previous setting) customers will be able to add the product to the cart.
An option variant is an extension to the product option of type select box, radio group or check box, which may have a separate
status, icon and amount of reward points as well as a weight modifier and a price modifier. Option variants have the following
attributes:
Position – Position of the variant relatively to the position of the other variants in the list.
Name – Name of the product variant. For example, if the option is titled “Size”, the product variants to the option can be
“small”, “medium”, “large”, etc.
Modifier/Type – Positive or negative value that modifies the original product price. The modifier can be either an
absolute value or a percentage.
Weight modifier/Type – Positive or negative value that modifies the original product weight. The modifier can be either
an absolute value or a percentage.
Status – Status of the product option (Active or Disabled.)
Icon – Thumbnail to represent the option variant. The image can be either uploaded from a local computer or the server
file system or linked to a remote location where the required image is physically located. An alternative text describes the
image and is shown when the image is missing or cannot be displayed. It is good practice to have an alternative text
associated with the image as an additional SEO-wise opportunity.
Earned point modifier/Type – Positive or negative value that modifies the original number of reward points that
customers receive at their accounts when they buy the product. The modifier can be either an absolute value or a
percentage.
Shipping Properties tab:
This tab contains a number of product properties that are important for shipping this product to customers.
Weight – Weight of a single product item in the store's default weight unit.
Free shipping – If selected, the product is delivered to the customer free of charge, i.e. no shipping cost for the product
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is calculated.
Shipping freight – Handling fee (insurance, packaging, etc.) added to the product cost.
Items in a box – Minimum and maximum number of product items to be shipped in a separate box.
Box length – Length of a separate box.
Box width – Width of a separate box.
Box height – Height of a separate box.
The last four options are required for a more accurate shipping cost estimation when a real-time shipping method with the
support for multi-box shipping is used (UPS, FedEx and DHL.) If you do not specify box dimensions, values will be taken from
the global configuration settings of a particular shipping carrier. Also see topic Shipping & Taxes.

Quantity discounts tab (product wholesale prices):
This tab contains a list of the product wholesale prices that have the following attributes:
Quantity – Minimum number of product items to qualify for the product wholesale price.
Value – Product wholesale price (per item.)
Type – Type of the discount: Absolute - cost of 1 discounted item; Percent - percent discount off the base product item
price. Percentage discount has certain natural limitations: the discount cannot be more than 100%, and the discount will
not be saved as long as it applies to 1 product item and all user groups.
User group – User group whose members can take advantage of the wholesale price.
Files tab (files for the downloadable product:)
This tab contains a list of files that are associated with this downloadable product. Each file may have the following attributes:
Name – Name of the file as you customers will see it on the product page. Note that it does not change the original file
name.
Position – Position of the file relatively to the position of the other files in the list.
File – File to be downloaded. The file can be uploaded from a local computer or the server file system, or be linked to a
remote location where the file is physically located.
Preview – Preview file that can be freely downloaded from the product details page on the storefront.
Activation mode – Mode of download link activation: Immediately = immediately after the order has been placed; After
full payment = once the order status has changed to Processed or Complete; Manually = manually by the store
administrator.
Max downloads – Maximum number of allowed product downloads per customer.
License agreement – Text of the file's license agreement.
Agreement required – Option to persuade customers accept the license agreement at checkout.
Readme – Text of the files's "read me" file (e.g., installation instructions, etc.)
Folder - Choose a folder, to which the file belongs (if you created any.)
Subscribers tab:
This tab contains a list of email addresses that visitors have left to receive a notification when the product is back in stock. To
allow visitors to subscribe to an out-of-stock product, set the Out of stock actions option (see the General tab) to Sign up for
notifications.
You can add the subscriber by his e-mail with the Add Subscriber button or you can choose subscribers among the
customers of your store with the Select customer button.
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Layouts tab (contents of the product details page):
This tab duplicates the global layout of the location to which this storefront page belongs (see Design

Layouts.)

By using this tab, you can disable blocks that are globally enabled, and, on the contrary, enable blocks that are globally
disabled. This makes it possible to configure an individual layout for different storefront pages.
Any modification that you make under this tab will not affect other storefront pages.
Tip: For more information on blocks, see Design > Layouts.

Add-ons tab (product attributes that depend on the active add-on modules:)
Configurable – If selected, the product is labeled as configurable, i.e. consisting of multiple components. Once you
select this option and save the product, a new tab Configuration will be added to the product details. Use the controls
under this new tab to define the product's configuration.
Returnable – If selected, the product is labeled as available for the return.
Return period – Period of time following the day of purchase during which the product can be returned.
Sales amount – Number of sold product items. This value is calculated automatically if the Bestsellers and on-sale
products add-on is available (Add-Ons > Manage Add-ons). Yet, you can change the current value manually.
Age verification – If selected, the access to the product is limited by the customer age.
Age limit – Minimum age for accessing the product.
Warning message – Message to be displayed if the customer does not qualify for accessing the product.
eBay template – Choose one of the templates created in the Marketing > eBay templates section. This setting
appears when the eBay synchronization add-on is installed and set up in the Add-ons > Manage Add-ons section.
Package type – Type of product package. If you do not know your package type, select the "Large package" option. To
ensure the most accurate cost, you will be asked to enter exact package dimensions. This setting appears when the
eBay synchronization add-on is installed and set up in the Add-ons > Manage Add-ons section.
Override title and description – Choose, if you want the original product name and description to be replaced with
that, specified in the ebay product title and the ebay product description fields (you can see them below). This
setting appears when the eBay synchronization add-on is installed and set up in the Add-ons > Manage Add-ons
section.
eBay product title – The title of the product to be used at eBay. This setting appears when the eBay synchronization
add-on is installed and set up in the Add-ons > Manage Add-ons section.
eBay product description – The description of the product to be used at eBay. This setting appears when the eBay
synchronization add-on is installed and set up in the Add-ons > Manage Add-ons section.
Reviews – Customer reviews or ratings, or both.
Buy Now URL - URL under the Buy Now button that leads to the external website of the product vendor. This setting
appears when the catalog mode is enabled in the Add-ons > Manage Add-ons section.
Features tab (extra fields):
This tab allows you to define the values of the extra fields that are valid for the product. The set of extra fields is controlled in
Products

Features.
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Product tabs tab:
In this tab, you can see the list of tabs, applied to the current product. Next to a tab name you can see its status — Active or
Disabled. You can also see, how the product page looks like with the help of the

button (on behalf of a customer -

Preview, on behalf of admin - Preview as admin.) Editing and adding product tabs is done in the Design

Product tabs

section.

Buy together tab (bound products:)
In this tab, you can bind the product with other products from the catalog and offer a discount if the bound products are bought
together. A set of the bound products is referred to as a product combination. The discount is promoted on the product details
page on the storefront, and customers can decide whether they want to profit by the offer or not.
Along with the set of bound products and the offered discount, each combination has the following attributes:
Name – Name of the product combination.
Description – Description of the product combination as it appears on the storefront.
Available from – Date when the product combination becomes available for customers.
Available till – Date until the product combination is available.
Display in promotions – If selected, the offered product combination appears in Products

Promotions.

Status – Status of the product combination (Active or Disabled.)
Tags tab:
This tab includes a list of tags associated with the product. Tags appear on the storefront in a special side box titled Tag cloud
. For more information about the product tags, please refer to the section Website > Tags further in this guide.
Tags – Tags that have been added to the product. Start typing in this field to add a new tag.You can choose among the
existing variants or create a new tag.
Configuration tab:
This tab appears if the Configurable check box is selected in the Add-ons tab. The configuration may include several product
groups, i.e. components of the configurable products that customer can select on the storefront.
Position – Position of the group relatively to the position of the other groups in the list.
Step – Step at which the component appears.
Group name – Name of the product group that the component belongs to.
Default configuration products – Products selected in the configuration by default.
Required – If selected, the customer must choose a product belonging to the group.
Attachments tab:
This tab contains product attachments, which are files associated with the products. Unlike the contents of the Files tab, the
files that appear here are available for non-downloadable products as well. Each attachment can have the following attributes:
Name – Name of the product attachment.
Position – Position of the attachment relatively to the position of the other product attachments.
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File – File that is used as the product attachment. The file can be uploaded from a local computer or the server file
system, or it can be a link to a remote location where the file is physically located.
User groups – User group whose members the attachment is available for.
Required products tab:
This tab contains a list of required products, which must be bought together with this product. To add a new product click the
Add product button.
To delete or edit required products use these graphic controls:

.

Reward points tab:
Use this tab to set up the product price in reward points and specify the number of reward points to be earned for purchasing
the product.
Allow payment by points – If selected, the product can be paid for with reward points.
Override global PER – If selected, the product has a fixed price in points that is independent of the point-to-money
exchange rate.
Price in points – Fixed product price in points.
Override global/category point value for this product – If selected, the below values override the global reward
points specified in Products

Reward points.

User group – User group whose members are granted reward points for buying the product.
Amount – Number of reward points to be granted to the user group member who bought the product.
Amount type – Absolute number of points or percentage-based value calculated in the following manner: the product
cost is divided into 100, and the result is multiplied by the value in the field.
Reviews tab:
List of customers' reviews of the product. Requires that the Reviews field in the Add-ons tab be set to Communication,
Rating, or both. In this tab, you can add own reviews and edit existing product reviews and ratings.

Also read in CS-Cart Knowledge Base:
Wholesale Prices
Downloadable Products
Displaying Same Product under Several Categories
Attaching Files to Products
Feature Comparison
Applying Same Value to All Products
Product Options
Exceptions/Forbidden Combinations
Adding Images to Product Option Combinations

4.3. Features
Use this section to add and manage extra product fields. Later, these features may be used to supplement standard product
information. For example, it can be a field for ISBN, if you sell printed books, a field for audio formats, if you sell music, etc.
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The section contains a list of all product features that are available in your store. Optionally, you can arrange features into
groups and then edit the settings of the whole group instead of editing every single feature.

Product feature and feature group attributes
General tab:
Name - Name of the feature as it appears on the storefront and in the Administration panel.
Store - Store to which the product feature originally belongs.
Feature code - Individual code to identify the feature.
Position - Position of the feature relatively to the position of the other features in the list.
Description - Product feature description that appears on the storefront if the customer clicks the question sign (?) next
to the feature name in the Feature tab.
Type - Type of the field for the feature: Check box (Single, Multiple), Select box (Text, Number, Extended) or Others
(Text, Number, Date). Selecting the Extended type enables you to extend feature values with several extra attributes like
a separate image, description, page title, META description, and keywords.
Group - Group that the product feature belongs to. If you assign the feature to a group, the next two attributes (Product
and Catalog pages) will apply to the whole group, not just the feature.
Show on the Features tab - If enabled, the product feature is displayed on the product details page as a separate
tab.
Show in product header - If enabled, the feature is shown under the product header.
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Show in product list - If enabled, the feature appears on the storefront on a product list page among the other product
details.
Prefix - Characters to come before the feature value.
Suffix - Characters to come after the feature value.
Variants tab:
Pos. - Position of the feature value relatively to the position of the other values in the list.
Variant - Feature value.
Categories tab:
List of categories which products may utilize this feature. If no category is specified, the feature will apply to all categories.
Share tab:
Stores that share this product feature. Read "Sharing objects" for more details.

Also read in CS-Cart Knowledge Base:
Product Features

4.3.1. Google export features
These product features were added automatically as part of the Google Export add-on functionality. They are critical for correct
data feed export to Google Shopping.

4.4. Filters
Product filters are displayed on the storefront and enable your customers to quickly find the products that meet specific
parameters like the price range, manufacturer, etc. The parameters can be either the standard product fields or the extra fields
defined in Products

Features.

You can make filters available in the entire store as well as in specific categories only.
Tip: If product filters do not appear on the storefront, please allocate a special block in Design

Layouts.
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Filter attributes
Below are listed the attributes that can be assigned to a product filter.
General tab:
Name – Name of the filter.
Store - Store to which the product filter originally belongs.
Position – Position of the filter relatively to the position of the other filters in the list.
Show on home page - If selected, the filter appears on the store's home page.
Filter by – Parameter to filter the products by. This can be a default product field (price, free shipping) or an extra field
(product feature) of one of the following types: select box and multiple check box.
Display type - Choose the manner, in which filter will be displayed on the screen.
Number of displayed filter variants before the "more" link - Choose the number of filter variants you want to be
displayed on the screen. The other variants will be hidden behind the "more" link.
Number of displayed filter variants before the "view all" link - Choose the number of filter variants you want to
be displayed in the "more" list. The other variants will be shown on the separate page.
Categories tab:
A list of categories on which pages the filter is displayed. If no category is specified, the filter will appear in all store categories.
Share tab:
Stores that share this product filter. Read "Sharing objects" for more details.

Also read in CS-Cart Knowledge Base:
Filter products by free shipping
Displaying Product filters as a drop-down selectbox menu

© 2004 - 2015 Simbirsk Technologies Ltd.

35

CS-Cart Reference Guide

4.5. Options
Use this section to manage global product options and option variants in your store. Global options work in the same manner
as the product specific options, but they can apply to multiple products.
In this section you can add a new option with the button

or you can apply existing options to products with the Apply to

products button.
To edit or delete an option, click the

button and choose the action from the drop-down list.

Sometimes it is useful to disable options instead of deleting them. To make an option Active/Disabled use the drop-down list to
the left.

Option attributes
Product options appear on the product details page on the storefront as selectable or input parameters to the product. Options
can have the following attributes:
Name - Name of the product option as it appears on the storefront.
Position – Position of the product option relatively to the position of the other options in the list.
Inventory – If selected, the option has its own number of items in stock, which is tracked separately.
Store - Store to which the product option originally belongs.
Type – Type of the product option: Select box, Radio group, Check box, Text, Text area or File. For a specification of
some of the option types, please refer to the CS-Cart knowledge base at http://kb2.cs-cart.com/settings-text-option .
Description - Description of the product option as it appears on the storefront under the question sign (?) next to the
option name.
Comment – Comment to be displayed below the option on the storefront.
Required - If selected, this option is mandatory for selection/completion.
Missing variants handling - Select how impermissible/missing option combinations should be handled: Display
message - the option will be marked as not available, if the option is mandatory (see the previous setting) customers will
not be able to add the product to the cart; Hide option completely - the option will be hidden, if the option is mandatory
(see the previous setting) customers will be able to add the product to the cart.

Variants attributes
An option variant is an extension to the product option of types Select box, Radio group or Check box, which may have its own
status, icon and amount of reward points as well as a weight modifier and a price modifier.
To add or delete options, use these graphic controls:
Option variants have the following attributes:
Position – Position of the variant relatively to the position of the other variants in the list.
Name – Name of the product variant. For example, if the option is titled “Size”, the product variants to the option can be

© 2004 - 2015 Simbirsk Technologies Ltd.

Products

36

“small”, “medium”, “large”, etc.
Modifier/Type - Positive or negative value that modifies the original product price. The modifier can be either an
absolute value or a percentage.
Weight modifier/Type - Positive or negative value that modifies the original product weight. The modifier can be either
an absolute value or a percentage.
Status - Status of the product option (Active or Disabled.)
Icon – Thumbnail to represent the option variant. The image can be either uploaded from a local computer or the server
file system, or linked to a remote location where the required image is physically located. An alternative text describes
the image and is shown when the image is missing or cannot be displayed. It is good practice to have an alternative text
associated with the image as an additional SEO-wise opportunity.
Earned point modifier/Type - Positive or negative value that modifies the original number of reward points that
customers receive at their accounts when they buy the product. The modifier can be either an absolute value or a
percentage.

Share tab:
Stores that share this product option. Read "Sharing objects" for more details.

Also read in CS-Cart Knowledge Base:
Global Product Options
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5. Customers
In this section of the Administration panel, you can manage user accounts that are registered at your store and configure
related settings.
A user account is literally a record in the store database that identifies a registered user and associates the user with the
related data, which includes order statistics, personal info, subscriptions, etc. Furthermore, user accounts are used to control
the activity and privileges of the store users.
CS-Cart has the following types of user accounts:
Administrator - Type of the user who can access both the storefront and the Administration panel and manage and/or
view the store contents and configuration.
Customer - Type of the user who can access the storefront and buy products in your store. Although the storefront is
normally available to non-registered users as well, registered users are supposed to enjoy greater privileges. Besides,
even registered users with a customer account may have different opportunities depending on the user group that they
belong to.
Supplier - Type of the user that is only mentioned in the database, but cannot access the storefront or the
Administration panel. Supplier accounts are used to flag products that belong to third-party providers.
In the Administrators, Customers, and Suppliers sections to display the records that satisfy a certain criterion
or a combination of multiple criteria only, use the form to the right of the list. To access more filtering criteria,
expand the form by clicking the Advanced search reference. If you filter accounts against a particular search
pattern regularly (e.g., to list users from a certain country), you will find it convenient to save the pattern and
add it to the list of predefined patterns appearing in the top right corner.

Quick actions
When you search through the list of users with your mouse pointer, the

buttons appear near the user statuses. Under

this button there is a drop-down list of quick actions, that can be done with the accounts. The set of applicable actions depends
on the type of the account.
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View all orders - Takes you to the list of all orders placed by the user.
Act on behalf of - Takes you to the storefront as if you are logged in as the current user.
Points - Takes you to the customer's reward points log.
Edit - Takes you to the page of editing the user account.
Delete - Permanently deletes the user account.
Warning: This operation is irrevocable. It is recommended that you never delete user accounts, but disable them
instead.
View supplier products - Takes you to the list of products by this supplier.

Enabling and disabling user accounts
Availability of a user account is controlled through the account status. In order to enable or disable the account, you need to
change its status to Active or Disabled, respectively. To change the status, click on the current status to expand a list of all
applicable statuses and then simply click on the new status.

Adding a user
You can add user accounts of the following types:
Administrator;
Customer;
Supplier.
To add a new user, click the button

in right top corner of a page. This will open a form with the user account details.

The exact set of fields may vary depending on the account type and the profile configuration, which is managed in the Profile
fields section.
Please pay attention that a user can have a shipping address that is different from this user's billing address.
After the new account is created, click the

button and choose Edit to configure additional parameters.

The Add-ons tab enables you to specify the customer's age.
The User groups tab enables you to assign the account to one of the available user groups.
A user's membership in a user group is managed by the statuses, which are Active (user belongs to the group), Pending (user
has applied for the groups and is waiting for approval), Available (group is available for application,) and Declined (user's
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application was declined).

5.1. Administrators
This section contains a sorted list of store administrators, registered users with an administrator account. The section
functions as described in the Customers section.

5.2. Customers
This section contains a sorted list of store customers, registered users with a customer account. The section functions as
described in the Customers section. A noteworthy feature appearing in this section is the Points link that takes you to the
customer's reward points log.

Customer's reward points log
This page shows the current reward point balance and the history of the balance changes. It enables the store administrator to
manually credit or withdraw reward points (the button

).
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5.3. Suppliers
This section contains a sorted list of store suppliers, registered user accounts that have the Supplier type.
Note: This section requires that you have the Suppliers add-on enabled in Add-ons

Manage Add-ons.

Adding a supplier account
To add a supplier account:
1. In Customers

Suppliers, click the

button.

This will open a form with the account details.
2. Complete the form in the General tab.
The exact set of fields may vary depending on the profile configuration, which is managed in the Profile fields section.
3. Switch to the Products tab.
Click the Add product button to add supplier's products from the product catalog.
4. Switch to the Shippings tab.
Choose shipping methods that will be available for a supplier.
5. Click the Create button.
The new account will appear among the other supplier accounts.

Adding new supplier's products
A new supplier's product can added to the catalog in the same manner as you add regular products. The only difference is that
you need to assign the product to one of the store suppliers. This is done on the product details page in the General tab.

Choosing shipping methods for a supplier
The are two ways to add shipping methods for a supplier:
Choose shipping methods on the supplier account details page (Customers > Suppliers) in the Shippings tab.
Go to Administration > Shipping and taxes > Shipping methods and choose the desired shipping method. Open the
Suppliers tab and choose the checkbox of your supplier.
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5.4. User groups
This section contains a list of user groups that exist in your store. Groups are used to control users' access to products and
categories as well as shipping and payment methods. In this respect, groups can be regarded as different membership levels.
Besides, groups enable you to introduce multiple pricing schemes into the store. Administrator user groups control the set of
tasks that the group members are allowed to execute.
For instructions on how to assign a user to a group, please refer to the section Customers earlier in this chapter.

Adding a user group
1. Click the button

. This will open a form with the group options.

2. Complete the form.
The General tab:
User group - Name of the group;
Type - Type of the group;
Status - Initial status of the group.
3. Click the Create button.
The new group will appear among the other user groups.

Approving membership requests
Customers can apply for a user group by clicking on the Join link on the storefront (Profile details > User groups tab). And
the store administrator is supposed to either approve or decline the request.
To process a request:
1. Click on the button

and choose the User group requests tab to open a list of pending requests.

2. Select the check boxes for the requests you want to process and click either the Approve selected or the

button.

You can also change the status of a particular request with the help of the drop-down menu to the right. You must act from
the root administrator account to do this actions.

Configuring administrator permissions
For each user group of the administrator type you can define the set of privileges and permissions, i.e. specify the tasks that
the group members are allowed to execute.
To configure administrator permissions:
1. Click on the

corresponding to the required administrator group in the list and choose the Edit link, choose the

Privileges tab. This will open a list of administrator tasks.
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3. Click the Save button to apply the changes.
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6. Marketing
Under this section of the Administration panel there are combined various facilities to increase your website traffic and sales
level.
Such systems as Gift certificates, Reward points, and Promotions make you store far more attractive for customers.

6.1. Promotions
This section introduces another tool to promote goods and offer bonuses basing on customers memberships. Here you can
specify the conditions that must be met to qualify for a bonus and the available bonuses.
The page contains a list of all promotions in your store.

CS-Cart supports two types of promotions that differ in the type of the bonus:
Cart promotions - Discounts on products and orders as well as discount coupons, free shipping, free products,
membership level, etc.
Catalog promotions - Discounts on products.

Attributes of promotions
General tab:
Name – Name of the promotion.
Detailed description – Description of the promotion. The description can be either a plain text or a formatted HTML
text. If you are not familiar with HTML, you are encouraged to add a formatted description using the built-in WYSIWYG
HTML editor.
Short description – Description of the promotion as it appears on the storefront on the order info page (My account >
Orders > Order info). The description can be either a plain text or a formatted HTML text. If you are not familiar with
HTML, you are encouraged to add a formatted description using the built-in WYSIWYG HTML editor.
Store - Store to which the promotion originally belongs.
Use available period - If selected, the promotion is available for the period of time specified below.
Available from – Date when the promotion becomes available for customers.
Available till – Date until the promotion is available.
Priority – Order in which the promotion applies relatively to the order of the other promotions. If two promotions have the
same priority, they are applied in the same order as they are retrieved from the database.
Stop other rules – If selected, other promotions do not apply.
Status – Status of the promotion (Active, Hidden or Disabled.)
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Conditions tab:
Use this tab to state conditions that must be met in order that the customer could receive a bonus. Conditions that you set up
here use different attributes and values connected with basic logical constants and comparison operations. To allow for more
flexible rules, conditions can be arranged into groups.
Bonuses tab:
Use this tab to configure the bonuses that the customer receives if the conditions of the promotion are met. When creating a
bonus, you are expected to choose the bonus type and then specify its value.
The following bonuses are available:
Order discount – Give a discount on the whole order.
Note: Discounts that apply to order total do not affect taxes.
Discount on products – Give a discount on the selected products.
Discount on all products in categories – Give a discount on all products from the selected categories.
Give user group – Assign the customer to the user group.
Give coupon – Give a discount coupon.
Free shipping – Deliver products for free.
Free products – Give products for free.
Gift certificate – Give the customer a gift certificate.
Give points – Add reward points to the customer account.
Share tab:
Stores that share this promotion. Read "Sharing objects" for more details.

Also read in CS-Cart Knowledge Base:
Discount on Order If Order Total Exceeds Certain Value
Applying Discount to Specific User Groups
Discount on Products From Specific Categories
Discount on Order if Total Number of Products Exceeds Certain Value

6.2. Abandoned / Live carts
This section keeps personal lists of products that your store visitors added to their carts and wishlist, but that have not been
purchased for some reason or another. For registered customers, the products from the list are automatically added to the
cart when they visit your store again.
Note: Each store tracks storefront visitors' cart separately.
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The section is equipped with a handy advanced search option allowing you to filter carts/wishlists against versatile parameters.
Use the Advanced search link to expand the advanced search facility.

6.3. Newsletters
Use this section to create and send newsletters to your customer. In addition, this section enables you to create templates,
autoresponders, and campaigns.
Tip: In order to use this functionality, you need to enable and configure Newsletters add-on in Add-ons

Manage Add-ons.
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6.3.1. Newsletters
Newsletter is an information letter available to store users by subscription.

Newsletter attributes
When you create a newsletter, you need to specify the following details:
Subject - Name of the newsletter.
Random subjects (one per line) - List of subjects that will be randomly selected for the newsletter subject.
HTML body - HTML formatted body of the newsletter. If you are not familiar with HTML, use the built-in HTML editor.
Note: The HTML body can include the following variables that will be automatically replaced with true values:
%UNSUBSCRIBE_LINK
%SUBSCRIBER_EMAIL
%COMPANY_NAME
%COMPANY_ADDRESS
%COMPANY_PHONE.
Template - Choose to use one of the existing newsletter templates (if any) and press the Load button.
Campaign - Choose a campaign that the newsletter is associated with.
Status - Status of the newsletter.
Mailing lists - Choose a mailing list for the newsletter. The mailing list can be created for each store separately and
then, shared among other stores.
Users - Adding individual users as opposed to assigning the newsletter to a mailing list.
Send to test e-mail - Enter an email address to receive a test newsletter and press the Send button.
Customers with abandoned ... which is ... days old - Select to sent the newsletter to all customers who
abandoned their carts, whishlists or both a certain number of days ago.
You can send the newsletters for customers of each store separately.

Also read in CS-Cart Knowledge Base:
How to send a newsletter

6.3.2. Templates
A template is a pattern that you can use for quick creation of future newsletter.

Template attributes
When creating or editing a template, you need to specify the following attributes:
Subject - Name of of the template.
HTML body - HTML formatted body of the newsletter. If you are not familiar with HTML, use the built-in HTML editor.
Note: The HTML body can include the following variables that will be automatically replaced with true values:
%UNSUBSCRIBE_LINK
%SUBSCRIBER_EMAIL
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%COMPANY_NAME
%COMPANY_ADDRESS
%COMPANY_PHONE.
Template - Choose to use one of the existing newsletter templates (if any).
Status - Status of the template.

Also read in CS-Cart Knowledge Base:
How to create a newsletter template

6.3.3. Autoresponders
An autoresponder is a typical message that is automatically sent to customers in response to some action (e.g., to confirm a
subscription or unsubscribe from newsletter, etc.) Autoresponders are usually associated with a mailing list.

Autoresponder attributes
When you create or edit an autoresponder, you need to specify the following details:
Subject - Subject of the autoresponder.
HTML body - HTML formatted body of the autoresponder. If you are not familiar with HTML, use the built-in HTML editor.
Note: The HTML body can include the following variables that will be automatically replaced with true values:
%UNSUBSCRIBE_LINK
%SUBSCRIBER_EMAIL
%COMPANY_NAME
%COMPANY_ADDRESS
%COMPANY_PHONE.
Template - Choose to use one of the existing newsletter templates (if any).
Status - Status of the autoresponder.
Send to test e-mail - Enter an email address to receive a test newsletter and press the Send button.

6.3.4. Campaigns
A campaign is an easy tool to track your newsletters and represent simple statistics (number of times customers followed the
link in the associated newsletters).
To launch a campaign:
1. Register a campaign by using the button

in Marketing

Newsletters

Campaigns.

2. Then you need to assign this campaign to a newsletter on the newsletter details page.
In this section you can add a new campaign with the button
following button:

or view the campaign statistics/delete the campaign with the

.

You can also change the campaign status with the help of the drop-down menu to the right.
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6.3.5. Mailing lists
Use this section to manage your mailing lists. A mailing list is a simple register of users (their names and email addresses)
who are subscribed to receive your newsletters that you create in Marketing
mailing list is managed in Marketing

Newsletters

Newsletters. The set of subscribers to a

Subscribers.

Important: To allow customers to sign up for a newsletter, make sure a block with the Newsletters: Newsletter
subscription form template is defined in the section Design > Layouts.

Creating a mailing list
To create a mailing list:
1. In Marketing

Newsletters

Mailing Lists, click

.

2. Complete the form in the pop-up window. The meaning of fields is described later in this topic.
3. Click Create. The new mailing list will appear among the other lists in the store.

Adding subscribers to a mailing list
To adding subscribers to a mailing list:
1. Create a mailing list as described above, if you has not created it yet.
2. In Marketing

Newsletters

Mailing Lists, click the button

3. Click Add subscribers. You will be redirected to the list of subscribers.
4. Click to expand the details of a subscriber.
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5. Select the Subscribed check box corresponding to the mailing list. Optionally, select the Confirmed check box to mark this
user's subscription confirmed.
Please remember that good practice is to ask users to confirm their subscriptions themselves.
6. Repeat the previous step for all users who you want to add to the mailing list.
7. If necessary, register more users by choosing the Add customer tab or add a new subscriber by choosing Add
Subscriber (use the following button:

).

Mailing list attributes
When creating or editing a mailing list, you need to specify the following attributes:
General tab:
Name - Name of the mailing list.
From name - Name of the sender (e.g., your company name).
From email - Email address of the sender.
Reply to - Email address to appear in the reply-to field of newsletters.
Confirmation e-mail - Autoresponder for this mailing list. Autoresponders are created in Marketing

Newsletters

Autoresponders.
Show at checkout - If selected, customers are offered to subscribe to newsletters (i.e., join the mailing list) on the
checkout page.
Show on registration - If selected, customers are offered to subscribe to the newsletter (i.e., join the mailing list) on
the registration page.
Subscribers - Follow the Add subscribers link to add subscribers to the list. Or you can add subscribers later in the
Content -> Subscribers section.
Status - Status of the mailing list (Active = customer can subscribe to the mailing; Hidden = only the store
administrator can subscribe customers to the mailing; Disabled = the mailing is not available for subscription.)
Share tab:
Stores that share this mailing list. Read "Sharing objects" for more details.
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6.3.6. Subscribers
Use this section to manage customers' participation in a mailing list.
You can either pick up subscribers among the registered users by choosing the Select customer tab, or add new subscribers
by choosing the Add Subscriber tab (use the following button:

).

Subscriber attributes
When you add a new subscriber, you need to specify the following attributes:
E-mail - Email address of the subscriber.
Language - Language in which the subscriber receives the newsletters.
In the Subscribers section you can click to expand the details of a subscriber. Here you can see mailing list to which the
customer can be subscribed.
Select the Subscribed check box corresponding to the mailing list or, optionally, select the Confirmed check box to mark this
user's subscription confirmed.
Please remember that good practice is to ask users to confirm their subscriptions themselves.
CS-Cart supports bulk subscriber attributes import and export by using the standard export/import feature in sections
Administration

Export Data

Subscribers and Administration

Import Data

Subscribers.

6.4. Subscribers
Use this section to manage newsletter subscribers.
Note: This section is available only when the Email marketing add-on is activated in the Add-ons

Manage Add-ons

section.
You can add new subscribers with the

button in the right upper part of the page. To remove a subscriber, click the gear

button of the required one and choose Delete.
To export or delete several subscribers at once, select their checkboxes, click the gear button in the top right corner of the
page and choose the required action. Choose Export all to export all subscribers in the list at once.
In the right part of the page you can see the following settings:
Newsletter checkbox on checkout - Allow users to subscribe for newsletters on checkout.
Send a welcome letter with the unsubscribe link - The user will receive a letter to the specified email that will
contain the unsubscribe link. Using this link he/she will be be able to refuse receiving newsletters.
Double opt-in - If enabled, when subscribing a user will receive a letter suggesting to confirm subscription.

Subscriber attributes
When you add a new subscriber, you need to specify the following attributes:
E-mail - Email address of the subscriber.
Name - Name of the subscriber as it appears in the newsletter.
Language - Language in which the subscriber receives the newsletters.
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CS-Cart supports bulk subscriber attributes import and export by using the standard export/import feature in sections
Administration

Export Data

Subscribers and Administration

Import Data

Subscribers.

6.5. eBay templates
Use this section to manage eBay templates. With these templates you can group your products to synchronize them with
eBay.
For each template you can specify such parameters as shipping and payment methods, categories, etc.
Note: This section is available only when the eBay synchronization add-on is installed and activated in the Add-ons
Manage Add-ons section.

Click the + button in the right upper corner of the page to add new template or click on the name of the required template to edit
it.
Tick the checkboxes next to the names of the required templates, click the gear button in the right upper corner of the page,
and choose Delete selected to delete templates.

eBay template settings
General tab:
Name - Name of a template.
List products on - The region of the ebay auction for which products in this template will be available.
Use as default - Tick the checkbox if you want this template to be used for products with no template defined.
NOTE: If several templates are defined as default, the latest specified template will be applied to products.
eBay Root category - The product root category at eBay for which products in this template will belong.
eBay Category - The product category at eBay for which products in this template will belong.
eBay Secondary root category - The product secondary root category at eBay for which products in this template
will belong.
eBay Secondary category - The product secondary category at eBay for which products in this template will
belong.
Shippings tab:
Shipping type - Choose whether to use calculated or flat shipping type. Calculated - shipping will be calculated
according to the customer ZIP address, the package weight, and the type of shipping services you offer; Flat - shipping
rate will be fixed.
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Domestic shipping service - The shipping service that will be used for delivering products in the domestic region.
Free shipping (if the shipping type is F lat) - Tick the checkbox if you want free shipping to be applied to products in
a template.
Shipping cost (if shipping is not F ree) - Fixed shipping price for one item (if shipping type is Flat).
Shipping cost additional - (if the shipping type is F lat) - Shipping price for each additional item in an order.
International shipping service - Shipping service that will be used for delivering products worldwide.
Dispatch days - The period of product delivery to a customer (in days).
Payments tab:
eBay payment methods - Payment method(s), available for a template.To select multiple items, press and hold the
Ctrl or Shift key.
PayPal email - The PayPal account login.
Listing duration - Period of time for that your product will be listed. GTC - Good 'Til Cancelled. More information read
here.
Return Policy tab:
Return Policy - Choose whether returns are allowed or not for products grouped under this template.
After receiving the item, your buyer should contact you within - The period of time within that the buyer must
contact you to approve the purchase reception.
Refund will be given as - The action that will replace the return, if it is not allowed.
Return shipping will be paid by - Choose who will pay for the shipping of the return purchase - the seller or the
buyer.
Policy description - The detailed description of your return policy.

Also read in CS-Cart Knowledge Base:
Setting up the “eBay synchronization” add-on
eBay template settings
Export products to eBay
Import complete orders from eBay

6.6. Gift Certificates
Gift certificate is the best solution for customers who don't know what to buy as a present. Customers just order a gift
certificate with specific parameters (the name and address of the person who the certificate should be sent to, certificate worth
and a cover message), and the store administrator sends the certificate to the recipient via email or regular post. Customers
are also encouraged to bundle a certificate with any number of products from the store catalog. These products are marked
as free products.
Once a gift certificate is created, the customer adds it to the cart and orders it as a regular product. After the order containing
the certificate is processed or completed, the certificate becomes active and gets sent to the recipient. The person who
received the certificate can then visit your web store, choose products from your catalog and add them to the cart. At
checkout, he or she will be offered to redeem the certificate, i.e. to enter a code specified in the certificate. The certificate's
worth will be subtracted from the order total. If the certificate doesn't cover the order total completely, the rest of the sum can
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be paid off through any available payment method.
Certificates never expire and can be used to pay for orders at any time. It's also possible to use the same certificate for
multiple orders if the certificate's worth hasn't been expended by previous orders.
The only limitation concerning gift certificates is that it is impossible to pay for an order with a gift certificate if the order
contains nothing but another gift certificate.
Tip: To allow your customers to order gift certificates, activate the Gift certificates add-on in the Add-ons section of the
Administration panel (Add-ons

Manage Add-ons

Gift certificates). There you can also configure some essential

settings that relate to gift certificates.

6.6.1. Gift Certificates
Adding a gift certificate
Although gift certificates are supposed to be created by customers, store administrators are also allowed to create and modify
gift certificates in the Administration panel.
To add a certificate:
1. In the administrator panel, go to the Gift certificates section (Marketing > Gift Certificates).
You will see a list of all gift certificates that have been created in the store (both by customers and store administrators)
and haven't been deleted.
2. Click the following button:

.

This will open a form for creating a gift certificate, which is quite similar to the form that customers use to create gift
certificates.
3. Complete the form.
To - Name of the person who the certificate will be sent to.
From - Name of the person who sends the certificate.
Message - Cover message for the certificate (greeting, some wish, etc.)
Amount - Certificate's worth. Can be either specified as a custom amount or chosen from a fixed set of available
amounts.
The amount must lie within the minimum and maximum amounts that are defined by the settings of the Gift certificates
add-on module (Add-ons

Manage Add-ons

Gift certificates.)

Send via email/Send via postal mail - Choose to send the certificate via email or regular post and specify either an
email or a regular address.
Free products - Products that will be bundled with the certificate and sent to the recipient. Click the Add Product
button to bundle new products.
Notify customer - If selected, the customer receives an automatic email notification when a new gift certificate is
created.
4. Click the Create button.
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Editing gift certificates
Store administrators are allowed to edit details of existing gift certificates.
To edit a gift certificate:
1. In the administration panel, open the Gift certificates section (Marketing > Gift certificates).
2. Click on the code of the certificate you want to edit. This will open a form that is pretty the same as the one you use to
create certificates.
3. Edit the fields in the form.
4. Click the Save button.

Viewing gift certificate history
CS-Cart registers all changes in the balance of a gift certificate.
To view the history of changes:
1. Display the list of certificates (Marketing > Gift certificates).
2. Click on the code of the certificate which history of changes you want to view.
This will open the page with gift certificate details.
3. Switch to the History tab to open a tab with a list of changes. Each entry in the list contains the following elements:
Date – Date and time the change was made.
Email – Email address of the user who changed the balance.
Order ID – ID of the order.
Name – Name of the user who changed the balance.
Balance – Certificate worth before the balance was changed.
Debit balance – Certificate worth after the balance was changed.

6.6.2. Gift Certificate Statuses
Managing gift certificate statuses
By default, there are four possible gift certificate statuses:
Active – Certificate can be applied;
Disabled – Order has been disabled by the store administrator;
Pending – Certificate was created but not activated yet;
Used – All work on the order has been completed.
To edit existing statuses, choose the button

, corresponding to a particular status and click Edit.

If necessary, you can expand the default set of gift certificate statuses with custom statuses.

Adding gift certificate statuses
To add a custom gift certificate status:
1. Click the button

and choose Add Status from the drop-down menu. This will open a pop-up window with a form for the

new status details.
2. Fill out the form. Fields marked with an asterisk (*) are mandatory.
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Name - Name of the status.
E-mail subject - Subject of an email message that is sent to customers automatically when the gift certificate status
changes to this status.
E-mail header - Header of an email message that is sent to customers automatically when the gift certificate status
changes to this status.
Color - Color to be used to visually distinguish certificates in this status from other orders in the order list in the
administration panel. Click the

icon to open a palette and pick the color.

Notify customer - If selected, the customer receives an automatic email notification when the gift certificate status
changes to this status.
3. Click the Create button.

6.7. Banners
In this section, you can create graphic and text banners that can then be placed on the storefront. Banners can lead your store
visitors to any of the store pages or to a third party resource.
Note: To display a banner on a page, you need to add a separate block with the content type Banner. For details see Design
> Layouts.

Banner attributes
Banners can have the following attributes:
The General tab:
Name - Name of the banner.
Store - Store to which the banner originally belongs.
Pos. - Position of the banner relatively to the position of the other banners in the list.
Type - Type of the banner (text or graphics).
Description (text banners only) - Text of the banner. This can be either a plain test or formatted HTML text. If you
are not familiar with HTML, you are encouraged to add a formatted description using the built-in WYSIWYG HTML editor.
Note: Banner description can be different for different languages. Simply switch to the required language when editing
the banner description.
Image (graphic banner only) - An image for the banner.
The images can be either uploaded from a local computer or linked to a remote location where the required image is
physically located. An alternative text describes the image and is shown when the image is missing or cannot be
displayed. It is good practice to have an alternative text associated with the image as an additional SEO–wise
opportunity.
Images must be of one of the following formats only: JPEG, GIF, PNG. Or it can be an SWF file (flash multimedia).
Maximum size of an uploaded image depends on your server configuration. As a rule, it should not exceed 2 MB.
Note : If you have several active languages in Administration -> Languages -> Manage languages section, you can
specify different images for each language. To do it, choose a language from the drop-down list in the left part of the page,
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upload an image and click Save. Repeat this actions for each language.
Open in new window (graphic banner only) - If selected, the URL under the banner is opened in a new window/
tab.
URL (graphic banner only) - URL to which the banner is linked.
Creation date - Date, when the banner was created.
Status - Status of the banner (Active, Hidden, or Disabled).
The Share tab:
Stores that share this banner. Read "Sharing objects" for more details.

Also read in CS-Cart Knowledge Base:
Displaying different banners for different category pages

6.8. Reward Points
Use this section to assign global reward points in your store. Reward points are the bonus that customers receive at their
accounts for buying products in your store. The points can then be used to pay for other products or to reduce the original cost
of a product.
Note: Each store uses a separate reward point system.

Global reward points that you define here can be overridden by the reward points that are specific to particular products and
categories (if any).
User group – User group whose members are credited with the reward points.
Amount – Number of points to be credited to the user account.
Amount type – Type of the credit: Absolute - customers receive a fixed amount of points, or Percent - customers
receive a percentage of original product cost.
Tip: In order to use this functionality, you need to enable the Reward points add-on in the Add-ons > Manage Add-ons
section.
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7. Website
In a nutshell, this section of the Administration panel provides a sort of a built-in content management system (CMS) allowing
you to create, edit, and publish supplementary content. Although such content is generally irrelative to the main content of the
web store (the product catalog) and the ecommerce functionality of the website, it makes the store complete by providing
additional information like the description of your company, your privacy policy, forms to contact the store administration,
surveys and questionnaires, etc.
Besides, this section provides facilities to create and publish store news, including newsletters and bulletins.

7.1. Blog
Use this section to manage blog posts that are published in the Blog box on the storefront.
Note: In order to use this functionality, you must have the Blog add-on enabled and configured in the Add-ons > Manage
Add-ons section.

Tip: Make sure that a block of the Recent posts type is added to a necessary page in the Design > Layouts section.

Use the + button in the top right corner of the page to add new blog post. If you want to edit or remove a blog post, click the
gear button near it and choose the desired action from the drop-down menu.
To clone or remove several blog posts at once, tick checkboxes near the desired blog posts, click the gear button in the top
right corner of the page, and choose Delete selected or Clone selected.

Blog post attributes
General tab:
Information
Parent page - Page that will contain a link to this post. If it is not intended that the page has a parent page, select the
Root level option.
Name - The header of the post.
Store - Store to which the post originally belongs.
Post description - Text of the post. It can be a plain text or a formatted HTML text. If you are not familiar with HTML,
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use the built-in WYSIWYG editor to create a formatted text.
Status - Status of the post (Active or Disabled).
Show this page in a pop-up window - If selected, the page is shown as a modal dialog when accessed by a visitor.
Meta data
Page title - Title of the page, which is displayed in the title bar of the web browser. Required for SEO purposes.
META description - Contents of the HTML meta tag describing the page. Required for SEO purposes.
META keywords - Contents of the HTML tag containing a list of search keywords for the page. Required for SEO
purposes.
Availability
User groups - User groups whose members can access the page.
Creation date - Date when the page was created.
Use available period - If selected, the page is available for a certain period of time only.
Available from - Date when the page becomes available for visitors.
Available till - Date until the page is available for visitors.
Add-ons tab:
Facebook
Facebook object type - Choose the object type on Facebook to characterize your page contents.
SEO (you must be logged in under the particular store administrator account to see this section)
SEO name - Search engine friendly name of the page containing the published post.
Blog
Image - Upload an image to be shown as your blog post preview and at the beginning of a post.
Comments and reviews (you must be logged in under the particular store administrator account to see this section)
Comments - Select box to enable or disable user comments and ratings for the page.
Important: Make sure that the Social Buttons, Comments and Reviews, and SEO add-ons are enabled and configured in
Add-ons

Manage Add-ons.

Tags tab:
This tab includes a list of tags associated with the page. Tags appear on the storefront in a special side box titled Tag cloud.
For more information about the tags, please refer to the section Website > Tags further in this guide.
Tags – Tags that have been added to a post. Start typing in this field to add a new tag.You can choose among the
existing variants or create a new tag.

Share tab:
Stores that share this post. Read "Sharing objects" for more details.
Comments tab:
List of user comments and ratings for the post. Requires that the Comments field in the General tab be set to
Communication, Rating, or both:
Name - Name of the user who left the comment/rating.

© 2004 - 2015 Simbirsk Technologies Ltd.

CS-Cart Reference Guide

59

Your rating - User's evaluation of the post.
Your message - Text of the comment.
Layouts tab:
This tab duplicates the global layout of the location to which this storefront page belongs (see Design

Layouts.)

By using this tab, you can disable blocks that are globally enabled, and, on the contrary, enable blocks that are globally
disabled. This makes it possible to configure an individual layout for different storefront pages.
Any modification that you make under this tab will not affect other storefront pages.
Tip: For more information on blocks, see Design > Layouts.

7.2. Content
In this section, you can create and publish new contents of the following type:
Page - Simple page that can contain formatted HTML description only. Good for various descriptions and policies.
Form - Page that contains a contact form and optionally a formatted HTML description. Forms are built with a userfriendly form builder that requires no HTML skills and knowledge.
Tip: To make it possible to create forms in your store, ensure that the Form Builder module is enabled and configured
in Add-ons > Manage Add-ons section.
Poll - Surveys and questionnaires.
Important: To make it possible to create surveys in your store, ensure that the Polls module is enabled and configured
in the Add-ons > Manage Add-ons section.
Link - Reference to an external web resource or any page in your web site.

Page attributes
General tab:
Parent page – Page that will contain a simple text link to this page. The parent page can belong to any type of content.
If it is not intended that the page has a parent page, select the Root level option.
Name – Name of the page as it appears on the storefront.
Store – The store where the page will appear.
Description – Plain text or formatted HTML description appearing on the page.
If you are not familiar with HTML, you are encouraged to add a formatted description using the built-in WYSIWYG editor.
Status – Status of the page (Active = page is available on the storefront; Disabled = page is not available on the
storefront; Hidden = page is not displayed on the storefront, but is available via a direct link).
Show this page in a pop-up window – If selected, the page is shown as a modal dialog when accessed by a visitor.
Page title – Title of the page, which is displayed in the title bar of the web browser. Required for SEO purposes.
META description – Contents of the HTML meta tag describing the page. Required for SEO purposes.
META keywords – Contents of the HTML tag containing a list of search keywords for the page. Required for SEO
purposes.
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User groups – User groups whose members can access the page.
Creation date – Date when the page was created.
Use available period – If selected, the page is available for a certain period of time only.
Available from – Date when the page becomes available for visitors.
Available till – Date until the page is available for visitors.
Layouts tab:
This tab duplicates the global layout of the location to which this storefront page belongs (see Design

Layouts.)

By using this tab, you can disable blocks that are globally enabled, and, on the contrary, enable blocks that are globally
disabled. This makes it possible to configure an individual layout for different storefront pages.
Any modification that you make under this tab will not affect other storefront pages.
Tip: For more information on blocks, see Design > Layouts.
Add-ons tab:
SEO name – SEO-friendly name of the page.
Comments – Select box to enable or disable user comments and ratings for the page.
Facebook object type – Choose the object type on Facebook to characterize your page contents.
Important: Make sure that the Social Buttons, Comments and Reviews, and SEO add-ons are enabled and configured in
Add-ons

Manage Add-ons.

Tags tab:
This tab includes a list of tags associated with the page. Tags appear on the storefront in a special side box titled Tag cloud.
For more information about the tags, please refer to the section Website > Tags further in this guide.
Tags – Tags that have been added to a page. Start typing in this field to add a new tag.You can choose among the existing
variants or create a new tag.
Note: Make sure the Tags add-on is enabled and has the Tags for pages option selected (Add-ons > Manage Add-ons
section).
Comments tab:
List of user comments and ratings for the page. Requires that the Comments field in the Add-ons tab be set to
Communication, Rating, or both:
Name - Name of the user who left the comment/rating
Your rating - User's evaluation of the page.
Your message - Text of the comment.
Share tab:
Stores that share this page. Read "Sharing objects" for more details.
Form builder tab (if the page type is Form):
Form submit text – Text that is shown to the user after the form is submitted.
E-mail to – Email address at which you want to receive the submitted data.
Form is secure (SSL) – If selected, the form is submitted through the secure protocol.
Position – Position of the form field relatively to the position of the other fields of the form.
Name – Name of the field as it appears in the form.
Type – Type of the field. If the field type involves a selection, you can specify as many choices and alternatives as you
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need.
Required – If selected, the field is mandatory for completion.
Status – Status of the field (Active or Disabled.)
If the field type is Select Box, Radio Group, Multiple Check boxes, or Multiple Select box, two extra fields appear on the
screen:
Position

Position of the item relative to the position of the other items of the form.

Description

The content of the field.

Poll tab (if the page type is Poll:)
Poll results visible to – Types of users, who can see the poll results.
Poll header – Header of the poll.
Poll footer – Footer of the poll.
Poll message – Message to be displayed on the storefront after the poll is completed.
Questions tab (if the page type is Poll:)
This tab lists the questions included in the poll.

When you add or edit a question, you need to specify the following attributes:
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General
Question text - Question itself.
Position - Position of the question relatively to the position of the other questions in the list.
Type - Type of the field for the answer.
Required - If selected, the question is mandatory for answering.

Answers
Position - Position of the answer relatively to the position of the other answers to the question.
Answer text - Answer itself.
Text box - If selected, the answer has a text box where the user can enter a custom answer.

Use these graphic controls to add or remove answers variants:
Poll statistics tab (if the page type is Poll:)
This tab contains the statistics on the submitted/completed polls and questionnaires.
Total number of poll forms submitted - Number of times polls were submitted by store users.
Number of poll forms fully completed - Number of times polls were completed in full.
The values of these two fields are links. Click on one of the links to see the following details: Date - date and time when
the poll was submitted; User - name of the user who submitted the poll; IP - IP address of the user who submitted the
poll (each user is allowed to complete a poll only once. This is controlled by the user's IP addresses); Completed label to show whether the pall was completed in full.
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First poll form submitted - Date and time when the poll was submitted for the first time.
Last poll form submitted - Date and time when the poll was submitted for the last time.
Statistics by questions - Questions of the poll, all answers to these questions and the percentage of the answers.

Also read in CS-Cart Knowledge Base:
Translating Fields From the 'Contact us' Form

7.3. Tags
Use this section to manage the tags that are added to different pages of your store. Tags can be considered as free-form
keywords or labels associated with a page or product making it easier to find the page/product.
Note: Tags are managed separately for each store in CS-Cart.
Tags created by the store administrators appear on the storefront in the Tag cloud side box. To display side box on the
storefront, use controls in Design

Layouts.

Tip: To use tags in your store, you must have the Tags add-on enabled and configured (Add-ons

Manage Add-ons).

Tag attributes
Tag - Name of the tag as it appears on the storefront.
Products - Number of products to which the tag is assigned. (To make this attribute appear in the list, select the Tax
for products checkbox in the Add-ons > Manage Add-ons > Tags section).
Pages - Number of pages to which the tag is assigned. (To make this attribute appear in the list, select the Tax for

© 2004 - 2015 Simbirsk Technologies Ltd.

Website

64

pages checkbox in the Add-ons > Manage Add-ons > Tags section).
Status - Status of the tag (approved/disapproved/pending), Tags added by the administrator automatically get the
Approved status.
You can delete the tag choosing the button

, corresponding to the particular tag, or change the tag status with the help

of the drop-down list to the right.
If you want to approve, disapprove or delete several tags at a time, choose the check boxes and press the button

in

the upper right part of the page. Then choose the action from the drop-down list.

Also read in CS-Cart Knowledge Base:
Adding tag cloud

7.4. Social login
Here you can see and manage the list of social network providers available in your store. Customers can log in on you store
using these providers.
Note: This section is available only when the Social login add-on is activated in the Add-ons

Manage Add-ons section.

Use the + button in the top right corner of a page to add new provider or click the gear button of the particular provider and
choose the required action to edit or delete it.
When you add or edit a provider, you can see the following settings. The list of settings can vary depending on a provider:
Provider - Choose the social network provider. The button for registration via this provider will be added to the user's
sign in form.
Status - Status of the provider in your store (Active or Disabled).

Google
ID - Identificator given to you after creating a project at Google.com.
Secret key - Secret key given to you after creating a project at Google.com.
Callback URL - URL that Google will use for the callback in case of successful authorization.
Further information see at HybridAuth.net

Facebook
ID - App ID given to you after the creating an application at Facebook.com.
Secret key - Secret key given to you after creating an application at Facebook.com.
Further information see at HybridAuth.net

PayPal
ID - App ID given to you after the creating an application at PayPal.
Secret key - Secret key given to you after creating an application at PayPal.
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Use seamless checkout - Tick this checkbox to allow customers seamlessly checkout with PayPal without the need
to log in to PayPal again. More information read here.
Test mode - Tick this checkbox, if you want the PayPal payments functionality work in test mode.
Callback URL - URL that PayPal will use for the callback in case of successful authorization.

Twitter
ID - Consumer key given to you after the creating an application at Twitter.com.
Secret key - Secret key given to you after creating an application at Twitter.com.
Callback URL - URL that Twitter will use for the callback in case of successful authorization.
Further information see at HybridAuth.net

Yahoo
ID - Identificator given to you after creating an application at Yahoo.com.
Secret key - Secret key given to you after creating an application at Yahoo.com.
Further information see at HybridAuth.net.

Live
ID - App ID given to you after the creating an application at Live.
Secret key - Secret key given to you after creating an application at Live.

LinkedIn
ID - Consumer key given to you after the creating an application at LinkedIn.com.
Secret key - Secret key given to you after creating an application at LinkedIn.com.
Further information see at HybridAuth.net.

Foursquare
ID - App ID given to you after the creating an application at Foursquare.
Secret key - Secret key given to you after creating an application at Foursquare.

7.5. SEO
The SEO (search engine optimization) section helps you to optimize your web store for search engines and improve its
ranking. Here you can define global rules for URL rewriting in your store, manage 301 redirects, and edit the robots.txt file.
Note: The 301 redirects and SEO rules sections are available only when the SEO add-on is activated in the Add-ons
Manage Add-ons section.
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7.5.1. SEO rules
Use this section to define global rules for URL rewriting in your store. This ensures that auxiliary URLs like http://www.
example.com/index.php?dispatch=auth.login_form will be replaced with user-friendly and SE-optimized URLs (e.
g., http://www.example.com/login.) Moreover, with the provided multi-language support, your shopping cart will be
indexed by search engine crawlers in different languages.
Tip: In order to control URL names in your store, first you need to enable and configure SEO add-on in Add-ons

Manage

Add-ons.
Here you need to specify the URLs that should be rewritten and their substitution names. You can use the following list as an
example:

Dispatch value - The value of the dispatch parameter from the standard URL that will indicate the replacement (e.g.,
auth.login_form for the URL http://www.example.com/index.php?dispatch=auth.login_form.)
SEO Name - The value to which the standard URL will be changed (e.g. login for auth.login_form.) The value can
be specified with .html extension if required.

7.5.2. 301 redirects
This section helps you to redirect customers from old and no more actual pages to the new ones. This is how it works: all
pages are indexed by search engines (when using the SEO add-on). If you have changed product page URL (for example) and
want it to be re-indexed by search engines, use 301 redirect.
Note: This section is available only when the SEO add-on is activated in the Add-ons

Manage Add-ons section.

Here you can create, manage and remove 301 redirects in your store. To add new redirect, click the

button and fill-in the

following fields:
Old URL - URL of an old page from that you want your visitors to be redirected.
New URL - URL of a new page where visitors will be redirected when clicking an old page. Custom - define URL by
yourself, Category/Product/Page - choose the desired item from the list.
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To remove the desired redirect, click the gear button corresponding to it and choose Delete. To remove several redirects at a
time, choose checkboxes of the desired redirects, click the gear button in the right upper corner of the page, and choose
Delete selected. You can also edit Old URL and New URL of a redirect on the fly typing corresponding values in editable
fields.
When you change some page SEO-name in the object (category, product, etc.) editing section, URL of that page is
automatically added to this list of redirects.
Note: Redirect from an object will work only if this object was not found.

7.5.3. robots.txt
In this section you can edit the robots.txt file directly from the administration panel.
This is the file at the root directory of your store where parts of the site that you don’t want to be accessed by search engine
crawlers are indicated. Here you can read more information about robots.txt.
To edit the file, tick the Edit robots.txt checkbox and edit the file contents given in the field below. Click the Save button.
If you want to resile to the original contents of the robots.txt file, click the Restore the default robots.txt button.

7.6. Comments and reviews
This section contains ratings, comments, reviews, and other customer communications. Here you can review all feedback and
communications in your store.
In order to enable customer communications in your store, install and activate the Comments and reviews add-on in Addons

Manage Add-ons. Also make sure that comments and ratings are allowed on configuration page (Add-ons tab) of the
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respective object: product, category, page, etc.
The section is divided into the following subsections:
Product reviews - Reviews that customers left on product details pages.
Category reviews - Reviews that customers left on category details pages.
Page comments - Comments that customers left on the store web pages.
Order communication - Comments that customers left on order details pages.
Testimonials - Comments that customers left on the page with testimonials.
News comments - Comments that customers left on the site news pages.
In this section you can change the comment or review title and body on the fly, as well as approve/disapprove or delete them
with the following controls:

7.7. Testimonials
In this section, you can manage the testimonials from your store visitors: you can approve/disapprove or delete testimonials as
well as edit them.
To add the new testimonial click the

button and fill in the following fields:

Name - Name of the user who wrote the post.
Your rating - User's evaluation.
Your message - Text of the post.
Click the Add button.

Tip: Make sure a block for testimonials is added to a necessary page in the Design
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7.8. Sitemap
Use this section to extend the store site map that, by default, may include links to category and information pages only. Here
you define a set of custom sections that should be included in the site map as well.
Each new section can nest additional links which are added under the

button (the Edit tab).

Section attributes
Name - Name of the section as it appears in the map.
Status - Status of the section (Active or Disabled.)

Link attributes
Position - Position of the section link entry relatively to the position of the other section link entries in the map.
Section name - Name of the shortcut for the link as it appears in the map.
URL - URL of the page under the shortcut. It should not necessarily be an absolute URL consisting of the access
protocol, the domain name and the path to the page. A relative link like index.php?dispatch=profiles.update
would be enough.

To add a new link, use the following graphic controls:
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8. Add-ons
CS-Cart is a scalable solution, and its core capacity can be greatly enhanced through many add-on modules included in the
regular distribution package. Each module introduces a particular functionality or feature that can be easily turned on or off
without affecting other components.
For convenience, the administration panel has a special section to manage all add-on modules in one place (Add-ons
Manage Add-ons).

8.1. Manage Add-ons
This section contains a list of installed modules in the Installed add-ons tab, a list of modules available for installation in the
Browse all available add-ons tab, and a few control elements to manage the modules.

Enabling/disabling add-on modules
To turn a module on or off, click on the current module status to expand a list of applicable statuses and select the required
status.

Configuring add-on modules
For some modules you can adjust module-specific options and preferences.
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Note: Modules that cannot be highlighted with a mouse do not have editable parameters and cannot be configured.
To configure a module:
1. Click on the following button near the add-on status:

and choose Settings.

This will open a form containing editable parameters.

2. Edit the values of the fields in the form.
3. Click Save to apply the changes.

Uploading add-on modules from archive
To upload a new add-on, click the

button in the right upper corner of the page. In the opened pop-up window choose

whether to upload a file from the local computer (Local) or the server file system (Server). You can also specify URL to a
remote location, where the required archive is physically located. Pay attention, that the add-on archive must be in tgz, gz or
zip format. When you are ready, click Upload & install.
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Before uploading an add-on from archive make sure that there is no such an add-on among the modules available for
installation in the Browse all available add-ons tab.

8.1.1. Access restrictions
This module empowers you to limit access to the administration panel and customer storefront based on users' IP-addresses.

Administrator area settings
The following parameters define access rules to the administration panel.
Login to the admin area from specified IPs only - If selected, the administration panel can be accessed from a
limited range of IP-addresses defined in Add-ons

Access restrictions.

Note: When you enable this option, your current IP-address is automatically added to the list of allowed IP-addresses.
Block IP after a number of unsuccessful attempts - If selected, the system blocks the user IP-address after a
series of failed login attempts made from this IP-address during a certain period of time. The number of attempts and
the surveillance period are defined in the fields below.
Number of unsuccessful attempts - Number of failed login attempts before the system blocks the IP-address.
Time between unsuccessful login attempts - Number of seconds to include the series of failed login attempts after
which the system blocks the IP-address.
Time for which the IP should be blocked - Number of hours before the system unlocks a blocked IP-address.
Note: When an administrator's IP is blocked, it appears among banned IP addresses in Add-ons

Access restrictions/

Administration panel having the active status. Changing the status to "disabled" unlocks the IP-address after the locking
period is over.

Customer area settings
Block IP after a number of unsuccessful attempts - If selected, the system blocks the user IP-address after a
series of failed login attempts made from this IP-address during a certain period of time. The number of attempts and
the surveillance period are defined in the fields below.
Number of unsuccessful attempts - Number of failed login attempts before the system blocks the IP-address.
Time between unsuccessful login attempts - Number of seconds to include the series of failed login attempts after
which the system blocks the IP-address.
Time for which the IP should be blocked - Number of hours before the system unlocks a blocked IP-address.

Also read in CS-Cart Knowledge Base:
Disabling Access to the Store for Customers From Certain IP Addresses
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8.1.2. Age verifications
The Age verification module enables you to restrict customers' access to certain products and categories on the basis of
their age. This add-on does not have configurable settings.
To specify the minimum age to access a product or category, use the Add-ons tab on the respective page of the product or
category.

8.1.3. Anti fraud
Anti Fraud module is an integrated fraud screening facility supported by the MaxMind Anti-fraud service. The module offers
advanced protection from fraudulent credit card transactions by estimating the risk factor according to multiple parameters,
which include matching of the user's IP-address and user entered data, historic legitimate and suspicious activity, etc.
Since the module relies on the Maxmind Anti-fraud service, to start screening orders for frauds you need to have a valid
account with MaxMind and subscribe to one of their fraud detection services.
Maxmind license key - The license key that you received from MaxMind.
Safe distance - Maximum number of kilometers between the billing address that the user provides and the physical
location of his IP-address. If the detected distance fits into this value, the order will be considered non-fraudulent.
According to the service, a large distance increases the risk factor.
Max order total - Maximum order subtotal to qualify the order as a safe one. If exceeded, the order subtotal is
considered to be too large, and thus suspicious. According to the service, a large order subtotal increases the risk
factor.
Maximum risk factor - Decimal fraction or an integer within 1 to 100 representing the maximum risk factor. The
greater the value, the higher the possibility of a fraud. If the risk factor returned by the screening service exceeds the
maximum value, the order is placed with the status "Open" even if the transaction has been successfully processed by
a payment system. The store administrator is supposed to review such an order, and manually change its status to
"Processed" or "Failed". The recommended maximum risk factor is 25.

8.1.4. Attachments
The Attachments module empowers you to attach files to regular products in your catalog. This add-on does not have
configurable settings.

8.1.5. Banners management
The Banners management module enables you to have custom logos and banners on the storefront.
Enable multi-language Images/URLs - Tick this checkbox to allow using different images/URLs for the same object
under different languages when using several languages in the store.

Also read in CS-Cart Knowledge Base:
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Adding a logo or banner
Text banner

8.1.6. Bestsellers & on sale products
The Bestsellers & on sale products module empowers you to have a section of bestsellers, products on sale, and similar
products on the storefront.
To add the Bestsellers, On sale products, or Similar products section to the storefront, add the Products block with the
corresponding Filling type to the desired location (Design > Layouts).

In addition, you create the Bestsellers, On sale, Final sale, and Newest products pages with the help of this add-on.
Following settings correspond to these pages content:
General
Minimum final sale discount (%) - Products with a discount starting from this amount (in %) will be displayed on the
Final sale page on the storefront.
Minimum sales amount to define bestsellers - Minimal value of the Sales amount parameter in the Add-ons tab
of the product details page, so that this product to be added to the Bestsellers page.
Newest
Period - Period of time over which products were added to the store database. The following choices are available:
Any date - The page will display the latest products. The output is not bound to any time period.
Today - The page will display products that have been added on the day when the visitor opens the storefront.
Last days - The page will display products that have been added over a certain time period before the moment the
visitor opens the storefront. The time period is specified in the Last days field.
Information on how to create the Bestsellers, On sale, Final sale, and Newest products pages you can find here.

8.1.7. Blog
With this add-on you can build in a blog in your shop: create and manage blog posts and review customer comments. This
add-on does not have configurable settings.
To manage blog posts in your store, use the Website > Blog section.

8.1.8. Buy together
The Buy together module enables you to bind several products and offer a discount if the bound products are bought
together. This add-on does not have configurable settings.
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8.1.9. Call requests
This add-on adds a Buy now with 1-click button on a product details page in the storefront. When a customer clicks the
button, a popup window with a short contact form appears. As a store admin, you will see the list of call requests in the Orders
> Call requests section of the administration panel with detailed information about each request.

Also, you can add the Call requests block to the storefront in the Design > Layouts section. When clicking the Request
call link on the storefront, customers will also see a form where they can type their name, phone, and a period of time
convenient for a call.
Products added to a customer's cart will be mentioned in the created call request in the Orders > Call requests section.

Settings:
Phone from settings - Phone number defined in the Company phone field in Settings > Company.
Rewrite phone - Replace the Phone from settings number with the one given in this field.
Highlight first chars - Number of symbols in the phone number to be highlighted as country code, area code, or phone
prefix.
Phone mask - Leave empty to use automatic country-based phone pattern, or type in a custom pattern. You can use
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spaces, commas, +, -, and digits. Note that 9 represents any digit; if you need a 9, type \\9.
Examples: +9 (999) 999 99 99, 99999999, 999 999 99, or +99-99-9999-9999.
Enable the "Buy now with one click" option - If selected, a Buy now with 1-click button will be displayed on a
product details page in the storefront.
Order status - Status of the newly created order, when a customer sends a call request.

8.1.10. Catalog Mode
This module enables you to set products to be displayed only in the catalog mode with a direct link to an external website
where the products are actually sold.
Important! If the store operates in the catalog mode, the following add-ons are automatically disabled as incompatible: Buy
Together, Gift Certificates.
Store operation mode - Store's default operating mode for products managed by the root administrator: Store products are sold directly in the store and can be added to the cart; Catalog - products are linked to external websites.
Allow purchasing products with empty Buy Now URL - If selected, products with no specific link to an external
website are supposed to be sold directly in the store and can be added to the cart.

8.1.11. Comments and reviews
This module enables you to manage customer feedback and discussions appearing on some of the storefront pages:
Product and category pages;
Order details;
News;
Gift registry:
Content pages;
Testimonials.

Products
Posts per page - Maximum number of posts to appear on one page.
Administrator must approve posts submitted by - Your moderation policy: require to approve posts submitted by
all customers or non-registered customers only, or do not moderate posts at all.
Only one post from one IP is allowed - If selected, customers are allowed to submit only one review or comment
per product from one IP-address. This can help you avoid spam and flames.
Send notifications to this E-mail - Email address at which you want to receive a notification of new posts.
Share discussion with product - If selected, you can share discussions among several stores.

Categories
Posts per page - Maximum number of posts to appear on one page.
Administrator must approve posts submitted by - Your moderation policy: require to approve posts submitted by
all customers or non-registered customers only, or do not moderate posts at all.

© 2004 - 2015 Simbirsk Technologies Ltd.

77

CS-Cart Reference Guide

Only one post from one IP is allowed - If selected, customers are allowed to submit only one review or comment
per category from one IP-address. This can help you avoid spam and flames.
Send notifications to this E-mail - Email address at which you want to receive a notification of new posts.

Orders
Posts per page - Maximum number of posts to appear on one page.
Allow customer to initiate discussion - If selected, customers can start discussion.

News
Posts per page - Maximum number of posts to appear on one page.
Administrator must approve posts submitted by - Your moderation policy: require to approve posts submitted by
all customers or non-registered customers only, or do not moderate posts at all.
Only one post from one IP is allowed - If selected, customers are allowed to submit only one review or comment
per piece of news from one IP-address. This can help you avoid spam and flames.
Send notifications to this E-mail - Email address at which you want to receive a notification of new posts.
Share discussion with news - If selected, you can share discussions among several stores.

Gift registry
Posts per page - Maximum number of posts to appear on one page.
Only one post from one IP is allowed - If selected, customers are allowed to submit only one review or comment per
registry from one IP-address. This can help you avoid spam and flames.

Pages
Posts per page - Maximum number of posts to appear on one page.
Administrator must approve posts submitted by - Your moderation policy: require to approve posts submitted by
all customers or non-registered customers only, or do not moderate posts at all.
Only one post from one IP is allowed - If selected, customers are allowed to submit only one review or comment
per page from one IP-address. This can help you avoid spam and flames.
Send notifications to this E-mail - Email address at which you want to receive a notification of new posts.
Share discussion with page - If selected, you can share discussions among several stores.

Testimonials
Posts per page - Maximum number of post to appear on one page.
Administrator must approve posts submitted by - You moderation policy: require to approve posts submitted by
all customers or non-registered customers only, or do not moderate posts at all.
Only one post from one IP is allowed - If selected, customers are allowed to submit only one review or comment
per testimonial from one IP-address. This can help you avoid spam and flames.
Send notifications to this E-mail - Email address at which you want to receive a notification of new posts.
Testimonials - Select how testimonials should be displayed on the storefront.
Show testimonials from all stores - If selected, testimonials from all stores are shown on the storefront.
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8.1.12. Customers also bought
This module enables you to display a list of products that are usually bought together with the product that your customers are
currently viewing. This add-on does not have configurable settings.

8.1.13. Data feeds
This module enables store administrator to create and export any number of custom product feeds of different formats. This
functionality is useful when working with shopping directories like Google Product Search, Shopzilla, Shopping.com, etc. as
you can adjust the set of fields and their orders according to the required export format.
Feeds can be regularly generated and uploaded to an FTP server or a web directory automatically. This task is controlled by a
cron script. Here you can define your password to access the cron script.
For instructions on how to create and manage data feed, please refer to the section Add-ons > Data feeds in this guide.

8.1.14. Email marketing
With this add-on you can manage newsletter subscribers in the Marketing -> Subscribers section.
General tab:
Newsletter checkbox on checkout - Allow users to subscribe for newsletters on checkout
Double opt-in - If enabled, when subscribing a user will receive a letter suggesting to confirm subscription.
Send a welcome letter with the unsubscribe link - The user will receive a letter to the specified email that will
contain the unsubscribe link. Using this link he/she will be be able to refuse receiving newsletters.
Email integration provider - Choose what email integration provider to use: MailChimp or MadMimi.
MailChimp tab:
API key - Key to access to your MailChimp account. Read more information here.
List - Subscriber list at MailChimp. You can find out more about the list in the MailChimp documentation.
MadMimi tab:
E-mail - Your e-mail specified at MadMimi.
API key - Secret API key at MadMimi. Here you can read information on how to find out your API key.
List - Subscriber list at MadMimi.

8.1.15. eBay synchronization
If you do not see this add-on in the Installed add-ons tab of the Add-ons > Manage Add-ons section, find it in the Browse
all available add-ons tab and click the Install button near its name.

This add-on helps to exchange products and orders with the online auction and shopping website eBay.
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NOTE: To use this add-on, purchase an eBay add-on license on eBay Synchronization page.

General tab:
eBay DevID, eBay AppID, eBay CertID - the authorization keys that you can generate after registering at https://
developer.ebay.com/join/. More information on how to get these keys you can read here.
eBay User Token - the token that you should get using this link after registering at the eBay Developers Program and
generating authorization keys.
Sandbox / Production - the environment where you want to operate: Sandbox - for test purposes; Production - for
real orders.
Default site - the region at eBay for that your products will be available.

License info tab:
The eBay add-on license number - the unique number that you will get purchasing an eBay add-on license on eBay
Synchronization page.

Also read in CS-Cart Knowledge Base:
Setting up the “eBay synchronization” add-on
eBay template settings
Export products to eBay
Import complete orders from eBay
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8.1.16. Form builder
The Form builder module enables you to create forms and add them to store page. This add-on does not have configurable
settings.

8.1.17. Gift certificates
This module enables your customers to order and apply gift certificates in your store. For a detailed description of this feature
and the instructions on how to use gift certificates, please refer to the section Marketing > Gift certificates in this guide.
Minimal amount – Minimum worth of a new gift certificate.
Maximal amount – Maximum worth of a gift certificate.
GC Code prefix – Prefix to be put before codes of all certificates created in your store.
Gift certificates per page – Number of gift certificates appearing on a single page.
Allow to use free products – If selected, a certificate can be bundled with products that the recipient gets at no
charge. The cost of the bundled products is defrayed by the customer who orders the certificate.
Allow to redeem shipping cost with gift certificate – If selected, gift certificates can be used to redeem shipping
costs, not merely the order subtotal.

8.1.18. Google Analytics
This module helps you integrate your store with Google Analytics, an advanced web analytics solution that generates detailed
statistics about the visitors to your website and gives you rich insights into your website traffic and marketing effectiveness.
Information on Google Analytics is available on the official website at http://www.google.com/analytics/.
Google Analytics account number – Your account number on Google Analytics.
Track e-commerce transactions – If selected, Google Analytics tracks e-commerce activity in your store and
generates appropriate reports.

8.1.19. Google Export
Tip: This add-on requires that the Data Feeds add-on has been installed and activated first (Add-ons

Data Feeds).

The Google Export add-on provides the facility for exporting store products to Google Shopping. In a nutshell, it introduces the
following changes to CS-Cart:
Adds a data feed template for creating and exporting data feeds to Google Shopping on a regular basis (Add-ons
Feeds).
See more information about this template in Add-ons > Data feeds > Google base.
Adds extra product fields required by Google as product features (see Products > Features).

Settings:
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Install additional languages for Google categories - Tick this checkbox if you need multi-language Google
categories installed. Supports French, German, Italian, Spanish, and British English. Pay attention that this operation
can take a significant amount of time.

8.1.20. Google Sitemap
This module generates an XML sitemap of your web store, which is adapted to be easily parsed and understood by web
crawlers. This makes website indexing easier and more qualitative. This improves the standing of your web store among
popular search engines, including Google, Yahoo, and MSN/Bing. Having an XML sitemap is highly recommended if you run a
large store with a significant number of products and categories in the catalog.
The module allows you to configure options of each web store element that can be described in the sitemap: homepage,
product pages, category pages, content pages, news, and extended feature pages).
Include in sitemap - If selected, the component is included in the sitemap.
Update frequency - Time interval between two updates of an element.
Priority - Priority of the element relatively to the other elements.

8.1.21. HiDPI displays support
This add-on enables the high-resolution (Retina) displays support. HiDPI (dots per inch) are displays with significantly more
pixels per inch than in ordinary displays.
For example, the Retina displays found on the iPhone, iPad, and MacBook are HiDPI.
Note: All newly uploaded images will be automatically shrinked (twice) to improve loading time on non-HiDPI devices. Existing
images are not changed. It is recommended to upload high-definition images.
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8.1.22. Image Zoom
This add-on adds the possibility for customers to zoom product images by hovering a mouse pointer over the picture.

Opacity - Opacity of tint for the product picture. Define any value between 0 and 1. If 0, no tint will be visible.
Animation time - Duration of the animation effects in milliseconds. The more the value, the slower the zoom picture
appears on the screen.
Color - Color to use for the tint effect.
Important: Color must be defined as hexadecimal HTML color from #000000 for black to #FFFFFF for white.
Zoom position - Specifies position of zoom window. Numeric (0-15) positions are relative to page image as shown by
the following key (blue squares represent zoom window:)
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Zoom size mode - Defines the rule for sizing the zoom window and lens: Image - Zoom window will match small
image; Lens - CSS of lens (.cloudzoom-lens) has priority, zoom window will be adjusted; Zoom - CSS of zoom window
(.cloudzoom-zoom) has priority, lens will be adjusted; Full - Zoom window will maximise to full size of zoom image.
Caption position - Position of the image caption: Top or Bottom.
Ease time - Number of milliseconds of mouse easing movement of zoom image. The bigger the number, the more
easing. Zero means no easing.
Zoom fly out - If selected, the flying zoom animation is enabled.

8.1.23. Janrain
This module enables the Social Login service in your store. This service is a part of the Janrain Engage solution. It encourages
your visitors to use their existing accounts with social platforms like Facebook, Twitter, and PayPal for registration and login in
your store. Please learn more details at www.janrain.com/products/engage/social-login.

Before using this add-on, you need to subscribe to a free or paid Janrain Engage account at www.janrain.com/products/
engage/pricing website. Once you have subscribed to Janrain Engage, complete the following fields in the add-on configuration
form:
API Key - Value of API Key in your Janrain account;
Application Domain - Value of Application Domain in your Janrain account.

8.1.24. My changes
This module enables CS-Cart to keep track of changes that you make in the code of the store. Changes are kept in the
directory <cscart_dir>\app\addons\my_changes, and the changes are applied as a separate add-on. This considerably
simplifies the upgrade process. For instructions and recommendations on how to customize CS-Cart, please refer to the API
documentation at docs.cs-cart.com.
The add-on does not have configurable settings.
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8.1.25. MYOB
This module enables you to export orders in a file that can then be imported into the MYOB accounting system.
Information on MYOB is available on the official website at myob.com.au.
Default Sales Account - your MYOB account number.
Note: When you enable this add-on, the Export to MYOB option appears under the gear button in the Orders > View
orders section.

8.1.26. Newsletters
This module empowers you to send newsletters to your customers. For instructions on how to manage newsletters, mailing
lists, and subscriptions, please refer to the section Marketing in this guide.
Newsletters sent per step - Number of email messages that can be sent at a time.

Advanced mailing server options
Method of sending e-mails - Method you prefer to send newsletters through (external SMTP server or PHP mail
function).

SMTP server settings
SMTP host - Host name of the SMTP server.
SMTP username - Username to connect to the SMTP server.
SMTP password - Password to connect to the SMTP server.
Use SMTP authentication - Select if your SMTP server requires authentication.

8.1.27. Order barcode
This add-on provides the ability to add barcodes to invoices. A barcode is a machine-readable representation of data in the
form of parallel lines and spacings of different widths. Barcodes that are printed on the invoices contain information about the
orders.
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Configs:
Type - Barcode type.
Output - Format of the image for a barcode.
Text - Enable or disable text under a barcode.
Height - Barcode height in pixels.
Width - Barcode width in pixels.
Resolution - Barcode image resolution.
Text Font - Size of the text included in the barcode.
Barcode prefix - Prefix before the barcode number.

8.1.28. PayPal payments
With this add-on you can accept payments via PayPal Express Checkout, PayPal Pro, PayPal Standard, PayPal Advanced,
and PayPal Payflow Pro. When you install the add-on, the corresponding payment processors are added to the list of the
available processors on the payment method adding page.
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Instant payment notification settings
Override customer info - Tick this checkbox, if you want customer profile information in your store to be replaced
with the info sent from PayPal.
Test mode - Tick this checkbox, if you want the PayPal payments functionality work in test mode.

PayPal order status conversion map
Here you can choose statuses in your store, to which corresponding PayPal order statuses will be converted. To change a
status, just click on it and choose the new one from the drop-down list.
For example, the following record means that the order received from PayPal with the Created status will be converted to the
order with the Open status in your store.

PayPal logo settings
PayPal logo - Image that will be placed at the top of the cart review area at PayPal side. Use a valid graphics format,
such as .gif, .jpg, or .png. Limit the image to 190 pixels wide by 60 pixels high. PayPal crops images that are larger.
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8.1.29. Polls
This module enables you to place custom surveys and polls on the storefront. For instructions on how to create surveys and
polls, please refer to the section Website > Content in this guide.
Votes on page – Number of surveys and polls appearing on a single page.
Answers on page – Number of answers appearing on a single page.

8.1.30. Price list
This module empowers you to generate and publish your product catalog in the PDF and XLS formats.
Fields - Fields to be included in the price list:
o Selected fields - Fields already included in the price list.
o Available fields - Fields to be added to your price list.
Sort by - Order in which products are arranged in the price list.
Group by category - If selected, products in the price list are grouped according to categories that they belong to.
Include product options - If selected, the price list contains product options.
With arrows you can move fields from available to selected (arrows to the right.) Besides, you can search through the list of
fields with arrows below.

8.1.31. Quickbooks
This module enables you to export orders in IIF (Intuit Interchange Format) files that can then be imported into QuickBooks.
Here you can adjust some parameters of exported IIF files.

© 2004 - 2015 Simbirsk Technologies Ltd.

Add-ons

88

For instructions on how to handle IIF files and their contents, please refer to the official QuickBooks documentation and support
resources.
Note: When you enable this add-on, the Export to Quickbooks option appears under the gear button in the Orders > View
orders section.

8.1.32. Required products
This module enables you to define a list of products that must be bought together with a particular product. This add-on does
not have configurable settings.

8.1.33. Reward points
This module enables a point-based bonus program in your store. In such a program, customers are rewarded for a product
with a certain amount of bonus points that they receive at their accounts. Later they can use these points to pay for other
products or just reduce the original products cost if the existing amount of points does not cover it completely.
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Points can be bound to a separate product or product category. In the latter case, a customer receives points for purchasing
any product from the category. Alternatively, points can be given as a part of a membership level, i.e. points are assigned to a
user group and all customers who belong to the user group receive points every time they buy a product.
The possibility to buy a product for points is defined individually for each product. The product worth in points may be
calculated automatically depending on the global settings or be set up individually for each product. The amount of points
earned with the product can be inherited from the category settings or be specific to that product only. All individual values are
set up in the Reward points tab of the product details page.
Points Exchange Rate (PER) - Global exchange rate to convert monetary product costs to points. The value you
enter here is the number of points to cover one monetary unit (e.g., $1, €1 or £1), which is the default store currency.
For example, with the exchange rate of 10 points and the product cost of $50, the product's worth in points is 500 points
(50*10).
''Price in points'' is calculated automatically on PER basis - If selected, products' worth in points is calculated
automatically based on the global exchange rate.
''Price in points'' is recalculated taking into account discounts - If selected, product's worth is recalculated after
discounts are applied.
''Points'' is recalculated taking into account discounts - If selected, points are recalculated after discounts are
applied.
''Price in points'' is recalculated taking into account order discounts - If selected, product's worth is
recalculated after order discounts are applied.
''Points'' is recalculated taking into account order discounts - If selected, points are recalculated after order
discounts are applied.
If the product and the product category do not have defined reward points but the higher level category
has such reward points, extract data from it - If selected, categories and products with no bundled points inherit
the amount of reward points from a higher level category.
If several reward points can be applied, set - The rule to handle multiple bonuses. Select whether to give a
minimum or maximum bonus when multiple bonuses can be applied.
Apply zero reward point values - If selected, members of a user group for which zero reward points are defined will
not get reward points. Otherwise, one of the other rules will apply to this user group, and its members will receive
reward points according to the rule.
Log lines per page - Number of records from the log to be displayed on a single Reward points log page.

8.1.34. RMA
RMA stands for return merchandise authorization. This module is designed to simplify the process of managing product
returns. When the module is enabled, customers can register product return requests specifying the reason for the return and
providing other related information. Store administrators can then handle requested returns through a special section of the
administration panel. For instructions on how to handle registered product returns, please refer to the section Orders >
Return requests. Return requests are allowed only for products that are marked as returnable. This option together with the
return period is controlled separately for each product in the catalog at the product details page.
Display product return period - If selected, product return period is displayed on the storefront.
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Do not take weekends into account when calculating product return period - If selected, Saturdays and
Sundays are excluded from the return period.

8.1.35. RSS Feed
With this add-on, you add an RSS (Really Simple Syndication) feed generator to your store. This means that store visitors can
subscribe to receive updates on the activity in your store in a friendly and habitual manner together with other news and
notifications they daily receive.
To enable visitors to subscribe to an RSS feed, you need to add an RSS icon on the storefront. To add the icon and configure
the RSS feed properties, use a block of the RSS feed type in the Design >Layouts section.
Additionally, the add-on has the following global properties:
Content editor - Email address of the feed content's editor. It is highly recommended that you fill out an email address
here. Otherwise, the RSS feed may fail to be validated.
Show RSS feed for each category - If selected, the regular RSS icon

is displayed next to a category name. This

enables customers to subscribe to updates inside this category only.
Max product number per category - Maximum number of products in a category-based RSS feed.

8.1.36. Searchanise
Note: The official Searchanise documentation is available at searchanise.com.
The Searchanise add-on integrates CS-Cart with the SaaS-solution of the same name. It adds enhanced instant product
search to the storefront by replacing its regular search bar with a special search widget. Shoppers see search results as they
type in the search bar, and can quickly review the found products. So, customers can get to the right product way much faster
because they don’t even have to finish typing while the preview box forms the first impression of the product.
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Important! Searchanise is incompatible with the Age Verification add-on because this add-on controls access to products on
the category level while Searchanise processes store data on the product level and takes no account of categories and their
properties.

With the Manage Searchanise panel you can navigate through the Searchanise sections that are described separately further
in this guide.
Above this panel there is the Unlock Pro features button with that you can see the features of Searchanise Pro and update to
it.
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Below this panel there is the searches counter and the Searchanise tweeter feed. You can follow Searchanise tweeter clicking
the Follow button.

8.1.36.1. Search Engines
Here you can see some information about search engines: name, API key, and its status, as well as the date of last update
and resync.

Manual indexation
Under the hood, search results are received from Searchanise in real-time. However, Searchanise does not retrieve data from
your store database at the moment when the shoppers type in their requests as this would load the database server and
significantly slow down the performance. Instead, Searchanise keeps a snapshot of the store products on its servers, and
returns search results based on this snapshot. Such data includes the product description, price, features, and images/
thumbnails.
The add-on tracks any changes in the products catalog and automatically syncs then with Searchanise. Usually, it takes two or
three minutes to complete.
However, you can force to synchronize data by clicking the Force re-indexation button.
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This is rather a time-consuming operation that is unnecessary in most cases. Manual syncing is required only when the
product catalog has been updated in an unconventional manner. For example, directly in the MySQL database or as a result of
custom programming.

8.1.36.2. Full-text search preview
In this section you can see the preview of the search results to be displayed in the storefront when the customer uses the
search bar. Type any word in the bar and press Search. The results will be displayed below.
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Use the Sort by... select box to choose the search results method of sorting.

8.1.36.3. Instant Search Widget

Configure widget
The search bar gets seamlessly integrated with the current theme of the storefront. Still there is a room for fine-tuning the
outwards appearance of the auto-complete form and the product preview box.
Before configuring the widget, make sure to activate it by selecting the Enable instant search widget checkbox.

Colors
Under the Colors tab you can edit the color scheme of the widget to make it more aligned to the existing storefront design.
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To edit the color scheme:
1. Switch the color scheme to Custom colors.

2. Enter new hexadecimal values (from #000000 for black to #FFFFFF for white) into corresponding text fields.

3. Type some text in the field above the Preview changes button and click this button to test your modifications before
saving them. If you want to revert colors to the default, click the Reset colors button.
4. Click Apply changes to save the new color scheme.

Content
Under the Content tab you can configure the behavior of the widget. The description of the settings under the General,
Products, and Search Suggestions sections can be found under the Help tab. Settings under the Pro features section are
available only in Searchanise Pro.
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Translations
This section provides facilities for translating the Searchanise search widget. To translate the text, write it's translation in an
editable text box and save the changes.

Custom HTML (this section is available only in Searchanise Pro)
Here you can edit the HTML code of some instant search widget elements. Activate the checkbox above the HTML content to
make it editable. Activate the Syntax highlighter checkbox to show the HTML structure.

Do not forget to click the Apply changes button when you are ready.

Custom CSS (this section is available only in Searchanise Pro)
Use custom CSS styles to customize the look and feel of the instant search widget. Activate the Syntax highlighter checkbox
to show the CSS structure.
Activate the checkbox above the CSS content to make it editable. Do not forget to click the Apply changes button when you
are ready.

8.1.36.4. Suggestion dictionary
In this section you can see the list of phrases that will appear among the suggestions, when a customer starts to type the first
word of the phrase in the search bar.
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In the General tab there is the list of suggestions. The description of the fields you can find under the Help tab.
To search for a particular suggestion, type it in the Search suggestions field and click the Filter button.

To add a suggestion:
1. Click the + button to the right.
2. In the opened section type a suggestion in the editable field and choose its priority.
3. If you want to add more suggestions, click the + button below.
4. Click the Save phrases button when you are ready.
If you do not want to save any changes, click the Cancel button.

To edit a suggestion:
1. Click the Edit suggestions button.
2. Edit the Suggestion field of the desired phrase and change its priority, if needed.
3. Click the Save changes button.
If you do not want to save any changes, click the Cancel button.

To delete a suggestion:
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1. Choose the checkboxes of the desired suggestions in the Delete row and click the Delete selected button.
2. In the opened window click OK to confirm the action.

8.1.36.5. Redirects
Note: This section is available only in Searchanise Pro.

Define custom redirects for particular search terms.
For example, you have a promo page for a tablet PC sale. You want your customer to be immediately redirected to this page
as they enter "tablet", "tablet pc", or "ipad" in the search box.

Here is how you can do it:
1.

On the Redirects tab, click the green + button.

2.

Type "tablet, tablet pc, ipad" in the Search Terms, Comma-separated column.

3.

Type your promo page URL in the Redirect To column, e.g.: tablet-sale (you can use both absolute and relative paths).

4.

Click the Save Items button.

To search for a particular search redirects, type it in the Search redirects field and click the Filter button.

To delete a suggestion:
1. Choose the checkboxes of the desired redirects in the Delete row and click the Delete selected button.
2. In the opened window click OK to confirm the action.

8.1.36.6. Synonyms
Note: This section is available only in Searchanise Pro.

A search term synonym is another search term, which, when searched, is treated like the search term itself.
For example, declare a synonym for the word "ipad" to be "tablet". When the word "tablet" is searched in the storefront, the
search results will be the same as if the word "ipad" was searched. In both cases, the result for "ipad" will be returned.
Note that this will work differently in reverse: if you set "ipad" to be a synonym for "tablet", then both searches will return the
result for "tablet".

Here is how you can define a synonym for the search term "ipad":
1.

On the Synonyms tab, click the green + button.

2.

Check Add to the suggestion list if you want to guarantee that this search term is suggested.

3.

In the Synonyms, comma-separated column, type "tablet".

4.

Click the Save items button.
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Note that the new synonym will become available in the storefront only after the indexation is complete.

To search for a particular search synonyms, type it in the Search synonyms field and click the Filter button.

To delete a synonym:
1. Choose the checkboxes of the desired synonyms in the Delete row and click the Delete selected button.
2. In the opened window click OK to confirm the action.

8.1.36.7. Promotions
Note: This section is available only in Searchanise Pro.

You can trigger a certain product to appear in the search results when particular keywords are typed in the search box.
For example, if you want to suggest iPhone 5S to your customer if they search for "phone", "apple", or "apple phone", this is
what you should do:
1.

Go to the Promotions tab.

2.

Type the name of the product to promote in the search box at the top of the page (e.g. "iphone 5s") and click Search.

3.

In the input box near the product entry enter the keywords to trigger this products, separated with commas: phone, apple,
apple phone.

4.

Click Save changes.

An indexation will launch immediately. After it is complete, the changes will become visible in your storefront.

Note that the Promotions tab may show misleading data during indexation, so its content is hidden until the indexation is
complete.

8.1.36.8. Stop words
Note: This section is available only in Searchanise Pro.

Stop words are special words that are disregarded during search (learn more on Wikipedia).
By default, such words as "a", "the", and some prepositions are added to the stop word list. In this tab, you can add your own
stop words.
To add a new stop word:
1.

On the Stop words tab, click the green + button

2.

Type the term in the Stop word column.

3.

Click the Save items button.
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Note that the new stop word will become available in the storefront only after the indexation is complete.

To delete a stop word:
1. Choose the checkboxes of the desired words in the Delete row and click the Delete selected button.
2. In the opened window click OK to confirm the action.

8.1.36.9. Support
This section allows to send a message to Searchanise developers. Feel free to ask us any questions and suggest your
solutions for improvement of our search widget.
To send a message, type your text in the text area, write your e-mail in the Contact e-mail field, and click Send message.

8.1.37. SEO
SEO is a common acronym for "search engine optimization". Obviously, the module aims at helping you optimize your web
store for search engines and improve its ranking. Optimization consists in replacing unattractive dynamic URLs like http://
www.example.com/index.php?dispatch=products.view&product_id=1533 containing query strings and
ancillary data with clean search engine friendly URLs like http://www.example.com/true_product_name.html .
Such URLs not only help search engines to index store pages, but they also improve your customers' experience, as clean
URLs are human-readable and thus are easy to perceive and remember.
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Product SEO URL format - Pattern for clean URLs for storefront product pages.
Category SEO URL format - Pattern for clean URLs for storefront category pages.
Page SEO URL format - Pattern for clean URLs for other store pages.
Other SEO URL format - Pattern for clean URLs for other items.
Show language in the URL - If selected, URLs include the code of the language in which the referred page is displayed.
The code follows the host name and the directory name.
Use single URL for all languages - If selected, the same URL is used to address a page disregarding the current page
language. Otherwise, the page is referred to by several separate URLs according to the languages that the page can appear
in.
Allow non-latin symbols in URL- If selected, URLs can contain symbols from different languages.
Important: The module requires that your web server have a URL rewriter installed. For the Apache HTTP Server or any
Apache interchangeable implementation it must be the mod_rewrite module. For Microsoft's Internet Information Server (IIS) it
must be ISAPI_Rewrite.

8.1.38. SMS notifications
This module enables you to receive SMS notifications about some routine events that occur in your store and may require
immediate response. The module utilizes the resources of Clickatell Gateway, a trustworthy mobile messaging platform. This
implies that you have registered an account with Clickatell.
Phone number – Phone number to receive notification at.

Clickatell settings
Username – Your username with Clickatell.
Password – Password to access your Clickatell account.
API ID – Unique API ID that you received during the registration.
Use Unicode

Select to send SMS in the Unicode format.

Split long sms into several parts

Select whether to split long SMS into shorter parts to avoid possible loss of

information.

Send SMS if
New order has been placed – Select to receive notifications about new orders.
New customer has been registered – Select to receive notifications about newly registered customers.
Product quantity is less than zero – Select to receive notifications about out-of-stock products.
Only send when order total amount is more than – Minimum order subtotal to notify of.
Only send for these shipping methods

Select shipping methods that must be used in an order so that you

receive a notification.

SMS content
Add payment info – If selected, payment details are included in the notifications.
Add customers e-mail – If selected, customers' email addresses are included in the notification.
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8.1.39. Social Buttons
This module provides the ability to add social buttons to the storefront. With the help of the social button the user can express
that he/she likes, enjoys or supports certain content.
It is possible to display the quantity of users who liked each content and show a list of them. This is an alternative to other
methods of expressing reaction to content, like writing a reply text.

Twitter
Show Twitter button - If selected, the Twitter social button is displayed on the pages of the storefront;
Via - The user account to attribute the Tweet to;
Button size - The size of the Twitter social button;
Display count - The way to display the number of users, who liked certain content;
Display on - Choose whether to display the social button on product details pages, on other pages, or on both.

Facebook
Show Facebook button - If selected, the Facebook social button is displayed on the pages of the storefront;
Facebook app ID - The numerical ID of your application on Facebook;
The URL of the page to like - Type the URL with which you want to replace the current URL. Leave empty if you
want to use current page;
Include a Send button with the Like button - If selected, the Send button is displayed near the Like button;
Width of the Like button (px) - Width of the social button;
Button layout - Choose whether to display a standard social button, a button with count of users, who liked the
content, or a button with count, larger than a standard one;
Display profile photos - If selected, profile photos are displayed below the button;
Button verb - Choose the verb to display on the button:
Language - Choose the language of the social button;
Button font - Choose the text font to display on the button;
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Color scheme - Choose the color scheme for the social button: light or dark;
Display on - Choose whether to display the social button on product details pages, on other pages, or on both.

Vkontakte
Show Vkontakte button - If selected, the Vkontakte social button is displayed on the pages of the storefront;
Vkontakte app ID - The identifier of your application on Vkontakte (the app parameter.) If you have any;
Button layout- Choose the appearance of the social button: its size and whether to display the number of users, who
liked certain content;
Button height (px) - Height of the social button in pixels;
Button width (px) - Width of the social button in pixels;
Button Name - Choose the words to display on the button;
Display on - Choose whether to display the social button on product details pages, on other pages, or on both.

Google plus
Show Google plus button - If selected, the Google plus social button is displayed on the pages of the storefront;
Google plus href - The URL of the page to share;
Size - Choose the social button size;
Annotation - Choose the method of annotation display: Bubble - an annotation is displayed in the bubble-shaped field;
Inline - an annotation is displayed as the text in one line and includes profile pictures thumbnails;
Width - Define the social button width in pixels;
Align - Choose the button alignment on a page;
Expand to - Choose the direction of the pop-up note to expand.
Recommendations - Choose whether to show recommendations or not;
Display on - Choose whether to display the social button on product details pages, on other pages, or on both.

Pinterest
Show Pinterest button - If selected, the Pinterest social button is displayed on the pages of the storefront;
Shape - Choose the social button shape;
Color - Choose the social button color;
Display on - Choose whether to display the social button on product details pages, on other pages, or on both.

E-Mail
Show E-mail button - If selected, the social button to send e-mail is displayed on the pages of the storefront;
Display on - Choose whether to display the social button on product details pages, on other pages, or on both.

8.1.40. Social login
This module integrates HybridAuth library into your store and allows users to log in and register using various social apis and
identities providers such as Facebook, Twitter, Google, etc.
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Settings
Icons pack - Directory with the social networks icons. A path to the directory: media/images/addons/addons/
hybrid_auth/icons/.
Autogeneration email - Tick this checkbox to enable the email auto generation in case that a social network does not
pass the address.
When you activate this add-on, the Social login tab appears under the Website section where you can add and edit social
providers.

8.1.41. Store Import
This tool allows importing the database from an existing store to the latest installation of CS-Cart. The add-on does not have
configurable settings.

8.1.42. Store locator
This module allows you to locate your brick-n-mortar stores on Google Maps. Maps with marked locations can then appear on
the storefront so that customers can find a nearest point of sale. Locations are managed in Add-ons

Store locator.

Settings
API key – Your Google Maps API key. For details, please refer to the Google official help page.
Map zoom - The initial resolution at which to display the map, where zoom 0 corresponds to a map of the Earth fully
zoomed out, and higher zoom levels zoom in at a higher resolution.
Zoom control - Displays a slider (for large maps) or small "+/-" buttons (for small maps) to control the zoom level of
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the map.
MapType control - Lets the user toggle between map types (such as ROADMAP and SATELLITE).
Scale control - Displays a map scale element.

8.1.43. Suppliers
This module adds the Suppliers tab to the Customers section.
Display product supplier company - If selected, the name of the supplier company will be displayed on the product
details page.
Display shipping methods to each supplier separately - If selected, products are displayed for each supplier
separately at the checkout. And it is possibly to choose shipping for each supplier.

8.1.44. Tags
This module introduces support for tags assigned to product and content pages.
Tags for products – If selected, the functionality to add tags to product pages appears in the store.
Tags for pages – If selected, the functionality to add tags to static content appears in the store.

8.1.45. Twigmo
Use this module to connect your store to the Twigmo service. This service enables you to control your online store from your
mobile phone. Once connected, the module will process requests sent from this service and return the requested information,
and you will be able to review the sales statistics and recent orders as well as searching and editing the most important data products, orders and customers - just looking at and touching the screen of your mobile phone.

Furthermore, this module equips your store with a special storefront designed for mobile devices. When this option is enabled,
the store automatically detects the type of device from which a customer has opened the store in the web browser, and
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switches the storefront in accordance. This means that your customers will fill perfectly comfortable whether they browse your
online store from a desktop/laptop computer or a cutting-edge mobile device.
To learn more about the Twigmo service features, please visit www.cs-cart.com/twigmo.html.

Connecting to Twigmo service
Once you have installed and activated the add-on, you need to connect your store to the Twigmo service.
To connect the store to the Twigmo service:
1. Go to Add-ons > Manage add-ons.
2. Find Twigmo in the list, click the gear button, and choose Manage.
3. Enter your twigmo account e-mail address to the E-mail input field, complete the Password field and choose stores to
be connected to the Twigmo service. If you have no Twigmo account, it will be created automatically, and the
confirmation letter from Twigmo service will be sent to the specified e-mail..
4. Confirm your agreement with the terms of usage.
5. Click Connect.
Now you can connect to the administration panel using Twigmo applications for iOS, Android or Windows Phone. And you
customers will access your store from their mobile devices through a front-end that is specially adapted for mobile devices.

In this section you can also access Twigmo Helpdesk with the Contact Twigmo support link on the right and go to the
Twigmo official pages on social media (the Facebook and Twitter buttons). After connecting the store you will also see the
Twigmo Control Panel button in the Twigmo account tab. Use this button to access your mobile administration panel.

Configuring the mobile front-end
To configure the mobile front-end:
1. Go to Add-ons > Manage Add-ons.

© 2004 - 2015 Simbirsk Technologies Ltd.

107

CS-Cart Reference Guide

2. Find Twigmo in the list and click Manage.
3. Switch to the Mobile Storefront tab.
4. Configure the mobile storefront:
Show mobile version for - Select checkboxes near the device types for which the mobile version of your store will
be displayed.
Home page content - Choose the necessary content of the mobile Home page.
Design - Click the Visual Editor button to access Twigmo Visual Editor where you can customize your mobile
storefront.
Mobile Storefront logo - Upload an image for the logo of the mobile storefront.
iOS device home screen icon - Use this setting, if you want to change Twigmo home screen icon for iOS device.
Enable geolocation - If enabled, shipping and billing address fields will be populated with the address determined by
a geolocation service on the registration and checkout pages.
Show only user profile fields marked as required - If enabled, only required profile fields in the account
information will be shown on the Register page of the mobile version of your store.
URL of your Facebook page/Twitter page/app on iTunes App Store/app on Google Play - Enter URLs to
connect your apps or pages on social networks to the mobile version of your store. Corresponding social network
icons will appear on the mobile storefront.
5. Click Save to apply the settings.
In the Upgrade tab currently available upgrades are displayed. You can click Check for upgrades to refresh the list.

8.1.46. Video tutorials
This module enables detailed video tutorials is some parts of the administration panel (Dashboard, Design > Themes,
Design > Layouts). They can help you to quickly customize your store. The add-on does not have configurable settings.
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8.1.47. Watermarks

Overview
A watermark is a text or graphic overlay (usually, a transparent one) that is added to images. For example, this can be a
company name or a logo.
Watermarks not only add more identity to product and category images in your store, but they also protect images from
unauthorized commercial use by other companies and private individuals.
By using this add-on, you can define a common watermark for your store images. Then, CS-Cart will automatically add the
specified watermark to all necessary images and thumbnails in the product catalog.

Defining a watermark
To define a common watermark for the store:
1. In Add-ons

Manage Add-ons, open the add-on configuration by clicking

Settings.
2. Specify the watermark properties.
3. Click Save to apply your changes and close the form.

Watermark properties
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Watermark
Watermark type - Select the watermark type: a text (Text watermark) or an image (Graphic watermark).
For text watermarks only:
Text - Text in the the watermark.
Font - Font of the watermark text.
Font color - Color of the text in the watermark.
Font size (thumbnail) - Size of the text in the watermark used for thumbnails.
Font size (large image) - Size of the text in the watermark used for large images.
For graphic watermarks only
Thumbnail watermark - Specify the image that should be used as the watermark in thumbnails. You can either
upload an image from a local file system or specify a URL of the image.
Large image watermark - Specify the image that should be used as the watermark in large images. You can either
upload an image from a local file system or specify a URL of the image.
Watermark position - Select the position of the watermark in the base product/category image.

Watermarks in product images
Select whether the watermark should be placed in the product thumbnails and large images.

Watermarks in category images
Select whether the watermarks should be placed in the category thumbnails and large images.
Caution When you disable or uninstall the add-on, make sure to manually remove these .htaccess directives. Otherwise,
category and product pages will not be displayed on the storefront.

8.1.48. Wish List
This module enables customer wish lists on the storefront. The module does not have configurable settings.

8.2. Access restrictions
Use this section to manage registration and access restrictions in your store. Restrictions can be based on the IP addresses
from which visitors try to access your store and email addresses that visitors may use to register at the store. In addition, here
you can specify a set of credit card numbers that must never be accepted in your store.
Important: In order to add restrictions, you must first enable and configure the Access restrictions add-on (Add-ons
Manage Add-ons).
The section consists of five tabs: IP, Domain, Email, Credit card, and Administration panel. Different tabs are intended for
different types of restriction.
IP tab:
List of IP addresses that cannot be used to access the store (both the storefront and the administration panel). You can
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define either specific IP address or a range of addresses. For example, 192.0.2.12 or 192.0.2.24 - 192.0.2.255.
Domain tab:
List of domain names whose IP addresses cannot be used to access the store (both the storefront and the Administration
panel.) For example, example.com or site.example.org.
Email tab:
List of specific email addresses or email servers that cannot be used to register at the store. For example,
johndoe@mail.example.com or mail.example.com.
Credit card tab
List of 16-digit card numbers that will be rejected at checkout.
Administration panel tab:
List of IP addresses that cannot be used to access the Administration panel. You can define either specific IP address or a
range of addresses.
For example, 192.0.2.12 or 192.0.2.24 - 192.0.2.255.
Each tab contains a list of admitted values with the corresponding value attributes:
Reason - Reason for the restriction that is displayed when someone is trying to access the store from a banned IP
address or register with an unwanted email address or pay with disapproved credit card.
Status – Status of the restriction (Active or Disabled.)

8.3. Data Feeds
Note: This section requires that you have the Data feeds add-on enabled and configured in Add-ons

Manage Add-ons.

Use this section to create custom product feeds of any configuration. Feeds that you create here can be regularly uploaded to
different shopping directories (e.g., Google Product Search, Shopzilla, Amazon, etc.) or any other remote location that can be
accessed through FTP.
Tip: In CS-Cart, you can create separate data feeds for each store. To do so, switch to the store administrator mode before
creating a data feed.

Creating/configuring a data feed
To create and configure a custom data feed:
1. In the Administration panel, go to Add-ons

Data feeds.

The section contains a list of data feeds available in the store.
Here you can rename data feed, export it by Cron to Server or FTP, make it Active or Disabled, or export it to local computer,
server, or FTP server (tabs under the
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2. Click the

button to create the new data feed or click the

button and choose Edit to configure the existing data

feed.
This will open a form for creating/configuring a data feed. The form includes three tabs:
General tab:
Data feed name - Name of the data feed.
File name - Name of the exported file.
Language - Language of the data in the feed.
Category delimiter - Delimiter to separate child and parent categories.
Features delimiter - Delimiter to separate product features.
Images directory - Directory where product images are located. Used for images without a path specified.
Files directory - Directory where files for downloadable products are located. Used for files without a path specified.
Price decimal separator - Decimal separator for product prices.
CSV delimiter - Delimiter to separate data in the feed.
Exclude disabled products - If selected, products that are disabled in the product catalog are not included in the data
feed.
Status - Status of the data feed (Active or Disabled.)
Server directory - Directory on your server where the data feed will be exported to. Make sure the directory has
writable permissions.
FTP server - URL of the target directory on the FTP server to which the data feed must be uploaded.
Enclosure - Delimiter to separate fields in the uploaded data table.
Important: Make sure the URL you enter here agrees with the following format: host[:port]/directory. For
example, ftp.example.com:21/home/johndoe/feeds.
FTP username - Your username to access the FTP server.
FTP password - Your password to access the FTP server.
Export by cron to - Option to choose where the data feed must be uploaded to: A directory on the current server or a
third-part FTP server.
Exported items tab:
Use this tab to select which individual products and/or product categories from your catalog must be included in the data
feed.
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Fields mapping tab:
Use this tab to arrange a list of fields included in the data feed. Each field has the following attributes:
Pos. - Position of the field relatively to the position of the other fields in the data feed.
Field name - Name of the field.
Field type - Meaning of the data in the field.
Active - Checkbox to control the availability of the field.
3. Complete the form.
4. Click the Create button.
The new data feed will appear among the other data feeds in your store.

8.3.1. Google Base
The Google Export add-on adds a pre-defined data feed template to the store. This template basically links CS-Cart product
fields with those required by Google. You can customize the mapping rules by linking more fields or removing the existing
fields.
This pre-defined template is suitable for regular products from a US supplier. If your products require more fields or you are
from a different country, you need to create a new template.
A complete specification of product fields supported by Google is available at http://support.google.com/merchants/bin/answer.
py?hl=en&answer=188494 .
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If some necessary product fields are missing in CS-Cart, add them as product features (see Products > Features for more
details).

8.4. Store Import
The Store Import add-on is developed for importing data from any version of CS-Cart from 2.2.4 (except the Community
edition) to the current version.
You can import data from CS-Cart Professional versions 2.2.4-3.0.6 and CS-Cart Ultimate versions 3.0.1-3.0.6 to your store.
If you want to upgrade your store from CS-Cart or Multi-Vendor 4.0.x and later versions, use Upgrade Center instead.

Restrictions
• The functionality of importing several CS-Cart Professional stores to one CS-Cart 4.2.x installation as different storefronts is
not included in the Store Import add-on.
• CS-Cart Community store cannot be imported directly to CS-Cart 4.2.x.

Server Requirements
PHP version 5.3.x

Data migration from different versions of CS-Cart
Data imported to CS-Cart 4.2.x from your old store depends on the version of that store.
From CS-Cart 3.0.x:
In this case all data will be moved to the new CS-Cart 4.2.x installation. So, you will have your layout and settings data
imported, and customizing the store before the actualization will be much easier.
From CS-Cart 2.2.4/2.2.5:
In this case all data will be imported, except the layout and some settings data. The core settings data will be replaced with the
default (the Settings section of the administration panel). However, the add-ons settings data will be imported from your CSCart 2.2.4/2.2.5 installation. All the layout data (information about blocks and tabs) will be removed. The exception are some
blocks under the Products location (Design -> Layouts ->Products). If these blocks are of the Products type with the
Manually filling, they will be successfully imported to the new installation. By default, 3 product tabs will be imported from the
old CS-Cart 2.2.4/2.2.5 installation: Description, Features and Files (you can find them in the Product tabs section). Also,
in CS-Cart 2.2.4/2.2.5 there were product tabs, created automatically at the installation of certain add-ons. Such tabs data will
be imported to the new installation by the Store import add-on too.
Note: In case that you used several languages in your CS-Cart 2.2.4/2.2.5 or 3.0.x installation, it is recommended to choose
the same languages for the newly installed CS-Cart 4.2.x. You can change the languages in the Administration ->
Languages -> Manage Languages section of the administration panel.

Data import
Important: Before you start import always make sure you have enough space on your server hard drive.

© 2004 - 2015 Simbirsk Technologies Ltd.

Add-ons

114

1. In the Add-Ons -> Store Import section enter the server path to the existing CS-Cart store. It is the path where your
existing store is installed on the server. For example, on UNIX-based systems it should look something similar to ‘/var/www/
examplestore’, and something like ‘C:/examplestore’ on Windows.

Click the Validate button.
2. If the entered path was correct, you will be sent to the next step titled Validate and import. Here you will see two tables with
the information about the imported store and the store where you want to import data:
Admin panel URL (when you make import from CS-Cart Ultimate edition) – The path to the administration
panel;
Number of storefronts (when you make import from CS-Cart Ultimate edition)– The number of storefronts
created for the store;
Database host - Name of the hosting, where your database is kept;
Database name - Name of the database, that you want to import;
Database user - Name of the user, who has access to the database;
Table prefix - Prefix to be applied to all tables of the database.

Press the Import data button to start the importing process.
The launching of the import process will be indicated in real time. When the process is finished, the data from the old
installation will be imported to the current store.
3. Now you will proceed to the Configure your store step. At this step you are free to leave the Store Import page and
configure your store appearance. It can take you some time to modify the CSS styles, layouts, locations, etc. Meanwhile
your old CS-Cart store continues to work as usual, taking orders and serving customers.
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Note: First of all, go to the Administration -> Stores section and set the correct Storefront URL for the Company.

When you are ready, go to Add-ons -> Store Import again and press the Proceed to actualizing data button.
4. At the Actualize data step you will see the information about the latest store import. If you click the Actualize data button,
the data import from the old store will be launched. This import will exclude settings and layouts in order to import the
updated information of the active store, but keep the information about renewed layouts and settings in the new installation of
CS-Cart.
If you do not want to actualize your data and wish to finish the store import, you are free to skip this step (the Complete store
import button).
Note: All the information will be rewritten at this step, except the settings and layouts!
5. After the successful data import you proceed to the Finish store import step, and now you can use your new store live.
Moreover, you can always return to the Configure your store and Actualize data steps by clicking the corresponding links.

If you want to launch the import process again, click the Start new store import button.

License requirements
You can use the Store Import add-on in case that you own the license with the valid subscription for the updates. If you
license does not have an active upgrade subscription, you can either prolong upgrades for the current license, or buy a new
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license.
Do not forget that it is illegal to use both CS-Cart 2.2.4/2.2.5, 3.0.x. and CS-Cart 4.2.x live having one license. So, during the
customization, the CS-Cart 4.2.x store should be closed from the public access (the Close storefront option in the
administration panel). The old store should be closed from the public access right after you go live with your CS-Cart 4.2.x
version.

Also read in CS-Cart Knowledge Base:
How to upgrade your store using Store Import

8.5. Store Locator
Use this section to define the locations of your brick-n-mortar stores (if any) so that your customers can find the nearest point
of sale. Each location is plotted on a map according to the coordinates that you specify when adding a location.
This functionality is based on the Google Maps service, and you need to provide your Google Maps API key in Add-ons
Manage Add-Ons

Store locator before you can start using the service in your store. If you do not have such a key, sign up

for the key at http://code.google.com/apis/maps/signup.html.
Tip: To display the store locator on the storefront, remember to add a block with the content type Store locator (see Design > Layouts for more details).

Location attributes
Name - Name of the store location.
Position - Position of the location relatively to the position of the other locations in the list.
Description - Description of the location.
Country - Country where the store is located.
City - City in which the store is located.
Coordinates - Coordinates of the store (latitude and longitude of the location).
Status – Status of the location (Active or Disabled).

8.6. Searchanise
Note: The official Searchanise documentation is available at searchanise.com.
The Searchanise add-on integrates CS-Cart with the SaaS-solution of the same name. It adds enhanced instant product
search to the storefront by replacing its regular search bar with a special search widget. Shoppers see search results as they
type in the search bar, and can quickly review the found products. So, customers can get to the right product way much faster
because they don’t even have to finish typing while the preview box forms the first impression of the product.
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Important! Searchanise is incompatible with the Age Verification add-on because this add-on controls access to products on
the category level while Searchanise processes store data on the product level and takes no account of categories and their
properties.

With the Manage Searchanise panel you can navigate through the Searchanise sections that are described separately further
in this guide.
Above this panel there is the Unlock Pro features button with that you can see the features of Searchanise Pro and update to
it.
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Below this panel there is the searches counter and the Searchanise tweeter feed. You can follow Searchanise tweeter clicking
the Follow button.

8.6.1. Search Engines
Here you can see some information about search engines: name, API key, and its status, as well as the date of last update
and resync.

Manual indexation
Under the hood, search results are received from Searchanise in real-time. However, Searchanise does not retrieve data from
your store database at the moment when the shoppers type in their requests as this would load the database server and
significantly slow down the performance. Instead, Searchanise keeps a snapshot of the store products on its servers, and
returns search results based on this snapshot. Such data includes the product description, price, features, and images/
thumbnails.
The add-on tracks any changes in the products catalog and automatically syncs then with Searchanise. Usually, it takes two or
three minutes to complete.
However, you can force to synchronize data by clicking the Force re-indexation button.
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This is rather a time-consuming operation that is unnecessary in most cases. Manual syncing is required only when the
product catalog has been updated in an unconventional manner. For example, directly in the MySQL database or as a result of
custom programming.

8.6.2. Full-text search preview
In this section you can see the preview of the search results to be displayed in the storefront when the customer uses the
search bar. Type any word in the bar and press Search. The results will be displayed below.
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Use the Sort by... select box to choose the search results method of sorting.

8.6.3. Instant Search Widget
Configure widget
The search bar gets seamlessly integrated with the current theme of the storefront. Still there is a room for fine-tuning the
outwards appearance of the auto-complete form and the product preview box.
Before configuring the widget, make sure to activate it by selecting the Enable instant search widget checkbox.

Colors
Under the Colors tab you can edit the color scheme of the widget to make it more aligned to the existing storefront design.
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To edit the color scheme:
1. Switch the color scheme to Custom colors.

2. Enter new hexadecimal values (from #000000 for black to #FFFFFF for white) into corresponding text fields.

3. Type some text in the field above the Preview changes button and click this button to test your modifications before
saving them. If you want to revert colors to the default, click the Reset colors button.
4. Click Apply changes to save the new color scheme.

Content
Under the Content tab you can configure the behavior of the widget. The description of the settings under the General,
Products, and Search Suggestions sections can be found under the Help tab. Settings under the Pro features section are
available only in Searchanise Pro.

© 2004 - 2015 Simbirsk Technologies Ltd.

Add-ons

122

Translations
This section provides facilities for translating the Searchanise search widget. To translate the text, write it's translation in an
editable text box and save the changes.

Custom HTML (this section is available only in Searchanise Pro)
Here you can edit the HTML code of some instant search widget elements. Activate the checkbox above the HTML content to
make it editable. Activate the Syntax highlighter checkbox to show the HTML structure.

Do not forget to click the Apply changes button when you are ready.

Custom CSS (this section is available only in Searchanise Pro)
Use custom CSS styles to customize the look and feel of the instant search widget. Activate the Syntax highlighter checkbox
to show the CSS structure.
Activate the checkbox above the CSS content to make it editable. Do not forget to click the Apply changes button when you
are ready.

8.6.4. Suggestion dictionary
In this section you can see the list of phrases that will appear among the suggestions, when a customer starts to type the first
word of the phrase in the search bar.
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In the General tab there is the list of suggestions. The description of the fields you can find under the Help tab.
To search for a particular suggestion, type it in the Search suggestions field and click the Filter button.

To add a suggestion:
1. Click the + button to the right.
2. In the opened section type a suggestion in the editable field and choose its priority.
3. If you want to add more suggestions, click the + button below.
4. Click the Save phrases button when you are ready.
If you do not want to save any changes, click the Cancel button.

To edit a suggestion:
1. Click the Edit suggestions button.
2. Edit the Suggestion field of the desired phrase and change its priority, if needed.
3. Click the Save changes button.
If you do not want to save any changes, click the Cancel button.

To delete a suggestion:
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1. Choose the checkboxes of the desired suggestions in the Delete row and click the Delete selected button.
2. In the opened window click OK to confirm the action.

8.6.5. Redirects
Note: This section is available only in Searchanise Pro.

Define custom redirects for particular search terms.
For example, you have a promo page for a tablet PC sale. You want your customer to be immediately redirected to this page
as they enter "tablet", "tablet pc", or "ipad" in the search box.

Here is how you can do it:
1.

On the Redirects tab, click the green + button.

2.

Type "tablet, tablet pc, ipad" in the Search Terms, Comma-separated column.

3.

Type your promo page URL in the Redirect To column, e.g.: tablet-sale (you can use both absolute and relative paths).

4.

Click the Save Items button.

To search for a particular search redirects, type it in the Search redirects field and click the Filter button.

To delete a suggestion:
1. Choose the checkboxes of the desired redirects in the Delete row and click the Delete selected button.
2. In the opened window click OK to confirm the action.

8.6.6. Synonyms
Note: This section is available only in Searchanise Pro.

A search term synonym is another search term, which, when searched, is treated like the search term itself.
For example, declare a synonym for the word "ipad" to be "tablet". When the word "tablet" is searched in the storefront, the
search results will be the same as if the word "ipad" was searched. In both cases, the result for "ipad" will be returned.
Note that this will work differently in reverse: if you set "ipad" to be a synonym for "tablet", then both searches will return the
result for "tablet".

Here is how you can define a synonym for the search term "ipad":
1.

On the Synonyms tab, click the green + button.

2.

Check Add to the suggestion list if you want to guarantee that this search term is suggested.

3.

In the Synonyms, comma-separated column, type "tablet".

4.

Click the Save items button.
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Note that the new synonym will become available in the storefront only after the indexation is complete.

To search for a particular search synonyms, type it in the Search synonyms field and click the Filter button.

To delete a synonym:
1. Choose the checkboxes of the desired synonyms in the Delete row and click the Delete selected button.
2. In the opened window click OK to confirm the action.

8.6.7. Promotions
Note: This section is available only in Searchanise Pro.

You can trigger a certain product to appear in the search results when particular keywords are typed in the search box.
For example, if you want to suggest iPhone 5S to your customer if they search for "phone", "apple", or "apple phone", this is
what you should do:
1.

Go to the Promotions tab.

2.

Type the name of the product to promote in the search box at the top of the page (e.g. "iphone 5s") and click Search.

3.

In the input box near the product entry enter the keywords to trigger this products, separated with commas: phone, apple,
apple phone.

4.

Click Save changes.

An indexation will launch immediately. After it is complete, the changes will become visible in your storefront.

Note that the Promotions tab may show misleading data during indexation, so its content is hidden until the indexation is
complete.

8.6.8. Stop words
Note: This section is available only in Searchanise Pro.

Stop words are special words that are disregarded during search (learn more on Wikipedia).
By default, such words as "a", "the", and some prepositions are added to the stop word list. In this tab, you can add your own
stop words.
To add a new stop word:
1.

On the Stop words tab, click the green + button

2.

Type the term in the Stop word column.

3.

Click the Save items button.
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Note that the new stop word will become available in the storefront only after the indexation is complete.

To delete a stop word:
1. Choose the checkboxes of the desired words in the Delete row and click the Delete selected button.
2. In the opened window click OK to confirm the action.

8.6.9. Support
This section allows to send a message to Searchanise developers. Feel free to ask us any questions and suggest your
solutions for improvement of our search widget.
To send a message, type your text in the text area, write your e-mail in the Contact e-mail field, and click Send message.
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9. Administration
This area of the Administration panel is literally the main part of the administrator interface. It is used to configure and maintain
the store. Here you can adjust global settings, import and export store data, make a back up copy of the store database,
control the accessibility of the store, etc.

9.1. Stores
Use this section to manage the set and properties of available stores. Before that, make sure to acquaint yourself with the
multi-store functionality implemented in CS-Cart.

9.1.1. Understanding multi-store functionality
CS-Cart provides a multi-store environment. It consists of multiple stores and an integrated administration panel to manage
them all.
Each store has a separate storefront, configuration settings and checkout mechanism to ensure that visitors will recognize
each store unit as an independent store.

9.1.1.1. Operation modes

Difference between the modes
The administration panel offers two operation modes:
Root administrator's mode
In this mode, you can manage objects (products, categories, pages, etc.) of all stores.
Storefront administrator's mode
You can manage objects (products, categories, pages, etc.) of the selected store only.

Switching between the modes
To switch between the modes, use the select box at the top left-hand corner of the administration panel. All stores enables the
root administrator's mode while selecting a particular store enables the storefront administrator's mode.
Note: If you have only one storefront (use only one store), there is no need to switch between the modes. In such configuration
there is a single mode and the storefront administrator acts like the root administrator.
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9.1.1.2. Cataloging
CS-Cart uses a common product catalog for all stores. The catalog is arranged in a way of a tree structure. Root nodes
represent stores. Child nodes inside a root node are basically the product categories and subcategories assigned to the
corresponding store. A single category cannot be assigned to more than one store at once.

A product in the catalog must always belong to a category or subcategory of products. So, a product becomes automatically
assigned to a particular store depending on the position of the product's category in the common product catalog (see the
picture above.)
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However, an individual product can be assigned to multiple product categories at once. This feature enables you to share
products among several stores and sell it in different web stores (storefronts.)
In addition, each shared product can have a number of store specific properties, including the product name, description, price,
etc.

9.1.1.3. Customer accounts
CS-Cart offers two ways of handling customer accounts.
The first option is to have a joint customer base shared among all stores.
All stores will recognize a customer as a return customer once he or she has registered in any other store. Using this
option may be somewhat confusing for your customers who are supposed to regard stores as independent ones.
The second option is to have separate customer bases for each store.
Customers will have separate accounts in each of your stores. This is the recommended option.
To choose either of the options, use the Share users among stores checkbox in Settings

Stores.

9.1.1.4. Storefront appearance
Each store has an independent storefront. This concerns theme templates, blocks placement, site maps, menus - literally
everything. To manage storefronts, use the Design area of the administration panel.
Instructions and conceptual information on the storefront appearance management are provided in the Design chapter of this
guide.

9.1.1.5. Configuration settings
In CS-Cart, store configuration settings are conventionally divided into global settings and store-specific settings.
Global settings
Settings and options that affect overall store functionality and the behavior of the administration panel. They include logging
options, usage of secure connection in the administration panel, base for tax calculation methods, and so on.
Store-specific settings
Settings and options that affect a particular store unit and the behavior of the related storefront. They include storefront
appearance options (for example, thumbnail dimensions), usage of secure connection at checkout, company information,
and so on.

Updating configuration settings
The general rule for updating settings is as follows:
To update global setting, you need to operate in the root administrator's mode.
Normally, store-specific settings are grayed out in the root administrator's mode to prevent unintended editing, if
otherwise is not determined by the multiple-storefront feature configuration (Settings

Stores).

To update store-specific settings, you need to operate in the store administrator's mode.
Global settings are not available in the store administrator's mode.
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However, you can use the root administrator's mode to update store-specific settings in all stores at once. To do so:
1. When applicable, disable the protection of the option that you want update.
If a store-specific option is protected, it is grayed out. To disable protection, click the edit icon

.

If a store-specific option is not protected, it is available for immediate editing and have the edit icon highlighted

.

2. Update the option as required.
3. Click Save to apply the changes. The options gets updated in all stores.
Note: If you have only one storefront (use only one store), there are no edit icons (

and

.) In such configuration there is a

single mode and the storefront administrator acts like the root administrator.

9.1.1.6. Global entry point

What is a global entry point?
The global entry point is a popup window that your visitors see when they open a storefront for the first time. This window
contains a list of countries and regions. Each list item is linked to a specific storefront in your store. Visitor simply choose a
country or a region from the list, then they get redirected to the respective storefront.

Why to use a global entry point?
This feature comes in handy when several of your storefronts are, basically, localized websites targeted at specific areas in
the world.
For example, you have a flagship web store www.example.com that is intended mainly for visitors from the US. Its localized
version www.example.ru targets the Russian market. And four other web stores www.example.au, www.example.ca,
www.example.eu and www.example.co.uk contain information specific to Australia, Canada, the European Union and the
UK, respectively.
In such a situation, a global entry point becomes an initial point of contact between the bunch of your websites and your global
visitors.
Basically, it ensures that all of them quickly and easily find the necessary web store.
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Note: The global entry point does not anyhow detect visitors' location. The choice of the regions or country is made entirely by
the visitor.

How to create a global entry point?
A global entry point is generated automatically based on the properties of the individual stores. So, adding a global entry point
involves the following actions:
1. Enabling the global entry point
You need to enable the global entry point individually for each store. You can choose whether to activate the global entry
point on the home page only or on any storefront pages. The second option is useful when a global visitor opens a specific
page through a direct link.
Even if you do not enable the global entry point for a particular store, this store can still be linked to a region or a country in
the list. To do so, you need to assign regions and countries to the store.
2. Assigning regions and countries
You need to assign regions and countries individually for each store. CS-Cart imposes no limitations on the set of countries
and regions that you can assign to a given store. So, technically you can assign the same country or region to two or more
stores. If you accidentally assign a country/region to two or more stores, the corresponding list item of the global entry point
will point to the store to which the country/region has been assigned first.
For details on how to enable the global entry point and assign countries and regions, see Store properties.

9.1.2. Creating a new store
To create a new store:
1. In the administration panel, make sure to select All stores in the store selector.

2. Go to Administration

Stores and click

. This opens the new store creation form.

3. If you already have stores, select the store which objects you would like to copy to or share with the new store. Then select
the object types to copy and share.
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4. Define the new store properties. For details, see "Store properties" further in this chapter.
5. Click Create and Close to create the new store and close the form.
The new store appears in the list of all stores. The new store's storefront should be available through the URL specified in the
store properties.

9.1.3. Sharing objects
How does sharing work?
When you create an object (product, page, promotion, shipping method, etc.) in CS-Cart, you must assign it to a particular
store. However, you can easily share objects among different stores.
Note: Categories cannot be shared among stores. For details, read "Understanding multi-store functionality".
CS-Cart supports two types of sharing rules depending on the object type:
Invariable sharing
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Objects are shared among stores without any changes. This rule applies to such objects as product features and filters,
global product options, promotions, CMS content, languages, currencies, and shipping methods.
Configurable sharing
Objects can be shared among stores and have different properties in every store. For example, when you share a product,
you can define a different price, description, and other properties.
Additionally, CS-Cart provides a possibility to share customer accounts among stores. For details, read "Understanding multistore functionality".
CS-Cart has a number of global objects that apply to all stores and cannot have unit-specific values. These include the tax
calculation rules, order statuses, locations, states and countries, user groups, user profile fields, etc.

Sharing objects among stores
To share a product among stores (Configurable sharing):
1. Switch to the root administrator's mode.

2. Open the product details page.
3. Under the General tab, click + Add categories. This opens the common category tree.
4. Select one or more categories (highlighted in green) under a different store's node (highlighted in red.)
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5. Click Add categories and close to close the form.
6. Click Save to apply the changes.
The product will appear on the storefront of the newly assigned store under the selected categories. Now you can switch to the
store administrator's mode and define store-unit specific properties for the product.
To share other shareable object among stores (invariable sharing:)
1. Switch to the root administrator's mode.

2. Use the top navigation menu to browse to the object that you need to share. For example, go to Administration
Shipping & Taxes

Shipping methods to share a shipping method.
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3. Click Edit (

) that corresponds to the object. This opens the object configuration page.

4. Switch to the Share tab. This opens a list of stores that already share the object (if any).

5. Click + Add stores to open a list of all stores.
6. From the list, select stores that will share the object. Then click Add stores and close to update the list of stores that
should share the object.
7. Click Save to apply the changes.
Note: If you have only one storefront (use only one store), there is no sharing. In such configuration there are no Share tabs.

9.1.4. Store properties
When you create or edit a store, you can specify the store properties described below.
To create the new store you can simply copy existing store configuration choosing one of the stores from drop-down menu in
the Store field:

General
Store name
Name of the store as it appears in the administration panel. This identifier is necessary for you to easily distinguish stores
in the administration panel.
Storefront URL
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Base URL of the storefront. For details, see Storefront URL.
Tip: To edit this parameter, you must switch to the root administrator's mode. See Operation modes for details.
Secure Storefront URL
Secure URL of the storefront. (HTTP protocol protected by SSL).
Company settings
Store specific settings. For details, see Settings > Company.

Regions
Tip: Before changing the following properties, make sure that you have familiarized yourself with the concept of the global entry
point used in CS-Cart.
Global entry page
Select one of the available options:
None - Do not use the global entry point for this store.
Home page - Use the global entry point on the home page only.
All pages - Use the global entry point on all storefront pages.
Countries
Compose a list of countries and regions for the global entry point. Each list item will point to this store.
The list box on the right contains a list of all available countries and regions; the list box on the left contains a list of
countries and regions assigned to the store. If no countries and regions are selected, the the global entry point does point
to this store.
To move items from one list to the other one, use the twin horizontal arrows between the lists. To select multiple items,
press and hold the Ctrl or Shift key.
To adjust the list of countries supported in your store, go to Administration

Shipping & Taxes

Countries.

Caution: CS-Cart imposes no limitations on the set of countries and regions that you can assign to a given store. So,
technically you can assign the same country or region to two or more stores. If you accidentally assign a country/region
to two or more stores, the corresponding list item of the global entry point will point to the store to which the country/
region has been assigned first.

9.1.4.1. Storefront URL
Behind the scenes, CS-Cart is a monolithic software that has all its files and folders inside a single web directory on your web
server or hosting account (e.g., /home/YourAccountID/example.com/public_html). Such an installation has
example.com as the base store domain. The administration panel is available through the http://www.example.com/
admin.php URL.
The storefronts, however, can be accessible through diverse URLs, including the base store domain, a subdirectory to the
base domain, a sub-domain, or even a different domain. It is only required that the target URL is assigned to the web directory
where CS-Cart is installed (/home/YourAccountID/example.com/public_html in the example).
The following table reviews the available options.
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Base store domain
www.example.com
The base store domain is available as the default option. To use it as a storefront's URL, simply type the domain name in the
Storefront URL field on the store properties page.

Sub-directory
www.example.com/store
To make a storefront accessible through a sub-directory:
1. Create the subdirectory in the web directory where CS-Cart is installed (e.g., /home/YourAccountID/example.com/
public_html/store).
This can be done via your server/hosting control panel or by using an FTP, SSH, etc.
2. In the new subdirectory, create .htaccess file with the following content:

<IfModule mod_rewrite.c>
RewriteEngine on
RewriteRule ^(.*)$ ../$1 [L,QSA,E=DOCUMENT_ROOT:%{SCRIPT_FILENAME}]
</IfModule>

Sub-domain
store.example.com
To make a storefront accessible through a sub-domain, you need to configure domain aliasing for the sub-domain so that it is
pointed to the web directory where CS-Cart is installed (e.g., /home/YourAccountID/example.com/public_html/
store).
Because different hosting providers offer different tools to manage domain aliasing, please address your provider's support
resources for instructions.

Different domain
www.example.org
To make a storefront accessible through a different domain, you need to configure domain aliasing for that domain so that it is
pointed to the web directory where CS-Cart is installed (e.g., /home/YourAccountID/example.com/public_html/
store).
Because different hosting providers offer different tools to manage domain aliasing, please address your provider's support
resources for instructions.

Also read in CS-Cart Knowledge Base:
Configuring storefronts in CS-Cart via cPanel

9.2. Files
In this section you can manage files directly from the administration panel with the help of built-in file editor.
With the controls in the upper part of the editor (see the picture below) you can create, upload, rename, remove files, and
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perform other actions with them.

In the left section of the editor there are two tabs: Private files and Public files.
Private files tab contains files used in the WYSIWYG editor. Public files tab contains files stored in the images directory of
your CS-Cart installation (files for downloadable products, etc.)
To search for particular files or directories, use the search field in the top right corner of the editor.

9.3. Payment methods
In this section, you can adjust the set of payment methods that your customers can use to pay for their orders. For
convenience, all methods are arranged in a single list representing the name of the method, its current status (active or
disabled), and a few control elements.

Adding a payment method
To add a payment method:
1. Go to Administration

Payment Methods.

A list of the available payment methods is displayed.
2. Click

.

This opens a form for creating a payment method.
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3. Complete the form. See details below.
4. Click the Create button below the form.

Configuring a payment method
To configure a payment method:
1. Go to Administration

Payment methods.

This displays a list of the available payment methods.
2. Click the

button, corresponding to the name of the method you need to configure and choose Edit.

This opens a form for creating/editing a payment method.
3. Complete the form.
The General tab contains basic parameters of the method:
Name - Name of the payment method as it appears at the checkout.
Store - Store to which a payment method belongs.
Processor - Online payment system that will process the payments, made through this payment method. Leave
Offline if this method does not involve online processing.
Tip: To accept payments through an online payment system, first you need to register an account with this payment
system.
Template - Template to display all necessary input fields on the customer storefront (It is active only if you have
selected to use an offline payment system.)
Payment category - Select a category that the payment method will be attributed to. Payment categories appear on

© 2004 - 2015 Simbirsk Technologies Ltd.

Administration

140

the checkout page if two or more payment methods are assigned to different categories. Categories basically group
payment methods. This makes it easier for your customers to choose their preferable payment methods at checkout.
User groups - User groups whose members can use the method.
Description - Short description of the payment method that appears on the checkout page.
Surcharge - Extra amount of money to be added to the order totals. This can be a flat rate or a percentage. If you
specify both a percentage and a flat rate, the percentage is added first.
Surcharge title - Title of the surcharge as it appears at the checkout.
Taxes - Select tax calculation rules that should apply to the surcharge defined above.
To configure the available tax calculation rules in the store, use section Administration

Shipping & Taxes

Taxes.
Payment instructions - Administrator's instructions to customers on the usage of the payment method.
The instructions can be either a plain text or a formatted HTML text. If you are not familiar with HTML, you are
encouraged to add a formatted description using the built-in WYSIWYG HTML editor.
Icon - Icon to depict the payment method on the storefront.
Important: Icons that you upload (or refer to) here are displayed in a special block having Payment methods specified
as the block's content. Remember to create such a block in Design

Layouts.

The Configure tab appears only if you have selected to use an online payment system. It contains the settings that are
specific to the payment system.
Share tab:
Stores that share this payment method. Read "Sharing objects" for more details.
4. Click the Save button to apply the changes.

Also read in CS-Cart Knowledge Base:
Setting PayPal in CS-Cart

9.4. Shipping & Taxes
This section of the Administration panel assembles control elements to manage and customize shipping and tax settings in
your store.

9.4.1. Shipping Methods
A shipping method is a set of rules and parameters to calculate the cost of shipping orders to buyers. This section contains an
editable list of shipping methods present in the store.
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In the list, you can quickly edit certain attributes of a shipping method. To access more attributes click on the method name or
the

button which corresponds to the required shipping and choose Edit from the drop-down list.

Shipping method attributes
General tab:
Name - Name of the shipping method as it appears on the storefront.
Store - Store to which the shipping method originally belongs.
Icon - Graphics to represent the shipping method.
The graphics can be either uploaded from a local computer or the server file system or linked to a remote location where
the required image is physically located.
An alternative text describes the image and is shown when the image is missing or cannot be displayed. It is good
practice to have an alternative text associated with the image as an additional SEO-wise opportunity.
Images must be of one of the following formats only: JPEG, GIF, PNG. Maximum size of an uploaded image depends on
your server configuration. As a rule, it should not exceed 2 MB.
Remember that the icon appears on the storefront in a special block with the content type Shipping methods. Make
sure to create such a block in Design

Layouts.

Delivery time - Time until the order is delivered. This info is displayed on the storefront so that customers could decide
if the delivery time meets their requirements.
Weight limit - Minimum and maximum weight of the order to be delivered through this method.
Rate calculation - Mode in which the shipping cost must be calculated: manual (table-based) or real-time.
Table-based, or manual, calculation is based on the custom charges and rates that you define in the Shipping charges
tab.
Real-time calculation is based on the rates that your store receives from the carrier who will deliver the order. The rates
are received in the real-time mode at the moment the order is being placed. In order to use the carrier-dependent
estimation, you need to enable the support for the particular service provider in Administration

Shipping and taxes

Shipping methods.
Carrier-specific settings are defined in the Configure tab.
Shipping service - Shipping service provider/carrier that will be in charge of delivering the order. This select box is
available only if the rate calculation mode is set to Realtime.
Test - A special form to test the selected real-time shipping rate estimation service. Test estimation considers the
weight that you specify in the form as well as the company (Settings
Settings

Company) and the default customer address (

General/Default location.)

Taxes - Tax rates that apply to the shipping method.
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User groups) - User groups whose members can choose to deliver their orders through this shipping method.
Status - Status of the shipping method (Active or Disabled.)
Configure tab:
This tab appears only if you have selected real-time shipping rate calculation in the General tab of this section. Here you
should configure the selected shipping service and specify its settings. Such settings vary depending on the shipping service
provider. So, if you do not know what values/options should be entered or selected, please refer to the carrier's help pages and
documentation.
Shipping charges tab:
The rates that you define here are used to calculate the shipping cost regardless of whether you use real-time shipping rate
estimation or not. If you have chosen to receive rates from a carrier in the real-time mode, the charges from this section will be
simply added to the carrier's charge. You can use this to add a shipping markup in order to compensate for your actual
expenses if they exceed the values returned by the carrier (e.g., packing, insurance, etc.)
The rates can depend on the product cost, weight or quantity as well as being specific to the customer's location, when tablebased rate calculation is used. To adjust the set of available locations, use section Administration
Locations.

Product Cost/Weight/Quantity - Minimum value when the rate must apply.

© 2004 - 2015 Simbirsk Technologies Ltd.

Shipping & Taxes

143

CS-Cart Reference Guide

Rate Value - Shipping rate itself.
Type - Type of the rate: absolute monetary value or a percentage of the product cost.
Suppliers tab:
Pick suppliers for which this shipping method will be available. Choose None to make shipping method unavailable for
suppliers.
Note: This tab requires that you have the Suppliers add-on enabled in Add-ons

Manage Add-ons.

Share tab:
Stores that share this shipping method. Read "Sharing objects" for more details.

9.4.2. Taxes
This section contains an editable list of tax calculation rules available in your store. Use this section to add new rules and
manage existing rules.

In the list, you can quickly edit certain attributes of tax calculation rules. To specify rates, click the

button, which

corresponds to the required rule and choose Edit from the drop-down list. Then switch to the Tax rates tab.

Actions on taxes
The store administrator can carry out the following actions on the taxes:
Add new tax calculation rules with the

button.

Edit existing tax calculation rules (the Edit tab of the

button).

Apply multiple tax calculation rules to all products in the catalog with the
Remove selected taxes from all products with the

button above the list.

Delete tax calculation rules (the Delete tab of the

button).

button above the list.

Make tax calculation rules active or disabled (Active or Disabled links in the Status field).

Tax attributes
General tab:
Name – Name of the tax as it appears on the storefront.
Registration number – Internal registration number of the tax calculation rule in the store.
Priority – Position of this tax calculation rule in a sequence of multiple tax calculation rules being applied to a product or
a shipping method. If two rules have the same priority, they are applied in the same order as they are retrieved from the
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database. In this situation, the correct sequence may be breached. So, it is highly recommended that you set priority of
every tax calculation rule in the store.
Rates depend on – Type of customers' addresses that the calculation rule depends on: shipping address or billing
address.
Status – Status of the tax calculation rule in the store: Active or Disabled.
Price includes tax – If selected, the tax represented by this rule will be already included in the product price specified
on the product details page. Otherwise, the calculated tax will be added to the order subtotal when a customer places
the order.
Tax rates tab:
Location – Location of the customer who places the order. To adjust the available locations, use the controls in
Administration

Shipping & Taxes

Locations.

Rate value – Tax calculation rate that is specific to the given location. When the value is set to zero (0), the tax will not
apply to the order if it has been placed by a customer whose address falls within the corresponding location. Please
note that locations do not override each other. So, the value specified for the hard-coded default location (all countries)
will apply only if a customer comes from a location which is not defined or activated in Administration
Taxes

Shipping &

Locations, but will never apply to active locations, even those with zero values.

Type – Type of the tax: absolute value in the primary currency (see Administration > Currencies) or a percentage of the
product cost.

9.4.3. States
This section provides an editable list of states and provinces (per country) that are supported in your store. These states/
provinces are used to define users' location (see Administration > Shipping & Taxes > Locations.) Here you can add missing
states/provinces, or delete and modify existing states/provinces for each country registered and activated in Administration
Shipping & Taxes

Countries.
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State attributes
Code – Unique code to identify the state or province.
State/Province – Name of the state or province.
Status – Status of the state/province: Active (i.e. can be selected in a user profile) or Disabled.
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9.4.4. Countries
Use this section to manage the set of countries that are supported in your store. Countries are used to define users' location.

Country attributes
Code - 2-digit code to identify the country.
Code A3 - 3-digit official ISO code to identify the country.
Code N3 - Numeric code to identify the country.
Country - Name of the country.
Region - Part of the world where the country is situated.
Status - Status of the country: Active (i.e. can be selected in a user profile) or Disabled.

9.4.5. Locations
Use this section to manage the set of locations that are supported in your store. A location is a combination of parameters to
represent a geographical area. Locations are used to calculate shipping rates and tax charges.
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Here you can add new location with the

button, edit or delete the existing location with the

button, or make it

Active\Disabled.

Location attributes
General section:
Name - Name of the location.
Status – Status of the location (Active or Disabled.)

Countries section (countries to be included in the location:)
The list box on the right contains a list of all available countries, the list box on the left contains a list of countries included in the
location. To adjust the list of countries supported in your store, go to Administration

Shipping & Taxes

Countries.

To move items from one list to the other one, use the twin horizontal arrows between the lists. To select multiple items, press
and hold the Ctrl or Shift key.

States section (states to be included in the location:)
The list box on the right contains a list of all available states, the list box on the left contains a list of states included in the
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States.

To move items from one list to the other one, use the twin horizontal arrows between the lists. To select multiple items, press
and hold the Ctrl or Shift key.

Zip/Postal code section (zip/postal codes to be included in the location:)
The text box contains the zip/postal codes included in the location. Entries must be separated by a paragraph break (appear in
different lines.)
It is not necessary to specify the exact codes, you can use wildcards (? = any single character, * = any series of characters)
instead. For example, 98?78 stands for 98178, 98278, 98378, 98478, 98578, 98678, 98778, 98878, 98978 and 98078; 12*
stands for 12345, 12876, 12098, etc.

Cities section (cities to be included in the location:)
The text box contains the cities included in the location. Entries must be separated by a paragraph break (appear in different
lines.)
It is not necessary to specify the exact names of the cities, you can use wildcards (? = any single character, * = any series of
characters) instead. For example, New Y* would stand for New York, etc.; L?s* would stand for Las Vegas, Los Angeles,
etc.

Addresses section (addresses to be included in the location:)
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The text box contains the addresses included in the location. Entries must be separated by a paragraph break (appear in
different lines.)
It is not necessary to specify the exact addresses, you can use wildcards (? = any single character, * = any series of
characters) instead. For example, * street would stand for 1st street, 2nd street, etc.

9.5. Order statuses
This section allows you to adjust the default set of order statuses. You can edit the details of the existing statuses (
well as add custom statuses (

) as

).

Note: To add new order statuses, you need to operate in the root administrator's mode .
The following 7 statuses are available by default and cannot be deleted:
Processed – Payment has been received.
Complete – All work on the order has been completed.
Open – Order has been placed and created in the store database, but it hasn't been processed yet.
Failed – Payment transaction hasn't been completed.
Declined – Order has been canceled by the store administrator.
Backordered – Order hasn't been processed yet as it contains out-of-stock items.
Canceled – Order was canceled by a customer.
There is also one hidden initial status

Incomplete. The order is created in the store database and the system waits for the

response from a payment method. This status cannot be set by the user.
That is how order statuses are assigned:
1. A customer places an order, and the order is placed with the status "incomplete", which does not change the inventory.
2. If the customer uses an offline payment method, the order status changes to "open" until the store administrator assigns a
different status to the order.
3. If the customer uses an online payment method, a positive response of the payment gateway changes the order status to
"complete" while with a negative response the customer is suggested to replace the order. In the latter case, no new order
is created.

Adding custom order statuses
To add a new order status:
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1. In the administration panel, open the section Order statuses (Administration > Order statuses).
2. Click

. This will open a pop-up window with a form for the new status details.

3. Fill out the form. Fields marked with an asterisk (*) are mandatory. Please find the meaning of every field in the form under
the Order status heading further in this section.
4. Click the Create button.

Editing order status details
To edit the attributes of an existing order status:
1. In the administration panel, open the section Order statuses (Administration -> Order statuses).
2. Click the

button corresponding to the necessary order status and choose Edit from the drop-down list. This will

open a pop-up form with the status details.
3. Edit the values of the fields in the form. Fields marked with an asterisk (*) are mandatory. Please find the meaning of every
field in the form under the Order status attributes heading further in this section.
4. Click the Save button.

Order status attributes
Here is the list of order status attributes that you can change when adding a new order status or editing the details of an
existing order status.
Name - Name of the status.
Status - Letter symbol to identify the status in the database.
E-mail subject - Subject of an email message that is sent to customers automatically when the order status changes
to this status.
E-mail header - Header of an email message that is sent to customers automatically when the order status changes
to this status.
Color - Color to be used to visually distinguish orders in this status from other orders in the order list in the
administration panel. Click the

sign to open a palette and pick the color.

Notify customer - Select to send customers an automatic email notification when the order status changes to this
status.
Notify orders department - Select to send the store administrator an automatic email notification when the order
status changes to this status.
Note: The email address of the order department to receive notification at is specified in the section Settings >
Company.
Inventory - Choose whether to decrease or increase the number of items in stock for products included in the order.
Remove CC info - Select to remove sensitive credit card info from the database when the order status changes to
this status.
Pay order again - Select to allow customers to pay for the order again if the previous attempt failed.
Invoice/Credit memo - Chose the condition of the order after receiving this status: Invoice - The order has been paid
and processed successfully; Order - The order has been placed, but not paid out; Credit memo - The order has been
paid and processed, but then returned.
Notify supplier - Select to send an automatic email notification to suppliers whose products are in the order when the
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order status changes to this status.
Change gift certificate status to - Choose a status that should be automatically assigned to gift certificates included
in the order when the order status changes to this status. This setting appears when the Gift certificates add-on is
installed and set up in the Add-ons > Manage Add-ons section.
Allow return registration - Select to allow customers to request a return if the order has this status. This setting
appears when the RMA add-on is installed and set up in the Add-ons > Manage Add-ons section.

9.6. Profile fields
Use this section to configure the set of fields included in the profile forms of different types of user accounts.

Configuring existing fields
It is convenient to regard the section as a table where each row is a field and the columns control the availability of the field and
its options (see the picture below). The PROFILE column controls administrator and customer profiles, the CHECKOUT
column defines the set of fields to be completed if the customer prefers not to register and checkout anonymously.
To edit or create the existing field press the

button and choose Edit/Delete from the drop-down menu. Some fields are

mandatory and you cannot delete them from the list.

Pos. - Position of the field relatively to the position of the other fields in the profile.
Description - Field name as it appears in the profile.
Type - Type of the field.
Show/required - These two check boxes are used to define whether the field must be included in the profile (show)
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and whether it must be mandatory for completion (required.) Mandatory fields are marked in the form with an asterisk
(*).
Important: If you deactivate shipping address fields for a particular type of users, shipping will not work for this type of users.

Adding custom fields
You are encouraged to extend the default set of fields so that user profiles could better suit your business requirements.
To add a new field:
1. Click

. This will open a form with the field options.

2. Complete the form.
Description - Field name as it should appear in a profile.
Position - Position of the field relatively to the position of the other fields in a profile.
Type - Type of the field.
Section - Section of the profile to which the field should be added.
User-defined CSS-class - Name of a custom CSS-class that you want to use for the field. The CSS-class itself is to
be defined in the file styles.css located inside the skin directory
Show/required - Check boxes are used to define whether the field must be included in the particular type of the profile
(show) and whether it must be mandatory for completion (required.) Mandatory fields are marked in the form with an
asterisk (*). Profile stands for administrator and customer profiles, Checkout stands for the form to be completed by
anonymous buyers at checkout.
3. Click the Create button.
The new field will appear among the other fields in the list.

9.7. Currencies
This section contains a list of currencies that are in use in the store. As a rule, multiple currencies are used to display prices
on the storefront while payments are usually accepted in the store primary currency only. However, if your payment gateway is
configured to accept payments in different currencies, customers that use this gateway will be charged in an alternative (not
primary) currency. And the order total will be calculated according to the store currency exchange rate that you define here.
Note: All prices that you enter in the Administration panel are assumed to be in the primary currency.
General tab:
Name - Name of the currency as it appears on the storefront (USD, Euro, etc.)
Code - Unique code of the currency.
Primary currency - Store's primary currency.
Rate - The exchange rate to convert store prices and costs from the primary currency to this currency. In the example
above, the primary currency is the American dollar, and the values in the Rate field define, how many dollars are in one
euro and in one British pound.
Sign - Currency symbol.
After sum - If selected, the currency symbol appears after the price. Otherwise, it appears before the price.
Ths sign - Symbol for the thousands separator.
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Dec sign - Symbol for the decimal separator.
Decimals - Number of digits after the decimal sign.
Status - Currency status: Active - the currency is available on the storefront, Disabled - the currency is not available on
the storefront.
Share tab:
Stores that share this currency. Read "Sharing objects" for more details.

Also read in CS-Cart Knowledge Base:
How to display product prices only in the secondary currency in the storefront
How to set the secondary currency to be selected by default in the storefront

9.8. Languages
This section provides the facilities to control the set of languages that are available in your store, as well as editing and
translating the text of language variables appearing both on the storefront and in the Administration panel.

Translations (the list of language variables for the selected language)
Language variable - Name of the language variable as it is used in template (*.tpl) files.
Value - Value of the language variable as it appears on the storefront or in the Administration panel.

You can add new language variable using the

button.

Manage Languages (the list of the store languages)
Under the Installed tab there is the list of languages available in the store, and under the Available tab there is the list of
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languages available for installation.
Use the

button to upload the language file in the PO format. Read here about using and adding languages in CS-Cart.

Note: The default language cannot be removed from the list.
Language code - Two-letter code assigned to the language.
Name - Name of the language.
Country - Country, which flag will be used as language icon.

Status - Status of the language: Active - The language is visible both in the storefront and admin panel; Disabled - The
language is disabled both in the storefront and admin panel; Hidden - The language is hidden in the storefront, but
available in the admin panel.

Use the gear button of the language to carry following actions:
Edit - Edit language code, name, country, or status.
Delete - Delete the language (you will be able to find it under the Available tab after it).
Clone - Make a copy of the language (it is necessary when you want to create the absolutely new language in the
store).
Export - Save the language file in the PO format on your local computer.
Update from PO file - Update the language using the file in the PO format. You can download such files from CSCart translation project. More information you can find here.
Important: If you do not need to use the default language, make sure there is at least one alternative language enabled
before you disable the default language..
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Share tab:
Stores that share this language. Read "Sharing objects" for more details.

On-site live editing
Click the gear button

and choose the On-site live editing tab for editing the storefront on the fly.

Now you can see the storefront, and all the editable interface elements are marked with a dash line. You can continue
navigating through the interface just if you were using the regular mode.
To edit an element, hover the mouse pointer over it and click the following icon
appears in an editable field. Click

. Change the value of the element that

when you are ready.

With the On-site live editor you can edit:
Language variables
Products
Images
Categories
Pages
Banners
Storefront logo
Some settings

9.9. Logs
This section contains all logs of the store. By default, you can filter logs against a period within which they were created. To
access more filtering criteria, click the Advanced search link. If you filter logs against a particular search pattern regularly, you
will find it convenient to save the pattern and add it to the list of predefined patterns. Just set the search options, type the name
of the pattern in the Save this search as input box, and click the Save button. Once the search pattern is saved, it is
displayed in the drop-down list box at the top.
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button:

Settings - Go to the page with the logging settings;
PHP information - See information about the current PHP version;
DB Backup/Restore - Go to the page with the database settings;
Clean logs - Delete all recordings in logs.

The following information is given in the list of logs:
Time - Date and time the event was logged;
User - User who performed the action registered in the log;
Type - What action was performed and what it is related to (categories, database, news, orders, products, requests or
users;)
Content - Content of the log;
IP - IP-address of the user, who performed the action.

9.10. Database
This section is designed to help you maintain your store database. In particular, you can back up the database and restore it
from a backup copy. Another task that you can carry out here is to optimize the store database. Besides, the section contains
a link to the database logs.
Note: To access this page, switch to All Stores mode.

Creating a database backup
Making a database backup consists in creating a database dump, an SQL file that contains a record of the table structure and
the data from a database. The file is saved to the directory <cscart_dir>/var/backups/. For security reasons, it is
recommended that you move the dump from the default directory and keep it in a directory that cannot be accessed through
the web.
To back up the database:
1. Go to Administration

Backup/Restore and click the + button.

2. Specify the parameters of the backup.
Backup files – Tick this checkbox, if you want to include files in a backup.
Extra folders – Choose additional directories to be included in a backup.
Backup database data – If selected, the backup includes the database data proper. Normally, this option should be
enabled unless you have a reason to do otherwise.
Select tables – List of the database tables to be included in the backup. The tables with the "cscart" prefix are
selected in the list by default.
Note: To select multiple entries, press and hold the CTRL or SHIFT key.
Backup database schema – If selected, the backup includes the structure of the database tables. Normally, this option
should be enabled unless you have reason to do otherwise.
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Compress backup file – If selected, the backup (SQL file containing the database dump) will be compressed into a TAR
archive.
Backup file name – Name of the SQL file containing backup (database dump).
Important: If you have chosen to compress the backup file, the filename that you enter here will be expanded with the .
tgz extension.
3. Click the Create button.
The system will create the database dump displaying the progress and finally save it to the SQL file .

Restoring the database from a backup
Restoring the database consists in restoring the SQL dump that was created during the backup.
Important: When you restore the database from an SQL dump, the existing database tables get overwritten.
To restore the database:
1. Go to Administration

Backup/Restore.

2. Click the gear button in the upper right corner of a page and choose Upload file. Locate the file containing the SQL dump
(local computer, this server, or a remote location).
3. Click the Upload button.
You can also select the appropriate dump from the list, if it is located in the default directory <cscart_dir>/var/backup/.
Click the gear button of the required file and choose Restore.

Optimizing the database
Database optimization that you carry out here consists in reclaiming the unused disk space and defragmenting the database
files.
To optimize the database, go to Administration

Backup/Restore and click the gear button in the upper right corner of a

page. Click Optimize database. The system will optimize the database files displaying the progress.
Important: We strongly recommend that you make a backup copy of the database before you start optimizing the database. In
this case, you'll be able to restore the original database if something goes wrong during the optimization.

Also read in CS-Cart Knowledge Base:
Making Backup of Store Database
Restoring Backup of Store Database

9.11. Storage
This section is designed for the centralized work with the store data. You can use Amazon CloudFront for the content caching.
Amazon CloudFront helps to deliver various website data, including dynamic, static and streaming content using a global
network of edge locations.
You must have an account on aws.amazon.com to use this service.
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9.11.1. CDN settings
In this section you can define the parameters for using CDN (Content Delivery Network). Amazon is used as the CDN provider
(the Amazon CloudFront service).
Key - Identification key given to you after the registration at aws.amazon.com.
Secret key - Secure key given to you after the registration at aws.amazon.com.
CNAME - Domain name that you want to use instead of the CloudFront domain name for the URLs for your files. You
need to create a CNAME record with your DNS service to route queries to the CloudFront host (it will be displayed on
this page after you enter the account information).
Please note that if the secure connection is used in your store (in the administration panel or storefront), you also should
upload the SSL certificate for this domain name to Amazon Cloudfront. Please refer to this article for additional information.

9.11.2. Clear cache
Cache is the space in your computer's hard drive and in RAM memory where your browser saves copies of previously visited
web pages. You can clear your cache (that is, delete all the files in your cache / computer memory), when they begin to
occupy too much hard drive space, or when the files in the memory / cache get out of date and no longer correspond to the
files on a web server.
To clear cache on your computer, choose Administration

Storage

Clear cache.

9.11.3. Clean up generated thumbnails
Commonly, for the objects with images (products, options, etc.) large pictures uploaded. To display such picture in the product
list or on the product details page, the smaller picture is generated from this one.
These generated images are stored in the thumbnails cache. During the import or because of errors in products generating,
this cache needs to be cleaned up sometimes for the regenerating of images. This tab allows you to clean up these generated
thumbnails.

9.12. Import data
Use this section for bulk data import in the CSV (comma-separated values) format. An appropriate .csv file can be created or
edited in a third-party application that supports this format. For example, it can be a spreadsheet editor or an accounting
software.
For convenience, the section is divided into 4 subsections according to the data type. To switch between the subsections, use
the toggle on the left.
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Features - Use this subsection to import product features.
Orders - Use this subsection to import order details. Please keep it in mind that you can only update order details adding new records is not supported.
Products - Use this subsection to import product details, including wholesale prices (i.e., quantity-based discounts).
Subscribers - Use this subsection to import mailing list subscribers.
Translations - Use this subsection to import language variables.
Users - User this section to import user profiles.
Each subsection may consist of several tabs. Each tab includes two areas: The upper area contains a list of fields that the
imported file can include. Mandatory fields are highlighted. The lower area contains import options that may vary depending on
the type of the imported data.

Importable fields
Below are listed and described all fields that can be included in an import file. The list is arranged in alphabetical order.
Important: This list describes all fields that can be imported into CS-Cart. However, the imported data must reflect a certain
type of information, and all these fields cannot be imported in a single CSV file therefore. To know which fields can be imported
at a time, please refer to the list of applicable fields inside the tab for importing the particular data type.
Activation key - Subscription activation key.
Active – User's account status. Y = user is active, N = user is disabled.
Amount – Number of items of a certain product combination.
--- User's billing info --Billing: address.
Billing: address (line 2.)
Billing: city.
Billing: country - Two-letter country code as it appears in the first column of the Manage countries page (e.g., US.)
Billing: first name.
Billing: last name.
Billing: state.
Billing: title.
Billing: zipcode.
--- End of user's billing info --Category – Path to the product category starting from the parent directory (e.g., Directory///Subdirectory1///
Subdirectory2.)
Code - ISO code of the state (e.g., NY.)
Combination - Description of the option combination. E.g., "Size: X-Large, Color: Black".
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Combination code - Code of the option combination.
Company – Company name.
Confirmed - Flag to denote that the subscription has been confirmed (1 or 0.)
Country code - ISO code of the country (e.g., US.)
Coupons – Discount coupon number.
Date – Date when the order was placed. Must be in the MM/DD/YYYY format (e.g., 12/25/2013.)
Date added – Date when the product was added. Must be in the MM/DD/YYYY format (e.g., 12/25/2013.)
Description – Product description.
Detailed image - Absolute path to the file with a detailed product image. If you specify the directory for images in import
options, this field should contain the filename only.
Details – Administrator notes.
Discount – Order discount.
Downloadable – Downloadable product. Y = yes, N = no.
E-mail – User's/subscriber's email address.
Extra - Additional information about the order item.
Extra fields - Order's extra fields in the following format: {Field1: value, Field2: value, Field3: value}
.
Fax – Fax number.
Feature comparison - Product can be added to the comparison list. Y = yes, N = no.
Features - Product features. Please refer to the embedded help (the ? link ) for more details.
Files - Absolute path to files assigned to the downloadable product. If you specify the file directory in import options, this
field should contain the filename only. Several filenames must be separated by a comma (e.g., file1.pdf, file2.exe, file3.
ogg, etc.)
First name – User's first name.
Format - Mailing list receipt format: HTML or Plain text.
Free shipping - Product is shipped free of charge. Y = yes, N = now.
Inventory tracking - Track the product inventory. D = disabled, B = track with product options, O - track without
product options.)
IP address – Customer's IP address (e.g., 192.0.2.12).
Item ID – Unique ID that is assigned to every product in the order. Item IDs are required to avoid conflicts in situations
when an order contains two identical products with different options.
Language - Two-letter language code (e.g., EN.)
Last name – User's last name.
List price – Product's market price (in 0.00 format).
Login - User's login.
Lower limit - Minimum number of product items to qualify for the corresponding wholesale price. For example, with the
regular price of $5 per item you can offer the product for only $3 per item if a customer orders 15 or more product items
at a time. In this case the Price field must have the value "$3" and the Lower Limit field must have the value "15".
Mailing list - Mailing list assigned to a subscriber. One subscriber can have multiple mailing lists assigned.
Mailing list date - Date when the mailing list has been registered in the store.
Meta description - Product's meta-description.
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Meta keywords - Product's meta-keywords.
Min quantity - Minimum product quantity.
Name - Name of the language variable.
Notes – Customer's notes of the order.
Options - Product options. Please refer to the embedded help (the ? link ) for more details.
Order ID - Order identification number.
Override exchange rate - Override global point exchange rate. Y = yes, N = no.
Override points – Recalculate points that go together with the product. Y = yes, N = no.
Page title - Title of the product page as it appears in a web browser.
Pair type – Type of the product image. M = main, A = additional. The M image appears in the Detailed Information tab
while the A image appears in the Images tab.
Password - User's password encrypted through the MD5 cryptographic hash function.
Pay by points – Product can be paid for with points. Y = yes, N = no.
Payment ID – Numerical ID of the payment method.
Payment information – Payment details (encrypted).
Payment surcharge – Amount of the surcharge on the payment.
Percentage discount - Flag to denote percentage discount (1 or 0.)
Phone - Company's (the Orders tab) or user's (the Users tab) phone number.
Price - Product price or the wholesale price (the Qty discounts tab.)
Product code – Product's SKU (stock-keeping unit) code.
Product ID – Numerical ID of the product.
Product name – Name of the product.
Quantity – Number of ordered items or the current number of product items in stock.
Registration date - Date when the user registered. Must be in the format MM/DD/YYYY (e.g., 12/25/2013.)
Search words - Product search words.
Secondary categories – Additional categories to which the product is assigned. Categories are separated by a
semicolon (e.g., b///c; d///e.)
Ship downloadable – Calculate shipping cost for downloadable products. Y = yes, N = no.
Shipping – Shipping details (in the native format.)
Shipping cost – Shipping charge for the order.
Shipping freight – Product's shipping cost.
--- User's shipping info --Shipping: address.
Shipping: address (line 2).
Shipping: city.
Shipping: country - Two-letter country code as it appears in the first column of the Manage countries page (e.g.,
US.)
Shipping: first name.
Shipping: last name.
Shipping: state.
Shipping: title.
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Shipping: zipcode.
--- End of user's shipping info --Short description – Short product description.
State - Name of the state (e.g. New York).
Status - Product (A - active, D - disabled, H – hidden) or order (C - Completed, O - Open, etc.) status.
Store - Store that the item belongs to. Note that this field is not applicable to products as products are not really
associated with store units. For more details, see section Understanding multi-store functionality.
Subscribers date - Date when the subscriber has been registered in the store.
Subtotal – Order subtotal.
Supplier - Name of the product supplier according to the "Company" field.
Tax exempt – Taxes are exempt from the product cost. Y = yes, N = no.
Taxes – List of taxes applicable to the product or the order's tax info (in the native format.)
Thumbnail - Path to the file with the product thumbnail. If you specify the directory for images in import options, this field
should contain the filename only.
Title – User’s title (Mr, Ms, etc.)
Total – Order total.
Unsubscribe key - Subscription deactivation key.
User group - User group that the discount is applied to.
User group ID - Numerical ID of the user group that the user belongs to.
User ID – Numerical ID of the user.
User type – Type of the user's account (A = administrator, C = customer, S = supplier.)
Value - Value/content of the language variable.
Web site – Company or user's web site.
Weight - Product weight in the store's default unit. The default weight unit is set up in the section Administration ->
Settings -> General.
Zero price action - Allowed action on the product if the product has zero price. R = Disallow users to add the product
to the cart, P = Allow users to add the product to the cart, A = Ask users to enter a custom product price.

Import options
Below are listed all the available import options that may appear or not appear in a subsection.
Category delimiter - Delimiter to separate child and parent categories.
Images directory - Directory where images are located. Used for images without a path specified.
Files directory - Directory where files for downloadable products are located. Used for files without a path specified.
Delete all existing product files before import - If selected, the files assigned to the product are removed from the
files directory before the product import.
Reset inventory - If selected, the number of items in stock for each product is zeroed before the product import.
CSV delimiter - Delimiter to separate the imported values.
Select file - Location of the imported file. It can be either a local path or a URL to a remote resource.
Features delimiter - Delimiter to separate multiple product features.
Price decimal separator - Decimal separator for product prices.
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Also read in CS-Cart Knowledge Base:
Product Import
Imported Fields Format
Example of Product Import

9.13. Export data
This section is capable of exporting data in the CSV (comma-separated values) format.
For convenience, the section is divided into 4 subsections according to the data type. To switch between the subsections, use
the toggle on the right.

Features - Use this subsection to export product features.
Orders - Use this subsection to export order details.
Products - Use this subsection to export product details, including wholesale prices (i.e., quantity-based discounts.)
Subscribers - Use this subsection to export mailing list subscribers
Translations - Use this subsection to export language variables and country states.
Users - Use this section to export user profiles.
Each subsection may consist of several tabs. Each tab includes two areas: The upper area controls the content of the export
file, and the lower area controls the export options that may vary depending on the type of the exported data.

Export file contents
The contents of an export file are controlled by two list boxes. The Exported fields list box contains a list of fields that will be
included in the export file while the Available fields list box contains fields that can be added to the export file. Exportable fields
and their meaning are listed below.
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In order to move fields from one list to another, use the twin horizontal arrows between the lists. To re-arrange the items in the
list of exported fields, use the twin vertical arrows below the list box. If necessary, you can save and then re-use a particular
layout of the exported fields.
Note: Highlighted fields in the Exported fields list are mandatory and thus cannot be removed from the list.

Below are listed all fields that can be included in an export file. The list is arranged in alphabetical order.
Important: This list describes all fields that can be exported from CS-Cart in the CSV format. However, the exported data must
reflect a certain of information, and all these fields cannot be exported in a single CSV file therefore. To know which fields that
can be exported at a time, please refer to the list of applicable fields inside the tab for exporting the particular data type.
Activation key - Subscription activation key.
Amount - Number of items of a certain product combination.
--- User's billing info --Billing: address.
Billing: address (line 2.)
Billing: city.
Billing: country - Two-letter country code as it appears in the first column of the Manage countries page (e.g., US.)
Billing: first name.
Billing: last name.
Billing: state.
Billing: title.
Billing: zipcode.
--- End of user's billing info --Category – Path to the product category starting from the parent directory.
Code - ISO code of the state.
Combination - Description of the option combination. E.g., "Size: X-Large, Color: Black".
Combination code - Code of the option combination.
Company – Company name.
Confirmed - Flag to denote that the subscription has been confirmed.
Country code - ISO code of the country.
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Coupons – Discount coupon number.
Date – Date when the order was placed.
Date added – Date when the product was added to the catalog.
Description – Product description.
Detailed image - Path to the file with a detailed product image.
Details – Administrator notes.
Discount – Order discount.
Downloadable – Flag to indicate a downloadable product.
E-mail – User's/subscriber's email address.
Extra - Additional information about the order item.
Fax – Fax number.
Feature comparison - Flag to indicate a product that can be added to the comparison list.
Features - Product features.
Files - Path to files assigned to the downloadable product.
Format - Mailing list receipt format: HTML or Plain text.
First name – User's first name.
Free shipping - Flag to indicate that a product is shipped free of charge.
Image URL - URL of the product image.
Inventory tracking - Flag to indicate a product's inventory tracking options.
IP address – Customer's IP address.
Item ID – Unique ID that is assigned to each product in the order. Item IDs are required to avoid conflicts in situations
when an order contains two identical products with different options.
Language - Two-letter language code.
Last name – User's last name.
List price – Product's market price.
Localizations - Localizations for which the product is available.
Login - User's login.
Lower limit - Minimum number of product items to qualify for the corresponding wholesale price.
Meta description - Product's meta-description.
Meta keywords - Product's meta-keywords.
Min quantity - Minimum product quantity.
Name - Name of the language variable.
Notes – Customer's notes of the order.
Options - Product options.
Order ID - Order identification number.
Override exchange rate - Flag to indicate that global point exchange rate is overridden.
Override points – Flag to indicate that the points that go together with the product must be recalculated.
Page title - Title of the product page as it appears in a web browser.
Pair type – Type of the product image.
Password - User's password encrypted through the MD5 cryptographic hash function.
Pay by points – Flag to indicate that the product can be paid for with points.
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Payment ID – Numerical ID of the payment method.
Payment information – Payment details (encrypted).
Payment surcharge – Amount of the surcharge on the payment.
Percentage discount - Flag to denote percentage discount (1 or 0.)
Phone - Company's (the Orders tab) or user's (the Users tab) phone number.
Price - Product price or the wholesale price (the Qty discounts tab.)
Product code – Product's SKU (stock-keeping unit) code.
Product ID – Numerical ID of the product.
Product name – Name of the product.
Product URL - The URL of the product details page.
Quantity – Number of ordered items or the current number of product items in stock.
Search words - Product search words.
Secondary categories – Additional categories to which the product is assigned.
Ship downloadable – Flag to indicate that a shipping cost must be calculated for the downloadable products.
Shipping – Shipping details in the native format.
Shipping cost – Shipping charge for the order.
Shipping freight – Product's shipping cost.
--- User's shipping info --Shipping: address.
Shipping: address (line 2.)
Shipping: city.
Shipping: country - Two-letter country code as it appears in the first column of the Manage countries page.
Shipping: first name.
Shipping: last name.
Shipping: state.
Shipping: title.
Shipping: zipcode.
--- End of user's shipping info --Short description – Short product description.
State - Name of the state.
Status - Product status.
Store - Store that the item belongs to. Note that this field is not applicable to products as products are not really
associated with store units. For more details, see section Understanding multi-store functionality.
Subtotal – Order subtotal.
Supplier - Name of the product supplier according to the "Company" field.
Tax exempt – Flag to indicate that taxes are exempt from the product cost.
Taxes – List of taxes applicable to the product or the order's tax info in the native format.
Thumbnail - Path to the file with the product thumbnail.
Title – User’s title.
Total – Order total.
Unsubscribe key - Subscription deactivation key.
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User group - User group that the discount is applied to.
User ID – Numerical ID of the user.
User type – Type of the user's account.
Value - Value/content of the language variable.
Web site – Company or user's web site.
Weight - Product weight in the store's default unit.
Zero price action - Flag to indicate the allowed action on the product if the product has zero price.

Export options
Below are listed all the available export options that may appear or not appear in a subsection (in alphabetical order).
Category delimiter - Delimiter to separate child and parent categories.
CSV delimiter - Delimiter to separate the exported values.
Filename - Name of the exported file.
Files directory - Directory where files for downloadable products are located. Used for files without a path specified.
Images directory - Directory where images are located. Used for images without a path specified.
Language - Language of the exported data (two-letter language code.)
Output - Output type: Direct download - export file will be downloaded to you computer; Screen - file contents will be
shown in the web browser; Server - file will be saved on the server where CS-Cart is installed. Whichever you choose,
the export file will be available for further download from the list of exported files (Administration

Export Data,

Exported files link).
Features delimiter - Delimiter to separate multiple product features.
Price decimal separator - Decimal separator for product prices.

Also read in CS-Cart Knowledge Base:
Product Export

9.14. Upgrade center
Use this section to upgrade your CS-Cart installation to the latest version directly from the web interface. The upgrade center
automatically receives information about available updates from our server and lists the applicable upgrade packages. Original
files that are replaced during the upgrade get saved to the directory <cscart_dir>var/upgrade/packages/PACK_NAME.
Important: Before using the upgrade center, make sure you have your CS-Cart license number specified in Settings
Upgrade Center.
To start applying a pack, click Download and then the Install button corresponding to it.
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If you want to look through the list of changes in the upgrade package, click the Package contents link.

If some files cannot be upgraded due to access permission issues, you will see a warning. To set permissions, click the Autoset permissions via FTP button.

Here you are prompted to provide FTP access details to your server. This information is not sent to our servers.
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In case of the successful upgrade you will see a notification that your store has been successfully upgraded.
You can manually upload an upgrade package clicking the + button in the top right corner of the page.
To refresh the list of available upgrades, click the gear button in the top right corner of the page and choose Refresh
packages list. To be redirected to the Settings > Upgrade center section, choose Settings.

Also read in CS-Cart Knowledge Base:
How to upgrade CS-Cart via the Upgrade Center
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10. Settings
Use this section to configure the settings of your store. For convenience, settings are arranged into groups. To switch between
the groups, use the toggle on the left.

10.1. General
Settings and preferences in this section control a great number of parameters that affect different aspects of your store.
Alternative currency display format - This option controls whether product prices are shown in one currency
(selected by the customer) or two currencies (default store currency and the currency selected by the customer).
Weight symbol - Symbol of the unit of weight that you use in your store (e.g., lb, kg, etc.)
Grams in the unit of weight defined by the weight symbol - Number of grams in the unit of weight that you use
in your store.
Close storefront - Make the storefront unavailable for customers.
Access key to temporarily closed store - Key to access the storefront when the store is temporarily closed for
maintenance. For example, with the key = 123456, the closed store can be accessed through the following URL only:
http://www.example.com/index.php?store_access_key=123456 .
Initial order ID value - Integer number to open the order ID numbering. The value you enter here will be used as the
ID of the next order placed in your store. With every new order, its ID will increase by 1. The value of this field cannot be
less than any order ID number that is already in the database.
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Allow multiple shipments for a single user - If selected, products from one order can be shipped separately in
different shipments.
Tax calculation method based on - Select whether taxes should apply to individual products in the order (Unit price)
or the order subtotal, which also considers all discounts (Subtotal.)
Here is a complex example of how taxes are calculated if the tax calculation method is based on the order subtotal.
Provided the order contains three products:
Product A - $100 x 2

(tax1 = 10%)

Product B - $50 x 3

(tax2 = 5%)

Product C - $70 x 4

(tax1 + tax2 = 10% + 5%)

Order total = $630
Order discount = $60
--Step 1: Calculating the discounted subtotal
630 - 60 = 570
Step 2: Allocating the discount by the tax group subtotal
$570 / $630 = $0.904762
tax1 subtotal = (($100 * 2) + ($70 * 4)) * $0.904762 = $434.29
tax2 subtotal = (($50 * 3) + ($70 * 4)) * $0.904762 = $389.05
Step 3: Calculating taxes
tax1 (10%) = $434.29 * 0.1 = $43.43
tax2 (5%) = $389.05 * 0.05 = $19.45
Step 4: Calculating the total (discounted subtotal + taxes)
570 + 43.43 + 19.45 = $632.88
Help us improve software - Select whether snapshots of your store should be sent to the development team
automatically by CS-Cart or manually by the store administrator. Snapshots include no personal data, but they only
reflect the current condition of the store: its settings and configuration, the modules that you use, etc. This information
allows the development team to learn what CS-Cart features and options are used most intensively, and adjust the
development processes accordingly.
Check for updates automatically - Select to check for software updates automatically.

Default location
The values you enter here are automatically considered as the geographic location of all unregistered store visitors.
You can define the following details:
Default address;
Default zipcode;
Default city;
Default country;
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Default state;
Default phone.

Catalog
Enable inventory tracking - If enabled, the system automatically updates the product inventory every time products
are ordered or returned.
Allow negative amount in inventory - If enabled, customers can order products that are out of stock.
Enable selling downloadable products - If enabled, the Downloadable checkbox will be added to a product details
page. It means that a product can be distributed by download.
Download key TTL - Number of hours after a download link for a downloadable product was sent to a customer,
during which the customer can download the product. After that the link expires and becomes invalid.
Low stock notification threshold - Minimum number of product items in stock that the order department must be
warned about when this quantity is reached.
Show products from subcategories of the selected category - If selected, products from subcategories are
displayed on the parent category page.
Display modifiers for product options - If selected, product option and variant selectors reveal how choosing a
particular variant/option will change the original product price (if at all).
Exception style - The way the system must handle product option exceptions (illegal combination of options:) hide
illegal combinations or just show a warning message saying that the chosen combination is illegal and cannot be
ordered.
Show out of stock products - If selected, products are displayed on the storefront even if they are out of stock.

Promotions
Allow customers to use single discount coupon only - If selected, customers can apply only one discount
coupon per order.

Users/cart
Allow users to create multiple profiles for one account - If selected, users are allowed to specify multiple
shipping and billing addresses for a single account. This may be useful when a user needs separate profiles for
personal and business use, for example.
Define minimum order amount by - Choose whether the minimum order amount should include the shipping cost (
Products with shipping) or be a bare cost of products in the order (Products.)
Minimum order amount - Minimum amount of order subtotal required to place an order.
Allow shopping for unlogged customers - If selected, store visitors can add products to their carts even if they are
not logged in..
Allow checkout only from the Cart content page - If selected, a customer is redirected to the cart after clicking
the Checkout button. Otherwise, the customer goes directly to the checkout page.
Allow customer to sign up for user group - If selected, customers can sign up for user groups on the storefront.
Administrator must activate new user accounts - If selected, newly created customer accounts are inactive until
the store administrator activates them manually.
User e-mail is used as login - If selected, user email addresses can be used instead of regular usernames to log in
to the storefront and Administration panel.
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Quick Registration - Require only contact information for registration.
Estimate shipping cost on cart page - If selected, a form for estimating shipping cost is displayed on the cart page.
Disable shipping - If selected, customers are not allowed to choose shipping methods at checkout. Shipping is
deactivated in the store.
Disregard product options when calculating quantity discounts - This option controls how CS-Cart counts the
number of product items in order to apply a quantity discount. If selected, product options and option combinations are
regarded as the same product, and CS-Cart simply counts the number of ordered items. Otherwise, CS-Cart product
options are regarded as separate products.
For example, a customer buys a $10 t-shirt that two color options - red and blue. The quantity discount rule for the t-shirt
is to sell each item at $8 if there are 5 or more t-shirts in the order.
When this option is cleared, a customer needs to order 5 red or 5 blue t-shirt to qualify for the quantity discount.
When this option is selected, a customer can order 2 blue and 3 red t-shirt to get the discount as 2 plus 3 gives 5 in total.

Proxy server for outgoing connections
If your store works under a proxy-server, specify your connection details here.
Proxy host - Name of the proxy server (e.g., example.com.)
Proxy port - Proxy server port number (e.g., 8080.)
Proxy user - Username to connect to the proxy server.
Proxy password - Password to connect to the proxy server.

Search options
Search also in - If selected, the search is additionally conducted in Pages and/or Site News.

10.2. Appearance
In this section, you can adjust some parameters that affect general appearance and behavior of your store (both the customer
area and the administration panel). These parameters are common for all storefront themes.

Administrator settings
Note: The following parameters apply to the appearance of the Administration panel only.
Backend default language - Language in which all text variables are displayed.
Orders per page - Number of orders displayed per page.
Products per page - Number of products displayed per page.
Elements per page - Number of other items displayed per page.
CMS pages per page - Number of content pages displayed per page.
Default WYSIWYG editor - Select one of the supported WYSIWYG editors, or select not to use any at all.

Customer settings
Note: The following parameters apply to the appearance of the customer storefront only.
Frontend default language - Language in which all text variables are displayed.
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Orders per page - Number of orders displayed per page.
Products per page - Number of products displayed per page.
Elements per page - Number of other items displayed per page.
Number of columns in the product list - Number of columns that is used to arrange products on a product list
page. Note, this option applies to the Grid layout only.
Estimate taxes using default address on cart/checkout pages - If selected, customers whose addresses are
not registered in the database will see taxes calculated according to the default address.
Display prices with taxes on category/product pages if the method of calculating taxes is based on a
unit's price - If selected, product will be displayed on product and category pages having taxes included in the product
price.
Display prices with taxes on cart/checkout pages if the method of calculating taxes is based on a unit's
price - If selected, product will be displayed on the cart and checkout pages having taxes included in the product price.
Display mini thumbnail images as a gallery - If selected, multiple product thumbnails are displayed as a small
gallery.
Show number of available products - If selected, the number of products, available for customers, is displayed on
the storefront.
Use "Value changer" for the Quantity field - If selected, the ordinary quantity field in the product list and on the
product details page is supplemented with a widget to increase/decrease the product quantity.
Display the "Pagination section" on the top of the listed object - If selected, the pagination bar appears both on
the top and at the bottom of a product list.
Default image previewer - Select one of the supported image previewers.
Product detailed page view - Choose a template for the default product details page view. If necessary, the view can
be set up separately for every product details page or a category of products.
Display product details in tabs - If selected, product details (description, features and so on) are arranged in multiple
tabs.
Display track my orders section - If selected, the Track my orders bar appears in the My account section of the
customer area. With this bar a customer can track orders by order ID or email.
Tip: To manage product tabs, use section Design

Product tabs.

Product list layouts settings
Available product list views - Available templates to arrange products on a product list.
Product list default view - Default layout to display categories that have no specific layout defined.Product list
default view - Default layout to display categories that have no specific layout defined.
Use the selected view for current category or search page only - If selected, customers are allowed to change
the layout of the category or product list page that they are browsing at the moment. And moving to another category or
product list page will restore the default layout. When this option is disabled, a customer can select to use a different
layout, and the selected layout will apply to all category and product list pages that the customer visits during one
session.
Available product list sortings - Available orders in which products are sorted on a products list page: Alphabetical by name in alphabetical order, Price - from lowest to highest product price (or from highest to lowest,) Popularity - by
product rating, Bestsellers - by the number of sold items, Oldest - by the date of adding the product to the store (Older
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are higher), Newest - by the date of adding the product to the store (Newer are higher,) Position - by position, that the
product takes in the list.
Enable quick view - If selected, the Quick view button appears on the product picture when the customer hovers a
cursor on it.
Product list default sorting - Default order in which products are sorted on a products list page.

Common settings
The following settings apply both to the storefront and the Administration panel:
Date format.
Time format.
Time zone.
Calendar date format.
Calendar week starts from.
Unsaved changes warning - If selected, administrators are warned of unsaved changes before they leave the page.
Show menu description - If selected, drop-down menus in the administration panel have a short description of each
item.
Notice displaying time - Number of seconds to display pop-up notices that follow an event like changing a status of an
item in the Administration panel, or adding a product to the cart.

10.3. Company
Use this section to specify your company details and contact information.
Company name - Name of your store. The value that you enter here is included in the copyright notes and invoices.
The following parameters are used to specify the geographical location of your business and your contact info. These details
are also mentioned in invoices.
Company address;
Company city;
Company country;
Company state;
Company zip code;
Company phone;
Company phone 2;
Company fax;
Company website.
Year when the store started its operation - The year since your company has been in business. This value is
used in copyright notes.
User department e-mail address - Email address to receive notifications about newly created, modified and deleted
user profiles.
Tip: To receive notifications about newly registered customer accounts, make sure to enable Administrator must
activate new user accounts in Settings

General.

© 2004 - 2015 Simbirsk Technologies Ltd.

Settings

176

Site administrator e-mail address - Email address to receive notifications about any technical issues.
Order department e-mail address - Email address to receive notifications about placed orders and changed order
statuses.
Help/Support department e-mail address - Email address to receive messages submitted through the Contact
Us form.
Reply-To newsletter e-mail address - Email address to include in newsletters as a reply-to address.

10.4. Stores
Use this settings to adjust the configuration of the multiple-storefront feature of your CS-Cart installation.
Share users among stores - If selected, the store uses a joint customer database where customer accounts are shared
among all stores. Otherwise, each store has a separate customer base.
Default state of the "Update for all stores" icon - Determines if store-specific options must be available for
immediate editing in the root administrator's mode. Active means that options are for immediate editing. Not Active means
that options are protected from unintended editing.
Caution: Editing a store-specific option in the root administrator's mode will update (overwrite) this option in all stores. It is
recommended that you normally have store-specific option protected (Default state of the "Update for all stores" icon = Not
Active) to prevent unintended editing.

10.5. Checkout
Use this section to adjust some parameters that affect the checkout appearance and functionality.
Disable anonymous checkout - When selected, only registered customers are allowed to place orders in your store.
Profile address section order - Choose which customer address should go first on the checkout page: billing
address or shipping address.
Ask customers to agree with terms & conditions during checkout - If selected, customers are asked to accept
your store terms and conditions at checkout.
Allow customers to pay order again if transaction was declined - If selected, customers are allowed to carry
out the same transaction if it previously failed.
Offer guest to create an account after successful order - If selected, at guest checkout, the buyer is offered to
register an account if the order was placed successfully.
Configure "Sign in" step - Choose the Sign in step sections order (or hide the step).
Default option for the "New customer" section at the "Sign in" - Choose what radio button will be chosen by
default in the New customer section - Register or Checkout as guest.
Display "Payment method" step - Tick this checkbox to display the step where a customer can choose a payment
method at the checkout.
Display "Shipping method" step - Tick this checkbox to display the step where a customer can choose a shipping
method at the checkout.
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10.6. E-mails
Settings in this section define the way CS-Cart will send email messages and notifications.
The three available options are:
Via an external SMTP server;
Via the PHP mail() function;
Via Sendmail (a popular email routing facility).
If you want to use an external SMTP server, specify connection details. If you want to use Sendmail, specify the absolute path
to the executable file. If you choose to use the PHP mail() function, emails will be sent directly from the script.

10.7. Thumbnails
Use this section to specify parameters and properties of automatic thumbnail creation.
Thumbnail background color - Background color of a thumbnail in hexadecimal HTML color code.
Thumbnail format - Format of a resized thumbnail. You can choose to keep the original format or convert it to GIF,
JPEG or PNG.
JPEG format quality - Quality of resized JPEG images starting from 100%, which is hard to distinguish from the
uncompressed original but that takes most storage space, down to 10% showing serious image degradation. It is
recommended that you not compress that aggressively and use the quality of no less than 60%. In most cases, the
optimum quality level is 80%.
Product list (category, search, etc.) thumbnail width - Width of a resized product thumbnail in the product list.
Product list (category, search, etc.) thumbnail height - Height of a resized product thumbnail in the product list..
Product details page thumbnail width - Width of a resized product thumbnail on the product details page.
Product details page thumbnail height - Height of a resized product thumbnail on the product details page.
Product quick view thumbnail width - Width of a resized product thumbnail on the product quick view page.
Product quick view thumbnail height - Height of a resized product thumbnail on the product quick view page.
Product cart page thumbnail width - Width of the resized product thumbnail on the cart contents page.
Product cart page thumbnail height - Height of the resized product thumbnail on the cart contents page.
Categories list thumbnail width - Width of a resized category thumbnail in the category list.
Categories list thumbnail height - Height of a resized category thumbnail in the category list.
Category details page thumbnail width - Width of a resized category thumbnail on the category details page.
Category details page thumbnail height - Height of a resized category thumbnail on the category details page.
Detailed category image width - Width of a detailed category image on the category details page.
Detailed category image height - Height of a detailed category image on the category details page.

10.8. Sitemap
Use this section to adjust the details of the sitemap that is automatically generated for your web store.
Show the ‘Categories’ section - If selected, the sitemap includes links to root categories and every subcategory.
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Show only root level categories links in the ‘Categories’ section - If selected, the sitemap includes links to root
categories only.
Show the ‘Site info’ section - If selected, the sitemap includes links to pages from the Information section.
Note: Use

icon to apply changes for all stores.

10.9. Upgrade center
Use this section to adjust the settings of the CS-Cart upgrade center available in Administration

Upgrade center.

License number - Your CS-Cart license number.
Hostname - Name of your FTP server.
Username - FTP account username.
Password - Password for the FTP account username.
Directory - Directory where CS-Cart files are located.
Note: FTP access details are required to adjust file permissions if there are access permission issues during the upgrade.

10.10. Security settings
Use this section to adjust security settings for accessing the backend.
Enable secure connection at checkout - If enabled, checkout pages work through the HTTPS protocol. This option
requires an SSL certificate to be installed on your server.
Enable secure connection in the administration panel - If enabled, the Administration panel works through the
HTTPS protocol. This option requires an SSL certificate to be installed on your server.
Enable secure connection for authentication, profile and orders pages - If enabled, login and profile
registration/update pages on the customer storefront work through the HTTPS protocol. This option requires an SSL
certificate to be installed on your server.
Keep HTTPS connection once a secure page is visited - If selected, visitors continue browsing through the
HTTPS protocol after they visit a secure page for the first time.
Minimum administrator password length - Minimum number of characters that in an administrator password.
Administrator password must contain both letters and numbers - If selected, the system demands that an
administrator password contain both letters and numerals. This improves password strength and thus makes it more
effective in resisting guessing and brute-force attacks.
Force administrators to change password on the first login - If selected, store administrators are demanded to
change their passwords once they have logged in to the administration panel for the first time.
Password validity period in days - Days before an administrator password expires and the user is demanded to
change the password. Set the value of this field to 0 (zero) so that passwords never expire.
Access key to cron script which sends e-mail notifications of password change - Key to access the cron
script that reminds the store administrator to change the password. To activate the script, open in your web browser
http://www.example.com/admin.php?dispatch=profiles.
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password_reminder&cron_password=access_key replacing the access_key part with the key you enter in this
field.
Notify visitors about cookies use - If selected, visitors will see the following note when they enter the site:

The note will be visible till a visitor clicks OK.

10.11. Image verification
Image verification is used to ensure that forms in your store are completed by humans, not automated systems. This allows
you to avoid lots of spam and fake user accounts. You can adjust parameters of verification images as well as specify when
image verification is required.
Image width – Width of a verification image.
Image height – Height of a verification image.
String length – Number of characters in an image.
Number of grid lines - Number of grid lines in an image.
Grid color – Color of grid lines in an image (hexadecimal code).
Minimum font size – Minimum font size of characters in an image.
Maximum font size – Maximum font size of characters in an image.
String type – Type of characters to appear in a string (digits, letters, or both).
Character shadows – If selected, characters are displayed with shadows.
Color – If selected, characters are displayed in color.
Background image – Image that is used as a background for a verification image. This field must contain a relative
path to the graphic file with the image.
Do not use verification if user is logged in – If selected, customers who have logged in to the store are not asked
to verify images.
Do not use verification after first valid answer – If selected, store visitors are not asked to verify images after they
have verified the first image.

Use for
Here you should specify forms for which image verification is required.
Login form.
Custom forms.
Send to friend form.
Comments and reviews forms.
Checkout (user information) form.
Polls.
Track my order form.
Create and edit profile forms.
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10.12. Logging
In this section, you can specify what kind of events must be registered in the system logs. Log files are kept in the directory
<cscart_dir>/var/log. Since log files can gradually grow larger, it is recommended that you clean the directory from time
to time. Or you can view and clean up the logs in Administration

Logs.

News – Select to track and record events concerning news that is published in your store.
Users – Select to track and record events related to user activity.
Products – Select to track and record events concerning products in the catalog.
Orders – Select to track and record events concerning orders.
Database – Select to track and record events concerning your store database.
Categories – Select to track and record events concerning product categories.
Requests – Select to track and record all HTTP and HTTPS requests.
General - Select to track and record general events.

10.13. Reports
Use this section to specify the format of time intervals displayed in report charts. You can specify the formal of the following
time intervals: day, week, month, year.
Note: Use

icon to apply changes for all stores.

10.14. Settings wizard
Settings wizard is a convenient post installation tool. Here you can set up some general preferences of your store in several
steps.
Note: Use

icon to apply changes for all stores.

Security settings
New administrator password - It is strongly recommended to change the administrator password, that was given you
after registration. Be sure, that your password is secure enough.
You can get automatically generated password pressing the Generate button.
SSL certificate - Click Check SSL button to check the secure connection.
Enable secure connection at checkout - If enabled, checkout pages work through the HTTPS protocol. This option
requires an SSL certificate to be installed on your server.
Enable secure connection in the administration panel - If enabled, the Administration panel works through the HTTPS
protocol. This option requires an SSL certificate to be installed on your server.
Enable secure connection for authentication, profile and orders pages - If enabled, login and profile registration/
update pages on the customer storefront work through the HTTPS protocol.
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This option requires an SSL certificate to be installed on your server.
Minimum administrator password length - Minimum number of characters that in an administrator password.
Administrator password must contain both letters and numbers - If selected, the system demands that an
administrator password contain both letters and numerals. This improves password strength and thus makes it more
effective in resisting guessing and brute-force attacks.
Force administrators to change password on the first login - If selected, store administrators are demanded to
change their passwords once they have logged in to the administration panel for the first time.

Appearance settings
Default wysiwyg editor - Select one of the supported wysiwyg editors, or select not to use any at all.
Default image previewer - Select one of the available tools for displaying images and image galleries.
Primary currency - Select the stores's primary currency.
Backend default language - Language in which all text variables are displayed (for the administration panel).
Frontend default language - Language in which all text variables are displayed (for the customer's area).
Estimate taxes using default address on cart/checkout pages - If selected, customers whose addresses are not
registered in the database will see taxes calculated according to the default address.
Display prices with taxes on category/product pages if the method of calculating taxes is based on a unit's
price - If selected, product will be displayed on product and category pages having taxes included in the product price.
Display prices with taxes on cart/checkout pages if the method of calculating taxes is based on a unit's
price - If selected, product will be displayed on the cart and checkout pages having taxes included in the product price.
Show number of available products - If selected, the number of products available for customers is displayed on the
storefront.
Display mini thumbnail images as a gallery - If selected, multiple product thumbnails are displayed as a small gallery.
Use "Value changer" for the Quantity field - If selected, the ordinary quantity field in the product list and on the product
details page is supplemented with a widget to increase/decrease the product quantity.
Display product details in tabs - If selected, product details (description, features, and so on) are arranged in multiple
tabs.
Date format - Choose the format, in which a date will be displayed both in the administration panel and in the customer's
area.
Time format - Choose the format, in which time will be displayed both in the administration panel and in the customer's
area .

Company settings
Use this section to specify your company details and contact information.
Company name - Name of your store. The value that you enter here is included in the copyright notes and invoices.
The following parameters are used to specify the geographical location of your business and your contact info. These details
are also mentioned in invoices.
Company address;
Company city;
Company country;
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Company state;
Company zip code;
Company phone;
Company phone 2;
Company fax;
Company website.
Site administrator e-mail address - Email address to receive notifications about any technical issues.
Order department e-mail address - Email address to receive notifications about placed orders and changed order
statuses.
User department e-mail address - Email address to receive notifications about newly created, modified and deleted
user profiles.

User settings
Administrator must activate new user accounts - If selected, newly created customer accounts are inactive until the
store administrator activates them manually.
User e-mail is used as login - If selected, user email addresses can be used instead of regular usernames to log in to
the storefront and Administration panel.
Offer guest to create an account after successful order - If selected, at guest checkout, the buyer is offered to
register an account if the order was placed successfully.
Quick Registration - Require only contact information for registration.
Profile address section order - Choose which customer address should go first on the checkout page: billing address or
shipping address.
Allow users to create multiple profiles for one account - If selected, users are allowed to specify multiple shipping
and billing addresses for a single account. This may be useful when a user needs separate profiles for personal and
business use, for example.
Share users among stores - If selected, the store uses a joint customer database where customer accounts are shared
among all store units. Otherwise, each store unit has a separate customer base.

Most popular add-ons
Here is the list of the most popular add-ons according to the user's preferences. Click the checkbox, corresponding to the
name of add-on, that you want to choose, to install it.
You can choose as many add-ons, as you want.

Other add-ons
Here is the list of all available add-ons, except most popular. Click the checkbox, corresponding to the name of add-on that you
want to choose, to install it.
You can choose as many add-ons, as you want.
Note: More information about add-ons see in Add-ons -> Manage Add-ons section.
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10.15. Licensing Mode
In this section you can choose one of three licensing modes: Full, Trial or Free.
In the Full mode you get unrestricted access to the full functionality of CS-Cart. To enable this mode you must enter the
licence number.
You are given this number when you buy a full version of CS-Cart on the official website.
In the Trial mode there are no functionality limitations. The Free mode will be activated automatically in 30 days, unless the Full
mode is activated.
You will be able switch to the Full mode anytime by entering a valid license number on the Licensing mode page. You can
download the Trial mode on the CS-Cart official site for free.
You can use the Trial version only once (for 30 days).
In the Free mode, you can run the store free of charge with no time restrictions. A basic set of eCommerce tools is available in
this mode. The Free mode is the the free version of CS-Cart (some functionality is unavailable and some add-ons are cut-off).
You will be able to switch to the Full mode anytime by entering a valid license number on the Licensing mode page.
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11. Design
This section of the administration panel assembles control elements and facilities to manage and customize the storefront
appearance. Here you can arrange the layout of different types of pages, edit the templates that constitute the interface, easily
change the store logos, apply a different theme, define product tabs, etc.
In CS-Cart, the storefront appearance is configured separately for each store. Make sure to select a store before performing an
action on the storefront.

Note: Once you have made any changes to the storefront appearance, make sure that everything displays correctly. If it does
not, try to adjust the components that you have edited, or revert to the original appearance.

11.1. Themes
Here you can choose, install, upload, delete, and customize themes for your store.
Note: To use this functionality, make sure to choose the store first.

In this page you can see the current theme applied to your store and the list of available themes (with different styles for each
theme).
Click NEED HELP to see the video tutorial on how to customize your storefront.
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In the Current theme section you can:
Open the Theme editor to customize your storefront in real time by clicking Visual Editor. You can customize separately
the Main layout and the Widget mode layout styles.
Choose the existing styles for layouts by using the drop-down lists near each layout name.
Open the On-site live editor with the Edit content on site button.
In the On-site live editor you can see the storefront, and all the editable interface elements are marked with a dash line. You
can continue navigating through the interface just if you were using the regular mode.
To edit an element, hover the mouse pointer over it and click the following icon
appears in an editable field. Click

. Change the value of the element that

when you are ready.

With the On-site live editor you can edit:
Language variables
Products
Images
Categories
Pages
Banners
Storefront logo
Some settings

In the Installed theme tab, there is a list of themes with different styles, that you can use in your store. For example, there is
the default Responsive theme and the list of styles (Black, Brightness, Facebook, etc.) available for it. Hover the mouse
pointer over the style preview and click Use this style to use the style.

In the Browse all available themes tab, there is a list of themes available for the installation. If you need to install the pristine
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default theme, you can find it here.
To the right of the page, you can see some theme information. There is the theme name, directory, where the theme is placed,
the number of layouts and styles and the current theme developer.
Here you can:
open the file editor by clicking on the directory name;
go to the Layouts page by clicking on the number of layouts;
see the list of styles for the current theme by clicking on the number of styles.

Click the gear button in the right upper corner of the page

and choose Clone theme from the drop-down list to clone

the current theme, if you wish to apply changes to it, customizing the theme to your own taste.
Here you can also see the Rebuild cache automatically selector. Click (On) if you want the modified files to be re-cached on
the fly.
To Remove a cloned theme:
Make sure that the theme you want to remove is not currently used (select another theme from the Installed theme tab);
After that, find the theme you want to remove in the Installed theme tab, and click the

button on the right.

Note: Before deleting a theme, make sure that the layout used by it is not set as default. Otherwise, you will not be able to
delete a theme.
To upload a new theme, click the

button in the right upper corner of the page. In the opened pop-up window choose

whether to upload a file from the local computer (Local) or the server file system (Server). You can also specify URL to a
remote location, where the required archive is physically located. Pay attention, that the theme archive must be in tgz, gz or
zip format. When you are ready, click Upload.
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11.1.1. Theme editor
When you choose to customize theme, the storefront and the Theme editor panel (in the left part of the page) are displayed
on your screen.
In the Theme editor you can easily change the default style to your individual company one: change logo, color scheme, fonts,
background settings.
Note: To use this functionality, make sure to choose the store first.
You can easily hide the editor panel and see your changes or close the Theme editor using the controls marked with red in the
picture below.
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With the help of the Theme editor you can create unlimited number of styles, clone and delete the existing styles (except the
default one.)
To change the style, choose the desired one from the drop-down list or clone one of them, rename and customize it according
to your preferences and press the Save button.
Your style will appear in the list of other available styles. Read how to customize a style further in this topic.

Customizing
There are 6 groups of the theme customization:
General - Change the favicon and choose weather to round the corners or not;
Logos - Change the mail, theme and gift certificate templates logos;
Colors - Set the color scheme and change colors for different theme elements (buttons, menu, etc.);
Fonts - Change the font style for different groups (headings, buttons, etc.);
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Backgrounds - Background settings (color, gradient, image, etc.)
Custom CSS - Advanced style settings in CSS-format.

General
To change the favicon for the store, press Browse and choose a picture. Favicon size must be 16х16 px. The picture will
appear near the button after the applying of changes. You can also click on the On/Off button to define, whether to round the
corners in the store or not.

Logos
Use this section to define the set of the store logos that are shown in the customer area, in the store invoices, and in the gift
certificates.
To upload the logo image from a local computer, press the Browse button.
An alternative text describes the image and is shown when the image is missing or cannot be displayed. It is good practice to
have an alternative text associated with the image as an additional SEO-wise opportunity.

Colors
In this section you can see the list of colors for different theme elements. Click on the color corresponding to the particular
element to change it.
Here you can either choose a color from the palette or enter new hexadecimal values (from #000000 for black to #FFFFFF for
white) into corresponding text fields.
Press Choose in the same picker window when you are ready.
To reset changes press the Reset colors button.

Fonts
Here you can change the font style for different groups of elements: body, headings, links, price tag, buttons.
Use the drop-down lists to pick a font and it's size and the following buttons to set the text to:

- bold,

- italic ,

-

underlined.
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To reset changes press the Reset fonts button.

Backgrounds
Use this section to define the settings of different background elements: general, top panel, header, content, footer.
You can change the background color of each element and see the applied changes on the storefront instantly. Click on the
color corresponding to the particular element to change it.
Here you can either choose a color from the palette or enter new hexadecimal values (from #000000 for black to #FFFFFF for
white) into corresponding text fields. Press Choose when you are ready.
For the General subsection, you can also set pattern as the background. Click the pattern preview to choose one from the list
of given patterns. You can also click the "gear" icon

and choose Browse to upload an image from your computer. The

picture must not be bigger than 200 kB.

With the help of pointers you can set the position of an image. Drop-down lists help you to define the picture display methods:
whether to repeat it in different directions (to fill in the background) or not, and whether to scroll the image or leave it fixed while
searching through the page.
For the header, top panel, footer and content you can define the following settings:
Gradient (for the top panel,header and footer) - Click on the color, to define the gradient. Here you can either choose a
color from the palette or enter new hexadecimal values (from #000000 for black to #FFFFFF for white) into
corresponding text fields. Press Choose when you are ready. You can try to choose different colors to form the gradient
and see the result on the storefront to the right.
Full width - Click on the On\Off button to define, whether to spread the element to the full width of the page or not.
Transparent - Choose, whether to make the background of an element transparent or not.

Custom CSS
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If you are familiar with CSS, use this section to customize some style elements.
Do not forget to press the Save button when you are ready to save changes in the theme.

11.2. Layouts
Use this section to edit the existing or add new layouts. A layout is the combination of blocks and the method of their
arrangement.
In this section you can add a new layout with the button

or edit the existing layout.

When editing or adding a layout, define the following attributes:
Name - The name of the layout.
Copy data from layout (when adding new layout) - Choose the layout from which you want to copy the content.
Default - If selected, the layout is set as a default.
Grid columns - Choose whether to use the 12- or 16-column grid in the layout.
Layout width - Choose how the pages layout will be formed: Fixed width - pages will have a fixed width (1200px, for
example); Full width - pages will have the full-width layout; Fluid - pages will have the responsive layout.
To the right of the page there is the Switch layout section. Here you can switch a layout by clicking on it or use the button
with the gear icon to perform the following actions:
Preview - Open the storefront in a separate page.
Make default - Make a layout default for the theme.
Properties - Open the Edit layout page.
Delete - Delete a layout. Pay attention that you cannot delete the default layout.
You can click the NEED HELP button at the top of a page to see the video describing the features of the Widget mode.

The Layouts section enables you to manage and customize the layout of storefront pages. The storefront is built by the use of
the framework where pages are assembled out of blocks nested inside containers.
Such a block conveys a certain piece of information like a logo, mini cart, product details, breadcrumbs, search form,
navigation menu, etc. You can add, edit, remove, or simply move blocks around a page to organize the new look and feel. The
following sketch presents the storefront structure and illustrates how a page may be composed.
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11.2.1. Locations
A location can represent either a certain type of the storefront pages (for example, detailed product pages, category pages,
etc.) or a specific storefront page (for example, checkout page, cart page, etc.)
By changing the layout of a specific location, you automatically change all storefront pages that this location represents.
Although a location cannot represent a specific page that belongs to a particular page type, you can configure individual blocks
to appear on specific pages only. This feature makes it possible to create a unique look and feel for individual storefront pages.
For more details, please refer to Design > Layouts > Blocks.
Tip: To associate a location with a specific page or page type, use the Dispatch option on the location attributes form (the
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icon near the location name).

Default location
A storefront must have a default location assigned. This property is assigned to a location by selecting the Default check box
on the location attributes form.
The default location defines the storefront top panel, header and footer that are inherited by the other pages. Also, the layout of
the default location is used by the storefront pages that do not have a separate location defined.
The location with the default property cannot be removed until you re-assign a new default location.

11.2.1.1. Actions on locations
Locations are not hard-coded or anyhow limited. You can have as many locations as you need. However, the default set of
locations is generally enough.
When you need to perform an action on the locations, go to the layout manager page (Design

Layouts).

General actions
Adding a location
To add a location, click on the More tab in the list of locations and choose Add location. A popup window with location
properties opens. Specify the new location's properties and save the changes.
Removing a location
To remove a location, select the location and click the button

in the pop-up window. This irrevocably removes the

location and its layout.
Editing location properties
To change a location properties, select the location and click the

icon on the tab. A special form with the location

attributes opens. Edit the location properties, then click Save to apply the changes and close the form.

Exporting/importing locations
Storefront locations can be imported and exported in an XML file. This feature becomes useful when you need to clone the
layout among several storefront. It is also recommended that you export location before making any changes to the storefront
layout. In case of emergency, you will be able to restore the original layout by importing the locations.

Exporting locations
To export locations:
1. Click the

button and choose Export Layout. This opens the export settings form.

2. Select the locations to be exported.
3. Choose the other export settings:
Output - Output type: Direct download - export file will be downloaded to you computer; Server - file will be saved on
the server where CS-Cart is installed.
File name - Name of the export file. By default, it is layouts_<TIMESTAMP>.xml.
4. Click Export.
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Importing locations
To import locations:
1. Click the

button and choose Import Layout. This opens the form for selecting the import file.

2. Choose the import file or enter the file's URL.
3. Choose the other export settings:
Clean up locations before import - If selected, all original locations will be deleted before the import operation.
Override locations by dispatch - If selected, original locations will be replaced with the locations in the export file
during an import operation. Otherwise, location will be added to the original location upon an import operation.
4. Click Import.

11.2.1.2. Location properties
To edit location attributes, select a location in Design

Layouts and click the

icon on the tab. This opens a special form

with the location attributes.
Once you have finished, click Save to apply the changes and close the form. A location has the following attributes:
General tab:
Dispatch - Choose a specific page or page type that the location will be associated with. Or select "Custom" to define the
parameter value manually. The "dispatch" parameter has the following format: [controller_name].[mode_name],
where [controller_name] – is the name of the controller, and [mode_name] – is the mode in which the controller
works. This value is added to index.php?dispatch= part of the page and points to a specific location. For example,
index.php?dispatch=checkout.cart points to the cart contents page while index.php?dispatch=checkout.
checkout points to the checkout page.
Name - Name of the location as it appears in the layout manager.
Default - If chosen, location is picked as default. Its Top and Bottom containers are used in all locations.
Position - Position of the location in the list of locations.

SEO attributes
Along to adjusting the layout, you can define SEO attributes of a particular location. These attributes will be automatically
assigned to all pages of this type.
Page title - Title of the page as it appears in the title bar of a browser.
META description - Contents of the HTML meta tag describing the page.
META keywords - Contents of the HTML tag containing a list of search keywords for the page.
Some locations (Pages, Categories, Products) have an additional tab in their attribute forms. In this tab you can add
particular items to which these location properties apply.
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11.2.2. Framework
Root containers
As illustrated in Design > Layouts, the basic storefront framework consists of four horizontal containers referred to as root
containers. This basic frame is the same for all locations.
Root containers cannot be added or removed.
Moreover, the top panel, header and footer containers of the default location are inherited by other locations. This means that
the changes that you make to these two areas automatically apply to all locations.
Each root container is associate with a particular area of the storefront page - header, main content area, or footer. However,
root containers themselves do not generate the corresponding parts of the storefront pages. In fact, they only accommodate
and form boundaries for multiple smaller containers referred to as child containers.
Note: Although a root container may consist of zero child containers, you are supposed to include at least one.

Child containers
Child containers ensure a more detailed and sophisticated layout of the storefront paged. Multiple child containers with certain
sizes, positions, and styles can be nested inside a root container or inside other child containers. And each such container
may include one or more blocks - boxes with information of certain type.
Both the root and child containers are fixed to the storefront grid system used in CS-Cart.
To create a child container:
1. Click

on the container that will be the parent on the new container, then select Add Grid.

The software opens a form with the new container's attributes.
2. Specify the new container attributes.
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3. Click Create when finished.

11.2.2.1. Grid system
CS-Cart uses the intuitive and powerful Bootstrap framework that can have the full-, custom-width, and responsive layout. The
layout in CS-Cart has 12- or 16-column structure.
In the full-width layout the length of the columns is adapted to the width of the page. In custom-width layout the length of the
columns is fixed and depends on the specified width of the page. And responsive layout is flexible and easily adapting for
different screen sizes. It is very useful for displaying site content on the portable devices screens.
In CS-Cart, the root containers always occupy the full page length, i.e. all columns in the grid. The number of columns is
defined through the container settings. It determines the possible dimensions of child containers. Their length cannot exceed
the number of columns in the grid.

Also read in CS-Cart Knowledge Base:
Full-, Custom-Width, and Responsive Layouting with Bootstrap

11.2.2.2. Container properties
When you create or edit containers, you can define the following attributes:
Width - Number of columns used in the container. For child containers, this number cannot exceed the the length of the
root container.
Content alignment (child containers only) - Container's position inside the root (or parent) container: Right, Left or Full
Length.
Prefix - Number of non-occupied buffer columns left to the container.
Suffix - Number of non-occupied buffer columns right to the container.
User-defined CSS class - Custom CSS class used by the container.

11.2.3. Blocks
While containers form the storefront structure, blocks basically populate this structure with contents and function elements. It
is convenient to regard blocks as separate boxes which represent a particular storefront component. This can be a search
form, currency or language selector, top menu, product filter, banner, list of products, text, HTML insertion, etc. Just everything
what can appear on the storefront is created by using blocks.
Blocks differ from each other in the type of data they represent. However, blocks with the same data type can have different
filling, appearance and configuration. Moreover, certain blocks may be assigned to specific items/pages only. This makes
blocks a highly powerful and flexible tool for building custom storefronts and creating individual pages out of a typical
framework.
CS-Cart already offers a number of pre-defined blocks. Use them to quickly add the most popular and common storefront
components. In addition, you can create custom blocks based on the available templates.
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Actions on blocks
You can re-arrange blocks in the frame, add and remove blocks, edit block properties, activate and disable blocks, assign
blocks to specific items/pages.
When you need to perform an action on the blocks, go to Design

Layouts and select the location where the necessary

block appears or should appear.
Tip: For blocks that refer to the top panel, footer or header container, make sure to select the default location.

Moving blocks
To move a block to a different position inside the frame:
Drag-n-drop the block to the required position.
Tip: Remember that blocks must be nested inside a child container.

Adding blocks
When adding a block, you can use one of the following options:
Add a pre-defined block.
Create and add a custom block with a specific configuration.
To add an existing block:
1. Click

on the container where the block should be placed and select Add Block.

2. Select Use Existing Block.
3. Choose a block from the list and click its icon.
The block will appear among the other objects in the frame.
To create and add a new block:
1. Click

on the container where the block should be placed and select Add Block.

2. Select Create New Block.
3. Choose a block type and click its icon. This opens a window with the new block configuration.
4. Set up the block parameters.
5. Click Create when finished.
The block will appear among the other objects in the frame. Also, it will be added to the list of the existing blocks.
Tip: Block types and properties are described in the "Block types and properties" topic later in this the guide.

Editing blocks
To edit a block:
1. Move the cursor over the block and click

. This opens the block configuration form.

2. Edit the block parameters.
3. Click Save to apply the changes.
Tip: Block types and properties are described in the "Block types and properties" topic later in this the guide.

Deleting blocks
To remove a block from the frame
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Move the cursor over the block and click .
When prompted, confirm the action.
To add new blocks, edit and delete existing ones you can also press the

button and choose the Manage blocks tab

from the drop-down list.

Assigning blocks
If a location represents a group of pages (for example, detailed product pages on the storefront,) blocks are automatically
assigned to all items in the group.
However, you can hide a block individually for an item (product, category, page, etc.,) if you want to hide the block on the
corresponding storefront page. Similarly, you can force a block to appear on a particular storefront page if the block is
deactivated in the location settings.
To hide/show a block on an item storefront page:
1. Open the item detailed page in the administration panel.
2. Shift to the Layouts tab.
3. Deactivate (hide) or activate (show) the block.

11.2.3.1. Block types and properties
When you create a block, you need to choose a block type and also specify the block's properties. The block type defines the
type of information that the block will contain. Block properties enables you to fine-tune the block to meet you specific
requirements. The set of available properties may vary depending on the block type.
After a block has been created, you can edit its properties at any time.

Common properties
Blocks have the following common properties regardless of their type:
Name - Name/title of the block as it appears in the block manager and your block gallery.
Wrapper - Template to border the block.
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User-defined CSS-class - Name of a custom CSS-class that you want to use for the block. The CSS-class itself is to be
defined in the file styles.css located inside the skin directory.

Type-dependent properties
The following is the list of available block types and the applicable type-specific properties:

Banners
Description
Related add-

One or more banners that were created in section Marketing

Banners.

Banners Management

ons
Templates

Original
Carousel

Content

Filling
Manually
Newest

Block

None

settings

Blog posts
Description
Related add-

Blog posts that were created in section Website

Blog.

Blog

ons
Templates

Blog: recent posts
Blog: recent posts scroller
Blog: text links

Content

Filling
Blog: recent posts
Blog: recent posts scroller
Blog: text links
Period
Choose whether posts published "Today", "Last days", or at ''Any date"' appear in the block.
Last days
Number of days in the Last day option of the Period setting.
Limit
Choose, how many posts can be displayed in the block.
Parent page
Choose a page whose child posts appear in the block.

Block

Limit

settings

Do not scroll automatically
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Speed
Pause delay (in seconds)
Item quantity
Outside navigation

Brands
Description

A list of brands represented in the store. A product brand can be defined as a feature with the Brand/
Manufacturer type.

Related add- None
ons
Templates
Content

Our Brands
Automatic

Block

Do not scroll automatically

settings

Scroll per page
Speed
Pause delay (in seconds)
Item quantity
Thumbnail width in scroller

Breadcrumbs
Description

Breadcrumbs, a navigation aid for visitors to keep track of their location on the storefront. Breadcrumbs
provide links to the parent pages of the current one.

Related add- None
ons
Templates

Breadcrumbs

Content

Automatic

Block

None

settings

Cart content
Description

Mini-cart, a summary of the cart contents on a regular storefront page.

Related add- None
ons
Templates
Content
Block

Cart content
Automatic
Display bottom buttons
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Display delete icons
Products links type

Categories
Description

Hierarchical hyperlinked list of product categories.

Related add- None
ons
Templates

Dropdown horizontal
Dropdown vertical
Multi-column list
Text links

Content

Filling (depends on the template)
Manually
Newest
Dynamic tree
Full tree
Rating
Parent category
Root element of the hierarchy.

Block

None

settings

Checkout
Description

Pieces of information and features that are related to the checkout page.

Related add- None
ons
Templates

Order information
Products in cart
Summary
Gift certificate

Content

Automatic

Block

None

settings

Currencies
Description

List (text or pictorial) of currencies supported in the store. To manage the list of currencies, use section
Administration

Currencies.

Related add- None
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ons
Templates
Content

Currencies
Automatic

Block

Text

settings

Format
Minimal number if items to be placed in a dropdown list

Note: This block type requires commercial license.

Gift certificate verification
Description Allows customer to validate or redeem a gift certificate.
Related

Gift certificates

add-ons
Templates

Gift certificate verification

Content

Automatic

Block

None

settings
Note: This block type requires commercial license.

HTML block
Description Custom HTML content.
Related

None

add-ons
Templates

HTML block

Content

Box with custom HTML content.

Block

None

settings

HTML block with Smarty support
Description Custom HTML/Smarty content.
Related

None

add-ons
Templates

HTML block with Smarty support

Content

Box with custom HTML/Smarty content.

Block

None
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Languages
Description Language selector.
Related

None

add-ons
Templates
Content

Languages
Automatic

Block

Text

settings

Format
Minimal number if items to be placed in a dropdown list

Note: This block type requires commercial license.

Menu
Description A custom menu created in Design
Related

Menus.

None

add-ons
Templates

Dropdown horizontal
Dropdown vertical
Text links

Content

A custom menu created in Design

Block

None

Menus.

settings

My account
Description Links to a page with the customer's account details.
Related

None

add-ons
Templates

My account

Content

Automatic

Block

None

settings

News
Description Links to the latest store news.
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News & Emails

add-ons
Templates

Site news
Text links

Content

Filling
Manually
Newest
Plain

Block

None

settings
Note: This block type requires commercial license.

Pages
Description Hierarchical hyperlinked list of static pages.
Related

None

add-ons
Templates

Dropdown horizontal
Dropdown vertical
Text links

Content

Filling
Manually
Newest
Dynamic tree
Full tree
Neighbours
Parent page
Root element of the hierarchy.

Block

None

settings

Payment methods
Description Icons that represent the available payment methods in the store.
Related

None

add-ons
Templates

Payments

Content

Automatic

Block

None
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Polls
Description One or several polls created in Website
Related

Content.

Polls

add-ons
Templates

Central
Side box

Content

Filling
Manually

Block

None

settings
Note: This block type requires commercial license.

Product filters
Description Filters to find products against specific parameters.
Related

None

add-ons
Templates
Content

Original
Filling
Manually

Block

None

settings

Products
Description

One or more products from the product catalog.

Related

Bestsellers

add-ons

Customers also bought

Templates

Grid
Grid 2
Links thumb
Multicolumns small
Products
Products2
Products grid
Scroller
Side box first item
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Short list
Small items
Text link
Without image
Content

Filling
Manually
Newest
Recently viewed
Most popular
Also bought
Best sellers
Rating
On sale
Similar

Block

Hide add to cart button

settings

RSS feed
Description
Related

Regular RSS feed icon -

. A visitor clicks the icon and adds the store's RSS feed to his or her RSS reader.

RSS Feed

add-ons
Templates
Content

Icon
Filling
Products
Pages
News
Sort by
(available for the Products filling type only)
Created
Updated
Other
(available for the Products filling type only)
Display SKU
Display image
Display gross price
Display net price
Display add to cart button

Block

Number of items

settings

Feed title
Feed description
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Shipping methods
Description

Icons that represent the available shipping methods in the store.

Related

None

add-ons
Templates

Shippings

Content

Automatic

Block

None

settings

Store locator
Description Box showing the location of your store on Google's map.
Related

Store Locator

add-ons
Templates

Store locator

Content

Automatic

Block

None

settings
Note: This block type requires commercial license.

Tags
Description List of product and category tags.
Related

Tags

add-ons
Templates
Content

Tag cloud
Filling
Tag cloud
Limit
Maximum number of items in the list.

Block

None

settings

Template
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Description A collection of versatile templates that represent different controls and pieces of information.
Related

None

add-ons
Templates

Authentication information
Copyright information
Feature comparison
Store logo
My account links
Payment systems icons
Profile information
Quick links
Search field
Shipping estimation
Newsletter subscription form
The 404 Not Found error message

Content

Automatic

Block

None

settings

Testimonials
Description List of testimonials left by the store customers.
Related

Comments & Reviews

add-ons
Templates
Content

Testimonials
Automatic

Block

Limit

settings

Random

Note: This block type requires commercial license.

11.2.3.1.1 Block filling types
Block filling type is defined under the Content tab of the block properties form.

All
With this filling type, the block contains all items of the selected type.

Also bought
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With this filling type, the block contains links to product that are usually bought together with the product that the visitor scans
at the moment.
This filling type is available when the Customers also bought add-on is installed and activated.

Bestsellers
With this filling type, the block contains links to products that are sold best in the store.
This filling type is available when the Bestsellers add-on is installed and activated.

Blog: recent posts
With this filling type, posts are added automatically according to the parameters that you specify. The following parameters are
available:
Period
Period of time over which posts were added to the store database. The following choices are available:
Any date - The block will display the latest posts. The output is not bound to any time period.
Today - The block will display the posts that have been added on the day when the visitor opens the storefront.
Last days - The block will display the posts that have been added over a certain time period before the moment the
visitor opens the storefront. The time period is specified in the Last days field below.
Last days
Number of days over which items were added to the store database before the visitor has opened the storefront.
Limit
Maximum number of items that will be displayed in the block.

Blog: recent posts scroller
With this filling type, posts are added automatically according to the parameters that you specify and displayed as a scroller.

Blog: text links
With this filling type, the block contains a hierarchical list of links to posts down the specified parent page.

Dynamic tree
With this filling type, the block contains a hierarchical list of items down the specified root element.

Full tree
With this filling type, the block contains a hierarchical list of items down the hierarchy's root element.

Manually
With this filling type, you manually add items to the block (see instruction below.)
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To add items:
1. Click +Add <ItemType>. The software opens a list of items.
The <ItemType> part in the name of the control corresponds to the type of items to be added. For example, Add Product,
Add Banner, and so on.
2. Select one or more items from the list.
To facilitate the process, you can use the search form on the top of the list.
3. Click Add products and close to save the results and display the block properties form.

Neighbours
With this filling type selected, the block contains a list of items, pages, that belong to the same echelon of the hierarchy as the
item (page) being viewed at the moment.
Let's consider a simple example. Imagine you have static pages organized in the hierarchy demonstrated below. When a
visitor studies the page named "Reviews & award" (highlighted in bold,) the block with the Neighbour filling type will contain only
the pages named "About us", "Brick-n-mortar superstore", "Career opportunities", and "Contact".
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Newest
With this filling type, items are added automatically according to the parameters that you specify. The following parameters are
available:
Period
Period of time over which items were added to the store database. The following choices are available:
Any date - The block will display the latest items. The output is not bound to any time period.
Today - The block will display the items that have been added on the day when the visitor opens the storefront.
Last days - The block will display the items that have been added over a certain time period before the moment the
visitor opens the storefront. The time period is specified in the Last days field below.
Last days
Number of days over which items were added to the store database before the visitor has opened the storefront.
Limit
Maximum number of items that will be displayed in the block.

On sale
With this filling type, the block contains links to products on sale.

Plain
With this filling type, the block contains plain text with no links.

Products
With this filling type, RSS feed contains information about products.
Sort by:
Created - Products in the list are sorted by the date of creation.
Updated - Products in the list are sorted by the date of updating.
Other:
Display SKU - If selected, stock keeping unit (SKU) is displayed in RSS feed.
Display image - If selected, product image is displayed in RSS feed.
Display gross price - If selected, product gross price is displayed in RSS feed.
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Display net price - If selected, product net price is displayed in RSS feed.
Display add to cart button - If selected, Add to cart button is displayed in RSS feed.

Pages
With this filling type, RSS feed contains information about pages.

News
With this filling type, RSS feed contains information about news.

Most Popular
With this filling type, items are added automatically based on a greater number of views.

Rating
With this filling type, items are added automatically based on a greater ratings.
This filling type is available when the Comments & Reviews add-on add-on is installed and activated.

Recently viewed
Block contains the items that have been recently viewed by the customer.

Similar
With this filling type, the block contains a list of products similar to the main product. Such products are being chosen
according to the main product price and category. Such parameters are customized in the filling type settings.

Tag cloud
With this filling type, the block contains a list of tags added that you have defined in the store.
This filling type is available when the Tags add-on add-on is installed and activated.

11.2.3.1.2 Block templates
The following templates are used in blocks.

Authentication information
Standard use authentication form.

Blog: recent posts
Posts appear as a list of links.

Blog: recent posts scroller
Scrolled list of products.

Blog: text links
A simple list of text links with the dates of publishing.
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Breadcrumbs
Standard breadcrumbs navigation aid.

Carousel
Items appear in a carousel-like manner: a horizontally scrollable list with pagination where only one item at a time is displayed.
This template has the following settings:
Navigation - Type of the item switcher in the list: dots, digits, or arrows. You can also disable manual switching between
the items by selecting None. In this case, items will be switching automatically.
Delay (in seconds) - Number of second to pass before items switch over.

Cart content
Standard mini-cart to be placed on the storefront pages.

Central
Layout intended for the content appearing in the center of the page.

Copyright information
Copyright information that you have specified in Settings

Company.

Currencies
A list of supported currencies defined in Administration

Currencies. Appearance options should be configured in the block

settings.

Dropdown horizontal
List of categories with drop-down lists that are displayed top-to-bottom. For hierarchical list, the following menu options are
supported:
Second level elements - Maximum number of second-level elements within a menu item.
Third level elements - Maximum number of third-level elements within a second-level menu item.
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Dropdown vertical
List of categories with drop-down lists that are displayed vertically left-to-right. To display lists right-to-left choose Right to left
orientation checkbox.

Events
Box with the current events in the store.

Feature comparison
List of products selected for comparison.

Gift certificate
Form to apply a gift certificate to the order.

Gift certificate verification
Field to enter the number of a gift certificate.

Grid
Items (product thumbnail next to a text link) arranged in a grid.

Grid 2
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Items (product thumbnail above a text link) arranged in a grid.

HTML block
Custom HTML content.

HTML block with Smarty support
Custom HTML\Smarty content.

Icon
Regular RSS feed icon (

) to the store's RSS feed.

Languages
List of storefront languages defined in Administration

Languages.

Links thumb
Product thumbnail with a text link to the product page.

Multi-column list
List of items arranged in multiple columns. Number of columns is defined through the template option Number of columns in
the objects list.

Multicolumns small
List of small items arranged in multiple columns.

My account
Links to the account details of the logged in customer.

My account links
Links to the account pages of the customer who has logged in.

Newsletter subscription form
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Form to subscribe to newsletters.

Order information
Order details on the checkout page.

Original
Box with all available product filters and a price slider.

Our Brands
A list of product brands that are defined as features with the Brand/Manufacturer type.

Payment systems icons
Icons of the supported payment systems in the store.

Payments
Icons of all the available payment methods in the store.

Products
Products are displayed in the box just the same as they are displayed in a typical product list.

Products in cart
Cart contents displayed during the checkout process.

Products2
Products are displayed with thumbnails and price, and are arranged in multiple columns.

Products grid
Products are displayed with big thumbnails and price, and are ordered by grid.

Profile information
Profile details of a customer who has logged in. These include login credentials and personal data.

Quick links
Active quick links defined in Design

Quick links.

Scroller
Scrolled list of products.

Search field
Regular search form.

Shipping estimation
Box with estimated shipping rates
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Shippings
Icons of all the available shipping methods in the store.

Short list
Products are displayed with small thumbnails, and are arranged in a table.

Side box
Template for a poll or questionnaire that is placed inside a side box.s

Side box first item
The first product is displayed with a thumbnail and a text link, and the rest of the products are represented as a link to the
products page.

Site News
A list of links to recently added news according to the date.

Small items
Product thumbnail with a text link to the product page.

Store locator
Location of your store on Google's map as specified in Administration

Store Locator.

Store logo
Storefront logo as specified in Design

Logos.

Summary
Template to display the order summary on the checkout page.

Tag cloud
List of tags that the store administrator created in Website

Tags.

Testimonials
List of testimonials submitted by the customers. To manage testimonials, use section Website

Text links
A simple list of text links.
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The 404 Not Found Error Message
Textual notification for users, that the requested page cannot be found.

Vendors
List of active vendors accounts in the store.

Without image
Simple text link together with the product price.

11.2.3.1.3 Block settings
Blocks can have the following specific settings:

Display bottom buttons
Select to display View cart and Checkout buttons in the mini-cart.
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Display delete icons
Select to display the Delete icon in the mini-cart.

Do not scroll automatically
Select to disable automatic items scrolling (items will scroll only when clicking arrows).

Feed description
Description of the RSS feed.

Feed title
Title of the RSS feed.

Format
Format to display items - text titles or icons.

Hide add to cart button
If selected, the Add to cart button does not appear in the block.

Item quantity
Number of items displaying in the block at the same time.

Limit
Maximum number of items displayed in the block.

Minimal number if items to be placed in a dropdown list
If the number of available items is equal or exceeds the number that you enter here, the selector is displayed as a drop-down
list.

© 2004 - 2015 Simbirsk Technologies Ltd.

221

CS-Cart Reference Guide

Number of items
Number of items (products or pages) to be included in an RSS feed.

Pause delay (in seconds)
Pause between items replacing each other in a scroller.

Products links type
Select whether to display (Thumbnail) or not (Text) a product thumbnail in the mini-cart.

Random
Select to display testimonials randomly. Otherwise, the latest testimonials will be displayed in the box.

Speed
The number that shows the scrolling speed: the bigger the number - the higher the speed.

Text
A short text to be displayed right to the selector. This can be something like Select a language or Choose a currency.

11.2.4. Widget mode
This tool allows you to operate your store in the Widget Mode. In the right upper part of the Layouts section (Design >
Layouts) you can see the Widget code. Copy this code and use it to embed your store as a widget in any other web page.
You can click the NEED HELP button at the top of a page to see the video describing the features of the Widget mode.

Note: Some websites don’t allow external JavaScript files, so the CS-Cart widget will not work on such sites.
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11.3. Templates
This section provides a facility to edit the source code of the theme files directly from a web browser.
Note: The file editor is based on Javascript. So, Javascript must be enabled in your web browser.

Controls
The editor includes a file explorer that is used to locate the elements inside the theme directory, and a number of controls to
manage the files and folders.

Controls grouped under the

button and the

button perform the following operations:

On-site template editing - Editing the storefront templates on the fly. When you choose this tab, the storefront
appears in the separate window. Editable templates have an edit icon

assigned to them. Hover the mouse point over

the necessary icon, to highlight the corresponding template or group of related templates, then click the name of the
template you want to edit. The template source code will appear in the file editor. Edit the template and save your
changes.
Restore from the repository - Restoring the original file from the theme directory.
Download - Saving the selected file on the computer.
Rename - Renaming the selected file or folder.
Delete - Deleting the selected file or folder.
Create file - Creating a new file.
Create folder - Creating a new folder.
Upload file - Uploading a file to the opened directory.
If you change something in this section, do not forget to click the Save changes button afterwards.

11.4. Menus
Use this section to create custom storefront menus. Each menu can be added to the storefront in Design
through a block of the Menu type.
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to add new menu, or click the

button and choose the Edit link to edit existing menus.

To edit or add a menu fill in two mandatory fields:
Name - The name of the menu as it appears in the storefront.
Status - Current status of the menu (Active or Disabled).
You can also manage the content of the menu with the Manage Items link (under the

Here you can edit or delete each item (the

button).

button), or add new items to the list (

). To edit or add the item, fill out

the form with the following attributes:
Parent item – Choose whether it is a tab or an item appearing in a drop-down submenu.
Link text – Name of the item/tab as it appears on the storefront.
Position – Position of the item relatively to the position of the other items of the same level.
URL – URL of the linked page. It should not necessarily be an absolute URL consisting of the access protocol, the
domain name, and the path to the page. A relative link like index.php?dispatch=pages.view&page_id=3 would
be enough.
Activate menu tab for – Components pages of the storefront, where the items appear.
Generate submenu – Select whether submenu containing child elements of the selected object (None = no
submenu; Category = subcategories of the selected category; Page = child pages of the selected page) should be
generated.
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11.5. Product tabs
Use this section to manage the set of tabs that appear on detailed product pages on the storefront.

Tip: To display additional product information in tabs, make sure to select Display product details in tabs in Settings
Appearance.
CS-Cart already has several pre-defined product tabs that are suitable for most situation. However, you can add more tabs by
clicking

and selecting a block to represent the contents.

In addition, you can perform the following actions on product tabs:
Change product tab names
To change the name of a product tab, click the

button corresponding to the tab and choose Edit. This opens the

tab's properties page. Enter the new name in the Name field and click Save.
Enable and disable product tabs
To enable or disable a product tab, change the status of the tab.
- Product tab is enabled.
- Product tab is disabled.
Change the position of the product tab
To change the position of a product tab relatively to other product tabs, drag and drop the tab.
Disable product tab for specific products
To disable a product tab for specific products, click the

button, corresponding to the tab, and choose Edit. Go to the

Status tab and click the Add product button in the Disable for line. This opens a form for adding products from the catalog.
Add products which must not have the tab on their details pages. Other products will continue using this tab.
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